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LIMITED WARRANTY ON MEDIA AND REPLACEMENT

If you discover physical defects in the manuals distributed with an Apple product or in the
media on which a software product is distributed, Apple will replace the media or manuals
at no charge to you, provided you return the item to be replaced with proof of purchase to
Apple or an authorized Apple dealer during the 90-day period after you purchased the
software. In addition, Apple will replace damaged software media and manuals for as long
as the software product is included in Apple's Media Exchange Program. While not an
upgrade or update method, this program offers additional protection for up to two years or
more from the date of your original purchase. See your authorized Apple dealer for
program coverage and details. In some countries the replacement period may be different;
check with your authorized Apple dealer.
All IMPLIED WARRANTIES ON THE MEDIA AND MANUAIS, INCLUDING IMPLIED
WARRANTIES OF MERCHANTABILI'lY AND ~ FOR A PARTICULAR PURPOSE,
ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF TIIE
ORIGINAL RETAIL PURCHASE OF TIDS PRODUCT.
Even though Apple has tested the software and reviewed the documentation, APPLE MAKES
NO WARRANTY OR REPRESENTATION, EITHER EXPRESS OR IMPLIED, WITH
RESPECT TO SOFTWARE, ITS QUAUTY, PERFORMANCE, MERCHANTABILI'lY, OR
~FOR A PARTICULAR PURPOSE. AS A RESULT, TIDS SOFTWARE IS SOLD "AS
IS," AND YOU THE PURCHASER ARE ASSUMING TIIE ENTIRE RISK AS TO ITS
QUAUTY AND PERFORMANCE.
IN NO EVENT Will. APPLE BE llABLE FOR DIRECT, INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY DEFECT IN
THE SOFTWARE OR ITS DOCUMENTATION, even if advised of the possibility of such
damages. In particular, Apple shall have no liability for any programs or data stored in or
used with Apple products, including the costs of recovering such programs or data.
THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU
OF All OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED. No Apple dealer, agent,
or employee is authorized to make any modification, extension, or addition to this warranty.
Some states do not allow the exclusion or limitation of implied warranties or liability for
incidental or consequential damages, so the above limitation or exclusion may not apply to
you. This warranty gives you specific legal rights, and you may also have other rights which
vary from state to state.

Addendum
Macintosh System Software
User's Gulde, Version 6.0

After the guide went to press, the veision numbers of the ~ystem
file and MultiFinder file changed The new version numbers are
• System version 6.0 (nqt 4.4)
• MultiPinder version 6.o (not 1.1)
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Preface

HIS MANUAL TELLS YOU WHAT YOU NEED TO KNOW TO USE THE SYSTEM

software you received with your Apple® Macintosh® computer. System
software is what lets you and your Macintosh communicate.
Before you can start using the system software, you should have set up
your computer (plugging it into a power source, attaching the keyboard and
mouse, and connecting any peripheral devices, such as printers). If you
haven't set up your Macintosh, do so now. You'll find all the instructions
you need in your Macintosh owner's guide.

xi

About this manual
The first chapter in this manual is a self-paced tutorial. The remaining
chapters-each designed to focus on a specific topic- contain reference
material. The idea is to help you locate exactly what you need quickly,
without having to conduct a lengthy search when you have a question.
Here's what you'll find inside:
• Chapter 1, "Tutorial: Learning Macintosh Basics," is a straightforward
tutorial that starts you off using the Macintosh system software to
learn the skills you need.
• Chapter 2, "Basic Macintosh Techniques," begins the reference portion of
the manual and provides step-by-step instructions for performing basic
tasks with the Macintosh.
• Chapter 3, "Working With the Finder Desktop," briefly describes the tasks
you perform on the Finder™ desktop (a metaphor for your base of
operations), and includes some important concepts.
• Chapter 4, "Finder Menu Commands," explains the purpose of every
command available in each of the menus on the desktop.
• Chapter 5, "Desk Accessories," tells how to use the preinstalled Macintosh
desk accessories (mini-applications you can use on the desktop and in
most applications).
• Chapter 6, "Keyboards," provides a map to each of the Macintosh
keyboards available and tells you how to use your keyboard to accomplish
specialized tasks.
• Chapter 7, "3.5-Inch Disks," explains how to prepare and work with the
small, portable disks that you will be using with your Macintosh.
• Chapter 8, "Hard Disks," takes you step by step through the process of
initializing (formatting) an Apple SCSI hard disk and offers tips on making
the best use of your hard disk.
• Chapter 9, "Startup Disks," explains what a startup disk is and provides
step-by-step instructions for creating and updating a startup
disk-whether it's a 3.5-inch disk or a hard disk.
• Chapter 10, "MultiFinder," describes the new MultiFinder™ multitasking
operating system you can use with your Macintosh and includes a brief
sample session to get you started.
• Appendix A, "A History of Macintosh System Software," provides a chart
that tells you which versions of system software work best on different
versions of the Macintosh, and a set of tables that summarize changes to ·
the software over time.
xii
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• Appendix B, "Troubleshooting," describes minor problems that can occur
and offers remedies you can try on your own.
At the end of the manual, you'll find an index, and inside the back cover is a
Tell Apple card. After you've spent some time with your computer, be sure
to fill out the card and send it in. We want to know what you think about
Apple products and training materials.

Using the chapters in this manual
You don't have to read the chapter contents in any particular order. The
topics covered, and the tasks associated with each topic, are described
independently. Here's an illustration to show you how to take advantage of
the structure of each chapter.

Major topic - - -- li " - - - - - -

Mouse basics

Lookiogata~u

fourMJ::1111oilh~on'>t.mll)' IO lllO\'rmmt.1)TIJll\akr•·•hiho:

mouse r°"' nn M.ln ,pp1in1~ ,nd open doNl!lC'!IU, •u\c on 1l'k-m. 1nd

I . l'Usldoothtpcil.otcroothtwor11Flk1Dthtmm1bat.

pu1Lhem1•":1.)' 1Plfl-f.llt h)' ITIOIVl,ithe~'ndllfeMlfijtthc:mous..

1. '51thoul mimng tbc moi- kw llCl'll'. prat and bold the bo.rcoa. lde;i:x h when JOI.I'~ flnbbcd looUDf.

"''oo

Related task - - --+

Mov1nglh<po1nttt
by moving th< lllOU5C

Step-by-step
instructions for
perfonning a task

I . 'fi'.rdlthttcr\"f:ll.-hlk:youroUtht -on11W1urbttott1

h1,dll1p.troand a mmu •o a~ar Thu 15:.omnimncillrd pulbn1100..·n'
mc:nu l andlti.:1T.n1Ull0r'l you1 .\1Ktnto:lli1~oflenolkdpull-OO..·nmcnusl

l. 'll'a&dithtkTft'llwhikyuullltthtlllOUM:mdputllcknruag:a!D
In •d.Ukmll .,-.C.
\l.~·('1)'0Ul\lnoutolroomfor1ho:~if1t!fOl"offlhctahk. f01"

1nsu11Cr. OI run\ m10 !he .\\acmtOllh 11J<lf-hfl the mou5( and pul ~ do"'·n
1pm,.·hc:n.-)"0U lu•rmon:room

Comment on or
explanarion of a step ---..,;----~

~~1ti.:hunon •llhth.:pou11non 1 mrnutllkou1nth.:t~le•o hc

10thtJUdnlOlb.for110W. doa'tpl'Ullhl:miDll9fbucu:>IL

E>"nr mQ1·r 1-ou m:ikr v.-.th w rmu!C' lllO\n th.: pointct in tnctly lfll:'

Choosing a command
from a mtnu

To choose- a mmnund From a mrnu. )'OU u.<c: 1hc umcdrlAAlnll 1n:hntqU<'
}'OU u!o<'d to ITIO\e KOO!
I. l'o dtkm tbc pol!ltcr :ropJ.n 011 tbc woni Flk lo the mniu bu.
2. Tb.htlme.pra1themowtbuuooaodboldltdownwb.lkJ0!.1
clntltbc polotttto thtwoni()ptn.a.nd Ihm rdaK thtmoi- buUoa.

l'l'hrn ~uu ~ka;i:lti.:IT!Oll.\( tiunon •· 11h th.:Opt n romnu ndh1¢tl1~h1nl. an
ouihne zoom.1 ou1of the Sy)l~m TCJOU .:on. ' nd tho: KRTll 11 almo$1 filko<l

Chooslng commands from menus

hy' "''ndo"

U~·c11w ..00;. •·ithyour ).bc111100.. youtdl • 11>uthm~. "'lul )l'lU
•1.Nto ..·ork on ,nd•lut)'OU •':l.Ntodo f1M, )'0Uldlthe .\bnn1oilh

•·tut you •':l.N 10 •"Orie on I'll' !C'l«llll,i • 11 )'()J'•l' ~n domjl; "1th iroru
on thedr~1op

Sc~whatyouwant

I . Mcmthtpol.o1n'totht S)"K111Tooillrotl.

toworkwtth

Figure P-1

How to use the chapters in this manual
Associated with each task, the numbered steps (printed in boldface type)
describe the actions you must take to perform that task. If you feel rusty
and want a quick refresher to help you complete a task you haven't done
lately, just read the bold type and do what it says.
Some tasks are so basic that all you need to know is how to do them. In
other cases, you'll find comments or explanation in plain type following a
step. You can decide whether you want-or need-to read this information.
About this manual

xiii

About the other manuals
Along with this book, your Macintosh came with some other manuals. You
won't have to read them all to use your computer. They're there to give you
information when you need it, but you'll quickly be up to speed with very
little "required reading." Here's what the other books are for:

• The Macintosh owner's guide: If your Macintosh has not been set up
yet, the owner's guide is the first manual you need. It contains complete
instructions for setting up your computer. It also offers a basic
explanation of the major components of the system and how they work
together with software. The owner's guide also provides some technical
information, a summary of technical documentation on Macintosh
computers, and a glossary. This glossary includes boldface terms you
may encounter in both the owner's guide and the book you are now
reading.
• Macintosh Utilities User's Guide: This is the manual that explains how to
use the two utilities disks that came with your computer (Macintosh
Utilities disks 1 and 2). These disks contain special programs you'll use
occasionally to customize your system to meet your specific needs, and
to update it and keep it running efficiently.
• HyperCard User's Guide: This manual explains an exciting new software
product-HyperCard™-that's included free with your Macintosh.
HyperCard is a personal toolkit for using, customizing, and creating
information. You'll want to read the HyperCard User's Guide only after
you've become familiar with your Macintosh.

Using the manuals
Depending on your level of computer experience, you can use the manuals in
a variety of ways.

For the beginner
Here are suggested steps to follow:
1. If you haven't set up your Macintosh, go to Chapter 1 of the owner's
guide for step-by-step instructions. When you've set up the computer,
you may choose to start the training disk-also explained in the same
chapter.
xiv
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2 For a self-paced tutorial that lets you use the Macintosh system
software, go to Chapter 1 of the manual you are reading now.
3. If your computer includes an internal hard disk (or you have an external
Apple SCSI hard disk), see Chapter 8, "Hard Disks," for instructions on
preparing the disk for use.

4. If you have brand-new, never-been-used 3.5-inch disks, you'll want to
initialize them. See "Preparing 3.5-Inch Disks for Use" in Chapter 7.

5. Make backup copies of the master system software and utilities disks
that came with this manual. See "Copying a 3.5-Inch Disk to Another
3.5-Inch Disk" in Chapter 7.

6. Create a startup disk. It doesn't matter whether your startup disk will be
a hard disk or a 3.5-inch disk. The instructions you want are in the section
"Creating or Updating a Startup Disk" in Chapter 9.

If you have other devices to attach to your computer, turn to the manuals
that came with those devices for instructions on connecting them correctly.
Also, be sure to look through the manuals that came with the application
programs you'll be using with your computer.

For the experienced user
Even though you may not need to learn all the skills described in this manual,
or read everything in the owner's guide, you'll probably want to look at the
following:
1. Read Chapter 1 in your owner's guide for instructions on setting up your
computer. That manual also contains useful information on the features
and internal workings of your Macintosh.
2 If your computer includes an internal hard disk (or you have an external
Apple SCSI hard disk), see Chapter 8 of this manual for instructions on
preparing the hard disk for use.

3. Make backup copies of the master system software and utilities disks
that came with this manual. See "Copying a 3.5-Inch Disk to Another
3.5-Inch Disk" in Chapter 7 of this manual.

4. Use the Installer to create a startup disk. See "Creating or Updating a
Startup Disk" in Chapter 9 of this manual.

5. Read about MultiFinder in Chapter 10.
6. Use the Macintosh Utilities User's Guide to learn about utilities that may
be new to you.

Using the manuals
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Tutorial: Learning Macintosh Basics

TT
HO NEEDS THIS CHAPTER?

This chapter teaches you fundamentals- the basic skills you need to use
your Apple® Macintosh® computer. Even if you have experience with other
computers, you'll probably need to learn some new techniques. But the great
thing about the Macintosh is that once you learn these skills, you'll use them
every time you use your computer-no matter what application program
you're running. That's because almost all Macintosh applications use the
Macintosh User Interface-the features that allow you and your

computer to communicate. Because the interface is consistent, you won't
have to relearn how to use your computer every time you get a new
application.

1
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switch

Getting ready
At this point your computer should be plugged in and ready to go. If that is
not the case, go to Chapter 1 in your owner's guide and follow the
instructions there for setting up your Macintosh.
Before you start the tutorial, you need to tum off your Macintosh.

@

~~ ~~@

• If it's already turned off, skip ahead to "Starting the Tutorial."

Figure 1-1

• If your Macintosh is turned on at this time, tum it off. For help in doing
this, read the appropriate instructions in one of the following sections
("Macintosh Plus," "Macintosh SE," or "Macintosh II").

On/off switch on the back
of the Macintosh Plus

Once you've turned off your computer, go to "Starting the Tutorial."
On/off

switch

Macintosh Plus
The on/off switch is located on the back of the Macintosh Plus. Figure 1-1
shows you where it is. Press the switch to tum off the computer.

Macintosh SE
The on/off switch is located on the back of the Macintosh SE. Figure 1-2
shows you where it is. Press the switch to tum off the computer.

Figure 1·2

On/off switch on the back
of the Macintosh SE

Macintosh Il

~~~~:-- Power off

8Witch

Figure 1-3

Power off switch on the back
of the Macintosh II
~

The correct way to tum off a Macintosh II is to choose the Shut Down
command from the Special menu. If you are completely unfamiliar with
using the mouse to choose a command from a menu (and don't have access
to someone who can do it for you), you can use the power off switch. The
power off switch is located on the back of the main unit. Figure 1-3 shows
you where it is. Press the switch once to tum off the computer. (You may
have to wait a second or two for the power to go off.)

Important The power off switch is not intended for regular use. If you have used a
Macintosh computer before, choose the Shut Down command from the
Special menu to turn off the computer. (If you aren't sure how to do this,
go ahead and use the power off switch this time.) 6
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Starting the tutorial
Follow these steps to turn on your Macintosh and start the tutorial:
1. Insert the disk labeled Macintosh System Tools into a 3,5.Jnch disk
drive, metal end first, label side up.

0

Figure 1-4
Inserting a 3.5-inch disk

When the disk ls most of the way into the disk drive, the Macintosh
automatically pulls it in and into place.

Starting the tutorial
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2.

Switch on your computer.
A beep lets you know it's started, and the soft noise you may hear is the
Macintosh getting information from the disk. An icon (a small picture)
representing a Macintosh appears, followed shortly by a message
welcoming you to Macintosh.
In a few seconds you'll see this screen:

Menu bar (showing titles
of menus you can use) ------~

II

••••
The desktop-your base of operations
for the computer and the place where
you organize and manage applications
and documents - -- - - -- - - - - -

Icons (one for the System Tools disk you
inserted and one that's always available
on the desktop-the Trash) - - - -- - -- - - - - - -- -..L..-- - -- -- - - - -- -

Figure 1-5

First screen

•:• Different screen? If your screen doesn't look like this, someone else may
have used this lesson and arranged the desktop in a different way.
If your computer has an internal hard disk drive and someone has already
set it up, you'll see an extra icon that represents the hard disk. For the
time being, just ignore the hard disk icon as you go through the rest of
this tutorial.
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How to use this tutorial
The tutorial gives you practice in the skills you need to work with your
Macintosh. It is designed so that you begin with the most elementary skills
and build on those skills, performing increasingly complex procedures. In
other words, the best way to take the tutorial is from front to back, exactly
as it's presented.
The actions you take to practice these new skills appear as numbered steps in
boldface type. Accompanying some steps you'll find comments or
explanation in plain type. Feel free to accommodate your own learning style.
It's a good idea to perform the actions in the numbered steps, but you can
decide whether you want or need to read the comments between steps.

Major topic - - --t-- - - - --

Mouse basics

Looking at a menu
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Figure 1-6

A section from this chapter
•!• When you want to take a break: You can complete the tutorial in one

sitting, or you can take a break whenever you want to. Good places to
take breaks are between major topics. When you decide to take a break,
it's best not to turn off the computer (or you'll have to retrace your steps
from the beginning).
How to use this tutorial

5

TUT

0

R

AL

What you'll learn
In this tutorial you'll be learning skills grouped under these topics:
• using the mouse-moving the pointer and moving objects
• choosing commands from menus-making things happen
• working with windows-resizing, moving, and closing them
Adocument is anything you create with
a Macintosh application, such as a letter,
a spreadsheet, or a picture.

• using an application-creating, editing, and saving documents
• organizing your work in folders-learning to use the file system
It may sound like a lot, but you can learn these skills in about an hour. You
can take a break whenever you want. Be sure to go at your own pace-enjoy
yourself!

Mouse basics
In this part of the tutorial you'll practice
• moving the pointer
• selecting icons
• dragging icons
Your Macintosh responds instantly to movements you make with the
mouse. You can start applications and open documents, work on them, and
put them away again-just by moving the mouse and pressing the mouse
button.
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1. Watch the screen while you roll the mouse on a flat surface next
to the Macintosh. For now, don't press the mouse button.
Every move you make with the mouse moves the pointer In exactly
the same way.

I:!

Pointer

-

- -- - -- -- -+---

tt-t-i -:.,~

y

./··~~f~,~:,:; ·:.·::·
·....

Figure 1·7
Controlling the pointer

You'll have the best control if you hold the mouse with its cable
pointing directly away from you and your index finger on (or close to)
the mouse button.
2. Watch the screen while you lift the mouse and put it down again

in a different place.
Notice that lifting the mouse doesn't move the pointer.
Whenever you run out of room for the mouse-if it goes off the table,
for instance, or runs into the Macintosh Itself-lift the mouse and put it
down again where you have more room.
Using the mouse might feel a little awkward at first, but it will soon be
second nature.

Mouse basics
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Selecting an icon by clicking

The Macintosh lets you organize your desktop any way you want, so one
thing you can do with your mouse is arrange the desktop to suit you. This
may not seem like much now, but you'll appreciate it as your desktop fills up
with icons. To move an icon, you first select it to let your Macintosh know
that this is the object you want to work on next. You select icons by using a
technique called clicking.
1. Position the pointer on the Trash icon.
Make sure the tip of the pointer is on the icon.
Click the icon by pressing and immediately releasing the mouse
button.

2.

S

11

cl1t

Figure 1-8

Selecting an icon
As you click the icon, it becomes highlighted. What was white is now
black, and vice versa. The highlighting shows that you selected it.
Notice that the System Tools icon is no longer highlighted. Selecting has
a specific meaning in the Macintosh vocabulary: you always select the
object or information you want to work on next.
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3. Click the System Tools icon.
Now the System Tools icon is selected, and the Trash icon is no longer
selected.
When clicking, try not to move the mouse as you release the mouse
button. Practice clicking each icon in tum until you can click without
moving the mouse at all.

Dragging an icon

Once you've selected an icon, you can use the mouse to move the icon with a
technique called dragging.

1. Position the pointer on the Trash icon.
2. Press and hold the mouse button while you move the mouse.
When you press the mouse button, you select the icon. As you move
the mouse, the pointer moves and drags an outline of the icon and its
name along with it. So you always know where you were-and where
you're going.
s

File

Edit

L11euo

~peual

~ !

......~

\
\
\
\
\

\

\~

-

Figure 1-9

Dragging an icon
Mouse basics
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3, Release the mouse button.
The icon snaps to its new place.
4. Now drag the System Tools icon.

Move the icon all the way to the left. Notice that it won't go off the
edge of the screen, so you don't have to worry about losing it.
Remember, lifting the mouse has no effect on what you're doing (but
releasing the mouse button does end the current dragging).

s.

Select the Trash icon and drag it to the top of the screen until
the pointer is in the menu bar, and then release the mouse
button.
This time the Trash icon stays where it was when you selected it. By
moving the pointer into the menu bar and releasing the mouse button
you canceled dragging. Whenever you change your mind, this is how you
cancel a drag in process.

Practice dragging until you can easily move the icons wherever you want
them.

What you've learned about the mouse
You've learned how to use the mouse to point to and select icons, and
you've seen how you can drag icons to arrange them on your desktop. Next
you'll learn how to act on what you select by choosing a command from a
menu.
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Choosing commands from menus
In this part of the tutorial you'll practice
• pulling down a menu
• choosing a command
Whenever you work with your Macintosh, you tell it two things: what you
want to work on, and what you want to do. First, you tell the Macintosh
what you want to work on by selecting it as you've been doing with icons
on the desktop. Then you tell the Macintosh what you want to do with the
selection. One way to do this is by choosing a command from a menu.

Selecting what you want
to work with

1.

Move the pointer to the System Tools icon.

2. Click the mouse button.
This is the same thing you've done before. Now the System Tools icon
is selected, and you can choose a command for it.

Looking at a menu

Along the top of the screen, in the menu bar, are the titles of several menus.
I

Menu

l11eu

Sp

Cl

I

title ----------~

Figure 1·10
Menu bar

Choosing commands from menus
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1.

Position the pointer on the word File in the menu bar.

2. Without moving the mouse for now, press and hold the mouse
button. Release it when you're finished looking.
Pressing the button with the pointer on a menu title causes the
title to be highlighted and a menu to appear. This is sometimes called
pulling down a menu (and the menus on your Macintosh are often called

pull-down menus).

Command you can choose - - - - - - ---+--< •
Print
r lose

Dimmed command that you
Get Info
can't choose right now - - - - - -- --+-Oup!i1:<11e

:l€ 1
:)[:!)

Put !lumq
Po qi~ S<o1 up"'
Print Birnc1oqJ."

Eject

:l€ E

Figure 1-11

File menu pulled down
The menu contains commands you can carry out on what you've
selected. Among other things, the File menu lets you open icons. (Notice
the word Open in the menu.)
Sometimes commands appear dimmed in a menu (for example, the Print
command in Figure 1-11). When a command is dimmed, you can't use
it-usually because it's irrelevant to what you're doing.
When you release the mouse button, the menu disappears.
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To choose a command from a menu, you use the same dragging technique
you used to move icons
1.

Position the pointer again on the word File in the menu bar.

2.

This time, press the mouse button and hold it down while you

drag the pointer to the word Open, and then release the mouse
button.

:)(:N

. I

Print

r lo~e
Get Info
lluplic<11e

~I
:}[:I)

..... !l<1111q

Figure 1-12
Choosing a command
As you drag through a menu, each usable command is highlighted in

turn. (Dimmed commands will not be highlighted.)
When you release the mouse button with the Open command
highlighted, an outline zooms out of the System Tools icon, and the
screen is almost filled by a window. The System Tools icon is dimmed
to show that the icon has been opened into a window.
Any time you change your mind about choosing a command, you can
move the pointer off the menu and release the mouse button. Nothing
is chosen unless you release the mouse button while one of the
commands is highlighted.

What you've learned about choosing commands
To sum up what you've practiced: first you selected something (the System
Tools icon), and then you chose a command (Open). You'll follow this
pattern whenever you work with your Macintosh: select an item, then choose
an action for it.
•!• Need a break? Remember, you can take a break from this lesson at any
point, leave the Macintosh switched on, and pick up where you left off.
Choosing commands from menus
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Working with windows
In this part of the tutorial you'll practice
• changing the size of a window
• moving a window
• arranging windows that overlap
• making a window active
• closing a window
• using the scroll bars on a window
Adirectory window is any window that
shows you the contents of a disk or folder.

You'll see a lot of windows as you work with your Macintosh. The window
on your screen now displays a directory of icons representing the contents
of the System Tools icon.
Different windows may serve different purposes (some are areas where you
do work, some give you information, and so on). Figure 1-13 illustrates the
features most windows have in common.

Close box--0ne way
to close a window - - - -- -- Title bar _ _ _ __ _ __ __ ______,/

- -- Zoom box-to let you
enlarge (or shrink)
a window with one click

Title (notice that the title of the window
is the same as the name of the disk icon
you opened) _ __ __ _ __ ____,

Scroll bars-to let you
get around in large
directories or documents
~

Size box-to let you
tailor the size of a window
exactly as you want it

Figure 1-13
Directory window for the System Tools disk icon

In this section of the tutorial, you'll see how to use these features of a
window to manipulate it.
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When you're working on a document on your desktop, it's great to have a
wide-open window so you can really see what's there. But small windows
also have advantages. They take up less space on your desktop, and you can
move them around to see the contents of more than one window at a time.
One way to change a window's size is to use the size box in the bottomright comer of the window.

1. Position the pointer on the size box, press and hold down the
mouse button, and drag up and to the left.
I LI

....................................................................,, .......... ,, ..................................................... ..

''

'

\J

Figure 1-14

Using the size box

2. Release the mouse button.
AB you drag, a dotted outline follows. The farther to the left you drag,
the narrower the outline becomes; the farther upward you drag, the
shorter It becomes. When the outline is as small as you can make It, It
stops moving. When you release the mouse button, the window
changes size.

The contents of the window don't change at all when you change a
window's size. The only thing that changes is how much you can see.

Working with windows
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Another way to change the size of a window is to use the zoom box. In a
way, the zoom box is easier to use than the size box because you don't have
to drag anything; all you do is click. On the other hand, you cannot use the
zoom box to make fine adjustments in the size and shape of a window.

1. Position the pointer on the zoom box and click.
The window zooms out to nearly fill the screen.

Zoom box

[ ri
l.J

..

lo

t1

F

1

r

l
Figure 1-15
Zooming a window

2. Click the zoom box again.
The window returns to its former size. Using the zoom box lets you use
almost every square inch of the screen for what you're currently
working on and, with a single click, brings you back to your former
view.
Experiment with controlling the size of the System Tools window. Drag the
size box down and to the right to make the window bigger again. Then try
all different lengths and widths. Use the zoom box and notice how the
Macintosh always shrinks the window back down to whatever size it was
before you zoomed it out.
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Just as you moved icons, you can move windows on your desktop. To move
a window, drag it by its title bar. Don't, however, drag it by the zoom box or
the close box, the small box on the left in the title bar. The close box is just
for closing the window.

Moving a window

1.

Position the pointer anywhere on the title bar of the System
Tools window (except in the zoom or close boxes).

~ File

Close box (don't drag from here)

I

~
I

Drag a window by its title bar

4

7

•+ , /

- - -- - ! - - - , -- - - - - J

1

I

>;

Lliew

[dil

Sp_ec_1a_1_ _ _ _ _ _ _ _~-----d

s~ee m Tools
(?'~f 1n ·11 -~

_

=

'

~ ',~

~ ~t•m

Fold:

~

Zoom box (don't drag from here) - - - -+-- - --,.-- - - - /

I
';;/

_____ .. .,. --

Figure 1-16
Moving a window

2.

Drag the System Tools window by pressing and holding down the
mouse button while you move the mouse.

3. Release the mouse button.
Just as when you dragged icons, a dotted outline of the window
follows your movements. When you release the mouse button, the
window moves to the new location. If you release the mouse button
before you have the window where you want it, just "pick the window
up" again.
If you change your mind about moving it, cancel the drag by moving
the pointer into the menu bar and releasing the mouse button. Just as
icons stayed within the limits of the desktop, so do windows. You
can't lose them by dragging too far.
Practice your new skills. When you can manipulate the window easily,
making it any size and putting it anywhere you want on (or partially ofO the
desktop, go on to the next section.
Working with windows
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Use your new window-handling expertise to get the System Tools window
out of the way if you need to. Shrink it down and move it around so you can
see the Trash icon.

1. Select the Trash icon.
2. Choose Open from the File menu.
As you've done before, move the pointer to the File menu title, press the
mouse button, drag to the Open command, and release the button.
Asecond window appears on the desktop, probably overlapping the first
(depending on where you left the first window and what size you made it).

Overlapping windows
With the Macintosh, you can have many windows on your desktop at the
same time. When there's more than one window, the Macintosh needs to
know which one you're working on at the moment so that the commands
you choose and the text you type end up in the right place. The window
you're working on is always the active window. (With several windows
open, the active window is likely to be in front of the other windows.) The
active window's title bar is highlighted with narrow horizontal lines on either
side of the title.

t

Inactive window - - - -- -- - - - - - - -

D

Tra sh

BJ

0 items

~
Active window

121
Figure 1-17
Overlapping windows
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When you opened the Trash icon, it automatically became the active,
frontmost window-the window you're working in. The System Tools
window is also open on the desktop, but it's no longer the active window.
To work in the System Tools window again, you make it active by clicking
once anywhere inside it.
If you left the System Tools window small before you opened the Trash
window, it may be completely hidden by the Trash window now. You know
how to move windows and change their size, so if you can't see the System
Tools window, move the Trash window or change its size until you can see
the System Tools window again. It doesn't have to be completely visible. As
long as you can see part of it, you can make it active.

Making a window active

1.

Click in the System Tools window.

D
4 items

7 59K in disk

LlJ

Sy stem Folder

2I

0

System Tools

y

2DK ava il able

~

LJ

§

Se tup Folder

N

@

IQ
Q]

Figure 1-18
Making a window active

The window is brought to the front of the desktop. Its title bar is
highlighted, and scroll bars and a size box appear to show it's the active
window. Whenever you want to work in a window that isn't already
active, you first make it active by clicking in it.
The position and size of your windows might not look exactly like the
ones here. Your Macintosh does exactly what you tell it to do; the size
and position of your windows are up to you.
Working with windows
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2.

Click in the Trash window.
Now it becomes active and moves in front of the System Tools window
again.

Experiment with arranging your desktop-making each window active in
turn, changing its size, and moving it.

Opening other icons

You can open icons inside a directory window, just as you opened icons on
the desktop. You know how to open an icon by selecting it and choosing
Open from the File menu. And there's another way to do the same thing-a
shortcut called double-clicking. Next, you're going to use this technique to
open the System Folder in the System Tools window. (If necessary, first
make the Trash window smaller; then make the System Tools window
active and large enough that the System Folder icon is visible.)
1.

Position the pointer on the System Folder and quickly press and
release the mouse button twice.

System Folder
16 iti?ms

System

759K in disk

Finder

MulhFinder Scrapbook File Clipboard File

T

Figure 1-19
Opening an icon in a window
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If the System Folder window doesn't appear when you double-click,
shorten the interval between your clicks. That way the Macintosh will
be able to interpret your action as a double-click, and not just as
insistent single clicks. Now you have two ways to open icons.

Inside the System Folder are icons that represent system files; these
contain information the Macintosh needs in order to operate.

2.

Open the Setup Folder, either by double-clicking it or by
selecting it and choosing Open from the File menu.
If necessary, first move or change the size of the System Folder
window.

T ol.-

F

r

I'

tJ

t F d

~O~ Setup Folder ~0~
t

3 items

759K in disk

20K available

~

~
Ins tall er

Appl• HD SC Setup

Instal ler Scripts

Figure 1-20
Directory window for the Setup Folder

The Setup Folder contains icons that represent utility programs.
While you use the system software in the System Folder every time you
switch on the Macintosh, utilities are tools you use occasionally. You
use the utilities in the Setup Folder to set up a hard disk drive (if you
have one) and to install Macintosh system software on other disks.
(You also received two utilities disks with your Macintosh. The utilities
on those disks are described in the Macintosh Utilities User's Guide.)
Working with windows
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You can have many windows on your desktop, but to keep things tidy, you
might want to close some when you're finished working on them, and open
them again when you need them.
1.

Make the Trash window active by clicking in it.

2.

Choose Close from the File menu.

Get Info
nup!kide
Put numq

~I

' ' il

Page Setup .. .
Print Directory .. .
Eject

~E

Figure 1-21

Using the Close command to close a window

The window collapses back to an icon. Whenever you choose Close from
the File menu, the frontmost, active window is closed, and the next
window behind it becomes active.
Now close the Setup Folder window by using another shortcut. The close
box in the title bar lets you close an active window with a single click.
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3. If it's not already active, click the Setup Folder window to make
it active.
Remember, when you can see horizontal lines in the title bar, a window
is active.

4. Click the close box.

t IY1

T l·:'

11

"

1

Figure 1-22
Using the close box to close a window

The result is the same as when you choose Close from the File menu.

Working with windows
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Windows on the desktop often can't show you the entire directory or
document all at once, even when you've made the window very large.
There's often more information than can fit in the window at one time.
The scroll bars in an active window let you move what's in the window so
you can see more of it.
1.

Click the System Folder window to make it active.

2.

Make the System Folder window small enough that some of the
icons are hidden from view.

Position the pointer in the size box, press the mouse button, and drag up
and to the left to shrink the window. When it's small enough, release
the mouse button.
Notice that when you release the mouse button with some icons
hidden from view, one or both scroll bars become active (that is, they
turn gray).
3.

Figure 1-23

Scrolling a document

Click the scroll arrow that points down.

More icons come into view. You can scroll down, up, right, or left by
clicking the corresponding scroll arrow. You can also scroll by dragging
the box in the scroll bar.
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Using scroll arrows
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Drag the box in the vertical scroll bar to the top of the scroll
bar and release the mouse button.

4.

s
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Figure 1-25

Using the scroll box

Nothing in the window moves until you release the mouse button.

What you've learned about working with windows
At this point you've practiced all the skills you need to work with windows.
You've changed their size, moved them around, made inactive windows
active, used scroll bars to see more information, and closed windows to get
them out of the way.
You might be wondering what all this has to do with your work-the
documents you'll create with Macintosh applications. You'll use the skills
you just learned in nearly all applications. You usually select information and
choose commands in consistent ways. And windows are always opened and
closed, changed in size, moved, and made active using the same techniques
you just learned.

•:• Need a break? Remember, you can take a break from this lesson at any
point, leave the Macintosh switched on, and pick up later where you left
off.

Working with windows
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Using applications
In this part of the tutorial you'll practice
• starting an application
• creating a document
• saving your work on a disk
• editing text in a document
• saving different versions of a document with different names
Most of the applications you'll use with the Macintosh come on their own
disks. TeachText-the sample application you'll use in the next few
sections-is already on Macintosh System Tools, the disk you used to start
this tutorial.

Starting an application

1. Close the System Folder window if you haven't done so already.
2.

Make the System Tools window larger, if necessary, to see the
TeachText icon.

Use the technique you learned earlier for changing the size of a window.
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3. Open the TeachText icon, either by double-clicking it or by
selecting it and choosing Open from the File menu.
You see the TeachText screen- an empty window ready for you to type
in some text.

Menu titles
Close box
Blinking i nsertion point
Title bar
Zoom box

L L " _L: di

p

titled

7

1

71

l

Scroll bar

lnl

-

Size box

i1:'_

Figure 1-26

TeachText screen
Like most applications, TeachText has its own menus, and its window has a
title bar, close box, size box, zoom box, and scroll bars. Also like most
applications, TeachText always opens with an "Untitled" window. You
create whatever you want with the application and then name the
document when you save it.
For now, you'll use TeachText as a sample application- and learn how to use
applications in general.

Using applications
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Now that you've started TeachText, you need to use the keyboard to create
a document.

•:• Different pointers: Usually the pointer is shaped like an arrow, but it
changes shape depending on what you're doing. Right now it's an
I-beam. It changes to the I-beam pointer when it's positioned over an
area where you can type text or where there's text you can edit.
(Sometimes it changes to a wristwatch to let you know that the
Macintosh is doing something that takes a little time.)
On the screen, a blinking vertical bar marks the insertion point, where text
you type will be inserted. If you make a mistake, use the Backspace (or
Delete) key to erase characters back to where the mistake is, and then start
typing again.
1.

Use the keyboard to type this sample paragraph:
The following is my best guess for a production
schedule. Please keep in mind that it is subject to
change once reality gets underway. Let me know if I'm
cheating anyone of the time he or she needs, or if I'm
not allowing for black holes.

You'll use the Macintosh keyboard mainly for typing text and numbers.
The main part of the keyboard is very similar to a typewriter keyboard.
Use the Shift key for capital letters.

2. As you type, do not press the Return key when you get to the end
of a line.
Most applications that let you enter and edit text-such as word
processing applications-start the new lines for you. It's a feature called
word wrap, so called because if a word is too long to fit at the end of
one line, the word wraps around to the next line automatically.
You'll have a chance later to learn more about adding and editing text, but
now you need to give the document a name and save it.
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This procedure gives the document a name of its own and puts a copy of it
(with that name) on the disk. It is stored there, as is, until you decide to
rename it, change it, or delete it.
1. Choose Save As from the File menu.
A dialog box appears. When your Macintosh needs more information
from you, it presents a dialog box with buttons to click, such as OK or
Cancel, and may include a place for you to type additional information.
The dialog box that appears now is called a directory dialog box. It gives
you a different view of the same directory you see in a directory
window on the desktop. It also gives you several options-including
the chance to save your document on any disk you choose. At this
point, you'll save your document directly on the Macintosh System Tools
disk. (For now, ignore the other options you see.)
The item of immediate interest is a text box in which you can type the
name of your document. (You see the label "Save this document as:"
just above it.) Because the text box is selected (highlighted), the name
you type will replace "Untitled" automatically. There's no need to use
the mouse to position the pointer in the text box.

I(g) system Tools I
r l D He<1d Me

Another view
of a direc tory

D Setup Folde r
D System Foiaer
(}< fed( h°!PH t

I

'"-1

Save button

JQJ
Saue this do cument as:
nu ' I

Text box

IQ (g) System To ...
[ Eject l
[ nrit>e l
l Saue

(

Cancel

l

Figure 1-27
A directory dialog box
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2. Type

First Memo in

the text box.

3. Click the Save button.
Your document is saved on the disk just as it appears on the screen. After
the Macintosh saves the document, the title bar shows the name you
just gave it.

•:• Save early and often: Once you've given your document a name, if
you continue working on it, make a habit of choosing the Save
command from the File menu about every 15 minutes or so. (It's a
good thing to do while you're waiting for your next inspiration.)
That way, if your Macintosh gets switched off or there's a power
failure, you'll never lose more than 15 minutes' worth of work.
With your work saved on the disk, you can quit TeachText and return to
the desktop.

4. Choose Quit from the File menu.
The desktop appears again. But now the icon of your new document
appears in the System Tools window.

Your new document's icon -------+--------____...,~
~
oF

D

Fi r st Memo

)-

Figure 1-28
A document icon
30

Chapter 1: Tutorial: Learning Macintosh Basics

T

U

T

0

R

A

L

This new icon represents the document you created, and below it is the
name you gave it. When you work on this document again, you'll select and
open the icon just like any other icon.
......:-.

;~~~l
\•/ord

Proi::e~sor

;'.~·:~~l
::;;pn:-ad:sheet

Figure 1-29

Document and application icons that resemble each other
Most documents you create will have an icon particular to the application
you used to create them, so you can tell which application you used to create
each of your documents.
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Now you know how to create and save a document. But suppose you need
to modify it in some way? In this part of the tutorial, you'll learn how to
revise a memo you've written.
1.

Open the First Memo icon.

Opening the document you want to work on also starts the application
you need to do the work. You don't have to open the application first
and then open the document.
Special

OOW

........ .................................................... ~ Sys I em Toolj:l\~~iiii~~f10Jt·
Gel Info
001
... !f i ill
l~
Duplicate
000 =
!'ut !lumq

Selected document icon - -- -- - -+-----<== = = = =+-Page Setup ...
Print Directory ...
£ject

,D

F

00£

Figure 1-30
Opening an application by opening a document icon

The TeachText application starts, and the document you saved earlier
reappears, just as 1t was when you saved it.
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2. Move the insertion point by clicking in front of the s in the word
subject.

Figure 1-31
Moving the insertion point

You're moving the insertion point to where you want to add text.
)

3. Type not.
What you type appears at the insertion point. (Don't forget to add a
space after not.) You probably noticed that when you added text, the
words on the other lines rewrapped to accommodate the extra word.
Now you'll select some text and move it to another part of the document.

4. Select the entire second sentence by positioning the pointer
after the period that follows the word schedule and dragging to
the end of the sentence.

Figure 1-32
Selecting text

First drag down, and then drag to the right. (Be sure you include the
period at the end of the sentence.) If you move the pointer off the
sentence, you might select more than just the sentence. If this happens,
just start dragging over again; nothing unexpected can happen while
you're selecting text.
When you drag through text, you're selecting information to work on,
as you did when you selected icons. You selected icons by clicking them;
you select text by dragging across it or down through lines of text.
Using applications
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5.

Choose Cut from the Edit menu.
The sentence vanishes. Whenever you choose Cut or Copy from the Edit
menu, whatever you cut or copy is put in a holding place called the
Clipboard, ready for you to paste it to a different location if you
want. (You use Copy when you want to leave the selected text where it
is and put a copy of it somewhere else. Copy works just like Cut, except
it leaves the text you selected in the document.)

6. Move the insertion point by clicking after the period that
follows the word holes.

\/
Figure 1-33

Moving the insertion point

7. Choose Paste from the Edit menu.
The contents of the Clipboard-in this case, the sentence you just
cut-are pasted into the location you selected.

Ple •lSe keep in rnin1j that it i s not sut•ject to
underv·1ayi

c ~1 a n ge

once re ality gets

Figure 1-34

Pasting in text
The contents stay on the Clipboard until you replace them by choosing
Cut or Copy again (or shut down the computer). This means you can
continue to paste them. You can paste within one document, between
two documents created with the same application, or between
documents created with different applications. For example, you can
draw a picture with a graphics program and use it in a report you create
with a word processing program.
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Now that you've edited your original memo, you need to save your revision.
When you're finished making changes to a document, you have two choices
for saving. You can choose Save from the File menu, and the revised
document is saved with the same name you gave the original. That's fine if
you don't want to keep a separate copy of the original document. But you
may want to save the revision and keep the original, too. (For example, you
may have a form letter that you keep as an original; you can personalize the
letter and save different versions with new names.) To do this you choose
the Save As command from the File menu.
1. Choose Save As from the File menu.
A directory dialog box appears. (It's the same one you saw when you
named your first memo.) The name of the original document appears
highlighted in the text box.

i-1

L

[tZl Slj\lem Tools]

Setup folder
Sy\tem ro1oe1

\at•e tr1s document <H.
Original document's name,
highlighted in text box - - - - - - - - irst Memo

[
Sat•e

~el

Figure 1-35

Save AB dialog box
You can edit the names of documents just as you would other text. (Or if
you prefer, you can just type a new name for the document rather than edit
the old one.)
2. Position the pointer at the beginning of the word First and drag
to the end of the word to select it.
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3. Type Second.
Typing over the selected text replaces it automatically.
SlfSI m Tools]

\ I IP fold r

l

\L•'emFole'e

ISec on~ Me mo
Figure 1-36
Changing a document's name

4. Click the Save button.
You've saved the revised memo with a new name. Notice that the title
bar has changed to show the name you just gave the revised memo.
Your original document is still saved, unaltered, with its own name.

Figure 1-37
Document with its new title

5. Choose Quit from the File menu.
You return to the desktop, where you see both the icon for your original
document and an icon for the revised memo with the name you just
gave it.

What you've learned about using applications
With TeachText, you've practiced starting an application and using it to
create, save, and modify documents. You've learned new skills and built on
earlier skills in performing these tasks. By the end of the next (and final)
section of the tutorial, you should be an accomplished Macintosh user.
36

Chapter 1: Tutorial: Leaming Macintosh Basics

TUT

0

R

AL

Organizing documents
In this final part of the tutorial you'll practice
• creating and naming folders
• putting folders into folders (nesting)
• moving through the hierarchical file system
• opening and saving documents within the hierarchical file system
• removing documents and folders you don't need any more
You've seen how to start an application and open a document, save it, and
quit the application to return to the desktop. This part of the tutorial shows
you ways you can organize your documents-group them together with
related documents, duplicate them, rename them, or throw them away.

Using folders

Macintosh folders work just like ordinary file folders to help you organize
your documents. For instance, you could keep all your monthly status
reports together in one folder. Or group all your illustrations together, or
keep each one with the report it illustrates. The Macintosh lets you organize
your documents however you want them.
You've already got some folders on the Macintosh System Tools disk. To
organize your own work, you have an endless supply of empty folders.

Organizing documents
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Start a new folder by choosing New Folder from the File menu.

1.

A folder named "Empty Folder" appears in the System Tools window.
•

File

Edit

Lliew
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Figure 1-38

Anew folder
The empty folder is automatically selected when you create it, so you
can rename it just by typing. (If you can't see the entire icon, you can
make the window larger or move the icon.)
2.

Type

Memos

and press Return.

Pressing Return confirms your new folder name. "Empty Folder" is
renamed "Memos."
Usually you have to click an icon before you can type a new name. But
you don't have to click newly created folders to rename them. (They're
already selected for you.)
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3. Drag each of the two document icons to the Memos icon,
releasing the mouse button when the Memos icon is highlighted.

r

4 IE
w-

:_ ________ _

r

IMIGtt'ffi'J

Figure 1·39
Dragging a document to a folder

When you cover the folder icon with the outline of each document icon,
the folder icon is highlighted. As soon as you see the change to
highlight, "drop" the document icon into the folder by releasing the
mouse button. The folder icon is no longer highlighted, and your
document icons disappear into the folder.

4. Open the Memos icon.
There are the icons that represent your two documents.

0

Icons you moved
into the Memos folder --------~§
-,-=--,'-~B

0

r

Figure 1-40
Memos folder opened
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When you drag a document icon to a folder icon, you file the document
there. You can also drag a document icon into an open folder window; the
result is the same.

Nesting folders

Large-capacity disks-especially hard disks-can hold hundreds of documents
and folders. At some point, you may find it helpful to place folders within
other folders to keep your work organized.

1. Close the Memos window if it's not already closed
Simply click the close box.

2. Choose New Folder from the File menu.
You see an "Empty Folder" in the System Tools window.

3. Name the new folder by typing TeachText Folder and
then pressing Return.

4. Put the Memos icon and the TeachText icon into the TeachText
Folder.
Use the technique you just learned for placing documents in folders.

5. Open the TeachText Folder.
You see both the TeachText application icon and the Memos icon in the
TeachText Folder directory window.

0

TeachleHt Folder

2 items

TeachTex t

760K in disk

Memos

Figure 1-41

TeachText Folder opened
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6, Open the Memos folder.

s

File

Edit

Uiew

Sperial

First Memo Second Memo

Figure 1-42
Memos folder opened

Notice that each folder has its own directory window. The active
window is the folder you just opened. (But you can still change the
active window by clicking anywhere in another window.)

7. Close the Memos folder and then the TeachText Folder.
As you close each folder's window, it collapses back into its icon in the
previous window, until you reach the System Tools window.

Placing folders within folders is called nesting. You can continue
nesting folders until you have about 12 levels, but most people find that
retrieving documents and applications nested more than four levels deep
becomes tedious.
When you nest folders, you create a hierarchy. When all of the folders on
a disk are closed, and the disk's directory window is open, you're looking
at the top level of the hierarchy. When you open a folder on the top
level, its directory window shows you the second level of the hierarchy.

Organizing documents

41

T

U

T

0

R

A

L

8.

Open the TeachText Folder.

You see the second level.

0

TeachTeHt Folder

2 items

Teach Text

760K in disk

19K available

Memos

Figure 1-43
Second level of the file hierarchy

If there's a folder in that second level-in this case, Memos-when you
open it, you see the third level, and so on.
9.

Open Memos.

You see the third level of the hierarchy-the two memos.

0

Memos

2 items

760K in disk

19K available

Firs t Memo Second Memo

~

Figure 1-44
Third level of the file hierarchy

The feature of the Macintosh that lets you nest folders is called the
hierarchical file system. (It's sometimes abbreviated HFS.)
42

Chapter 1: Tutorial: Learning Macintosh Basics

TUT

0

R

Moving through the
hierarchical file system
within an application

AL

When you're working with an application, moving around in the hierarchical
file system would be tedious (and confusing) if you had to quit the
application and go back and forth through all those folder windows
whenever you wanted to open a new document. Fortunately, you can open
documents while you're within an application. This section of the tutorial
will show you how.
The first three steps are here to get you ready to use the hierarchical file
system from within the TeachText application.

1. Close the Memos folder to get it out of the way.
2.

Open the TeachText icon to start the application.

3.

Close the Untitled window.
Either click the close box or choose Close from the File menu.
You don't want to create a new document right now. With "Untitled"
closed, you can use the hierarchical file system to open one of the
documents you created earlier.

4. Choose Open from the File menu.
You see this directory dialog box:
Title of the folder
you're working in - - - - - - - - - - -1 ':_j Tearhle11t Folde1)

CJ Memos

·

\y~

tc>m

l

E1ecQ

(

_J

Tool~

OpeQ

,,

, c anceJl

Figure 1-45
Directory dialog box for the Open command

A title shows you the name of the folder you're currently working
in-TeachText Folder. The box beneath it shows you all the items in the
TeachText Folder that you can open with this application-in this case,
only the Memos folder.
Organizing documents

43

TUT

0

R

AL

Remember, you got to this dialog box by choosing the Open command.
What you see in this dialog box is a selective view from within
TeachText of items you can open in TeachText. Even though the
TeachText Folder also contains the TeachText application, that is not
something you can open from this dialog box, so its name does not
appear in the list.
You can always open folders from within this dialog box.

5. To open the Memos folder, click the Open button.
Memos is already highlighted, showing that it's selected, so you can
click Open without selecting Memos first. (You can also double-click the
name Memos to open it.)
As you open Memos, you move down through the hierarchy. The title
changes to remind you where you are in the hierarchy, and the box
shows you what's on the new level you just moved to-in this case, the
two documents in the Memos folder. The selected document is the one
that will open when you click the Open button. If you want to open
another document, click anywhere on its name to select it, and then
click the Open button.

Items you can select
and open - - - - - - - - - - - - <
(t

Open button - - -- - - - - -- - -- - - - - - -- - -

e 111;
m I

,

Figure 1-46
The next level in the hierarchy

If you want to open a document that's located somewhere else in the
hierarchy, you can move to another level by using the pull-down list
available from the title.
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6.

Position the pointer on the title and press and hold down the
mouse button.

Release the mouse button when you've seen enough.
fl
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Figure 1-47
Directory hierarchy

This pull-down list is similar to the menus you used earlier, except that
rather than showing commands, this list shows the path through the
hierarchy back to the top level. (The top level is always the last on the
list.) You choose the level you want by dragging down the list and
selecting it.
7.

Now press the mouse button again and choose TeachText Folder
from the list.

61 Memos
I

e
ct

I

)

Figure 1-48
Choosing a different level in the hierarchy

The title changes again. You chose to see inside the TeachText Folder,
and now you see the Memos folder, contained in the TeachText Folder.
Organizing documents
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8. Pull down the list again and choose System Tools.

The list changes again, and you see the folders on the top level of the
hierarchy-in this case, the System Folder, the TeachText Folder, the
Setup Folder, and the Update Folder.
So far, all you've seen in the box are folders and the documents you can open
with TeachText. When you open a document from within an application, the
dialog box shows you only folders and documents that you can open with
that application. If you open a folder and you don't see anything listed
below its title, it's because that folder doesn't contain anything you can
open with the application you're using.

Opening a document
within an application

Now open one of the memos.
1.

Open the TeachText Folder.

2.

Open the Memos folder.

3.

Open either of the two memo documents.

The first document in the directory, First Memo, is automatically
highlighted. If you want to open Second Memo, click its name, and then
click Open.
•!• So far.. . To review what you've learned so far: You've seen how to use

the Open command dialog box to move through different levels of the
hierarchy on the Macintosh System Tools disk. The directory title tells you
where you are in the hierarchy, and the pull-down list lets you move to
different levels within it. The box beneath the directory title shows you
the folders and documents on each level that you can open with the
application you're using. Now you'll use a similar technique to move
through the hierarchy when you save a document.
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Saving a document in the
hierarchical file system

1. Choose Save As from the File menu.
You don't need to make any changes to the document. Right now, you
just want to save a version of the document with a different name.
You see the familiar Save As directory dialog box.

M 11'

n •I

Figure 1-49
Save As directory dialog box

This time, you'll choose a different level of the hierarchy to save the
document on.
2.

Pull down the list and choose the TeachText Folder.
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Figure 1-50
Choosing the TeachText Folder
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You see the contents of the TeachText Folder-the TeachText
application and the Memos folder. The directory title changes again to
show you where you are in the hierarchy.
When you're saving a document, you see all the applications, folders,
and documents on that level in the window. Seeing everything gives
you a chance to make sure you're not saving this document with the
same name as something else that's already there. That way, you won't
inadvertently lose anything by using the same name. (Actually, if you
choose Save As and save a document with the same name as another
item in the directory, you'll get an alert message asking you to confirm
that you want to replace the other document.)

3. Type

the text box.

Third Memo in

4. Click the Save button.
You saved the new document in the TeachText Folder.

5. Choose Save As from the File menu.

lt5.J TeachleHI

folder

I

D Memos

(g) System To ...

c Ej~
[
Document with the same name
Saue this doc ment a\.
already saved at this level
Third
Memo
of the hierarchy - - - - - - - - --H--1=
==
======

Figure 1-51
Changing a document's name

Again, you see the directory dialog box. This time, you see the name of
the document you just saved listed in the box along with the other
items in the TeachText Folder. Now you have memos saved at two
different levels of the hierarchy--0ne at the second level in the
TeachText Folder, and two at the third level in the Memos folder.
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6. Type

Fourth Memo

in the text box.

7.

Click the Save button.

8.

Choose Quit from the File menu.
The Macintosh returns you to the directory window for the TeachText
Folder, where you see the icons for your new memos.

Removing documents
and folders

You're almost finished with this tutorial. Before you go, it will help the next
person who uses this tutorial if you leave everything the way you found it.

1.

Drag the TeachText application icon from the TeachText
Folder you created earlier to the System Tools directory
window.
It will be there if you or anyone else wants to use the tutorial.

2. Drag the Memos folder to the Trash.
This removes the folder and its contents (two memos).

3. Close the TeachText Folder window and drag the folder to the
Trash.

4. Choose Empty Trash from the Special menu.
The items you placed in the Trash are effectively erased.
Congratulations, you've completed the tutorial.

Organizing documents

49

TUT

0

R

AL

Starting your own work
You have practiced using most of the skills you need to put your Macintosh
to work. What you do next is up to you, but here are some suggestions to
get you started.
• Does your Macintosh have a brand-new hard disk? If your system
includes a hard disk, go now to Chapter 8, "Hard Disks," to get your hard
disk set up and running.
• Do you have some application programs? If you have applications
to use on your Macintosh, you can start working with them. Be sure to
read the manuals that came with them, and enjoy your Macintosh.
• Do you plan to use application disks as startup disks? You may
want to update your application startup disks so they'll take advantage
of the latest improvements in the system software on the Macintosh
System Tools disk. To update application disks, you use a utility program
called the Installer. In Chapter 9, "Startup Disks," you'll find instructions
on using the Installer to do this.
• Do you want to learn more about your Macintosh? If you'd like to
know more about how your Macintosh works, read the rest of the
owner's guide that came with your computer.
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Basic Macintosh Techniques

HO NEEDS THIS CHAPTER?

This chapter summarizes basic techniques you'll use whenever you work
with your Macintosh computer-from clicking and dragging to the
fundamentals of editing text. If you've already completed the tutorial in
Chapter 1 or are familiar with operating the mouse, scrolling windows,
moving icons where you want them, and so on, you can skip this chapter for
now. Later, if you've forgotten how to perform a particular task and want a
refresher, the information will be here when you need it.

51

What's in this chapter?
There are three topics covered in this chapter:
• using the mouse
• using windows
• editing text

Using the mouse
You can do all your work on the computer (except type text and numbers)
with these mouse techniques:

• click, to select an item or make it active (including the variations doubleclick, to select and open icons quickly, and Shift-click, to select two or
more icons when they're not grouped)
• press, to cause a continuous action with an item you've selected
• drag, to move an item you've selected (including dragging to select a
contiguous group of icons or a block of text)

Selection
Every time you press the mouse button, you make a selection, an important
part of communicating with your Macintosh. It's your way of telling the
computer what you want to work on before you tell it what you want it to
do. Here's an example: You select a folder named Memos, the computer
highlights it to acknowledge your action, you choose the Open command,
and the computer opens the folder. It's the equivalent of your saying, "The
Memos folder is the one I want opened. " Your actions tell the Macintosh
what to do.
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Clicking

1. Position the pointer on what you want to select or make active.
2. Press and quickly release the mouse button.
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Figure 2-1

Clicking

Whenever instructions tell you to click, this is the action you should take.
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Double-clicking

1. Position the pointer on an icon.
You can choose a document, a folder, or an application that you want to
open.

2. Press and release the mouse button twice in quick succession.
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Double-clicking

Double-clicking is a handy way to open a folder, application, or document. Of
course you can always open an icon by selecting it and choosing Open from
the File menu, but many Macintosh users find that double-clicking is quicker.
Another handy use of double-clicking is to select a word in text. For example,
if you want to delete a word from the middle of a sentence, double-dick the
word to select it. Then press the Backspace (or Delete) key.
If you try double-clicking and aren't getting the expected results, you may
be clicking faster or slower than the computer is set to accommodate. Use
the Control Panel to adjust the speed to suit your personal style. (If you
don't know how to use the Control Panel to change the double-dick speed,
see "Using the Mouse Control Panel" in Chapter 5.)
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Shift-clicking

Shift-clicking is a technique you can use when you want to select icons that
are scattered in different places. To select several icons that are neatly
grouped together, you can use a different technique. See "Selecting Grouped
Icons by Dragging," later in this chapter.
1. Select something by clicking.

2. Hold down the Shift key while you continue to select (or
deselect) by clicking individual icons.
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Shift-clicking to select random icons as a group
As long as you hold down the Shift key, each icon you click will be added

to the selected group. If you change your mind about including a
selected icon, you can Shift-dick to deselect it.
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Pressing

1. Position the pointer on a menu title, a scroll arrow, or
wherever you want the action to happen.
2. Without moving the mouse, press and hold down the mouse
button.
As long as you hold down the mouse button, the effects of pressing

continue. Pressing on scroll arrows results in continuous scrolling.
Pressing on a menu title pulls down the menu and keeps it down until
you release the mouse button.
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Pressing
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Dragging

1. Position the pointer on an icon.
2. Press and hold down the mouse button, and move the mouse.
As soon as you press the mouse button, the icon will be highlighted

(showing that it's been selected). Then, when you move the mouse, an
outline of the icon moves along with the pointer.

3. Release the mouse button.
When you release the mouse button, the icon you selected moves to the
new location and replaces the outline.
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Dragging

To cancel dragging

1. Before releasing the mouse button, move the pointer back to
where you started dragging.
You can also cancel dragging by moving the pointer into the menu bar.
You can cancel dragging in a menu by moving the pointer off the menu.
2. Release the mouse button.
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Selecting grouped icons
by dragging

When you want to select icons that are grouped together, you can do it by
dragging diagonally to enclose them all in a selection box.

1. Position the pointer above and to the left of the group you
want to select.
Make sure the pointer is not actually touching any icon.

2. Press and hold down the mouse button while you drag
diagonally, down and to the right.
The outline of a box will appear, enclosing the icons you want to select.
(If you have selected only one icon, the pointer was too close to that
icon. Click in a clear space to deselect that icon, then try again.)
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Dragging diagonally to select icons as a group
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3. Release the mouse button.
As soon as you release the mouse button, the icons will be highlighted

to show that they are selected. Now, any action you perfonn on one of

them will happen to all of them. For example, you can drag the whole
group to the Trash or to a different folder.
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Icons selected as a group

You can select a group of icons only if they're all in the same window or all
on the desktop. If you want to work on a number of documents from
different folders or disks, drag them to the desktop and select them all there.
Operations on a group of icons are usually perfonned one by one-printing a
group of documents, for example.
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Using windows
A window frames its contents. The contents can be a directory of a disk or
folder, a desk accessory, or a document you create with an application. Most
windows can be moved, changed in size, scrolled, and closed. Windows can
also overlap each other.
You can have multiple windows on your desktop so you can view more than
one set of information at the same time. When more than one window is
open, all the action happens in the frontmost window. Clicking anywhere in
an inactive window brings it to the front and makes it active.
An active window always has a title bar and may also have

•
•
•
•

a size box
a zoom box
a close box
scroll bars

Although a window might be "buried" behind others, it cannot be dragged
completely off the desktop or made so small that you can't see it.
Windows might behave a little differently within an application. See each
application's manual for an explanation of how windows work in that
application.
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Windows
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Activating a window

1. Find an inactive window (one without horizontal lines in its
title bar).
2. Click anywhere in the window.
Activating a window brings it to the front, where it can overlap or
completely cover other windows. To see covered windows, move the active
window or resize it to make it smaller.

Moving a window

1. Position the pointer anywhere in the title bar of the window
except on the close box or zoom box (if either is showing).
2. Press and hold down the mouse button.
The window becomes the active window (if it's not already). To move a
window without activating it, hold down the Command key before
you press the mouse button.
3. Drag the window to a new location.
You can't drag a window completely off the desktop.
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Dragging a window

To cancel the move, move the pointer into the menu bar.
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Resizing a window

1.

Activate the window by clicking in it.

2.

To use the size box, move the window if necessary so that the
size box in the bottom-right corner is visible.

3.

Drag the size box.

Dragging horizontally changes the width, dragging vertically changes
the height, and dragging diagonally changes both.
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Using the size box

4.

Release the mouse button.

The new dimensions take effect only when you release the mouse
button.
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Zooming a window

1. To enlarge a window that's small, click the 1.00m box in the
top-right corner of the title bar.
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Using the zoom box to enlarge a window
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2. To shrink the window back to its original (smaller) size, click
the zoom box again.
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Using the zoom box to shrink a window

Some windows don't have a zoom box. However, if they have a size box, you
can still change the size to suit you.
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Closing a window

1.

Activate the window by clicking anywhere inside it.

2.

Choose Close from the File menu, or click the close box on the
left side of the title bar.
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Closing a window

Some windows don't have a close box. When that's the case, you can usually
close the window by clicking anywhere inside it. If an application doesn't
have a close box or a Close command, read that application's manual to find
out how to close its window.
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Scrolling a window

Scroll bars let you see more of what's in a window. When a scroll bar is gray,
it means that there is material not shown in the immediate window area.
(That is, the contents of a directory window or application window are
partly hidden from view outside the edges of the window.) A gray scroll bar
is active, and you can use it to bring material into the window where you can
see it.
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Figure 2-14

How scroll bars work
Most windows have both vertical scroll bars to let you scroll up and down
and horizontal scroll bars for scrolling from side to side. Scroll bars are not
always gray (active). One or both of the bars can be white. Awhite scroll bar
is inactive because scrolling would not show you anything you can't already
see in the window.
You can use the scroll bars in different ways, depending on how far you need
to scroll to find what you want to see.
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To scroll line by line

1.

Determine whether you want to see the area preceding (up
arrow) or following (down arrow) the part of the document
you're looking at now.

2.

Click the arrow that points in the direction of what you want to
see.

In a word processing (or spreadsheet) application, each click scrolls the
document one line. In a graphics application the document may not
have "lines," as such. In this case, each click scrolls the document one
unit of space equivalent to a line.
If you press the scroll arrow, you can scroll continuously.
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Scrolling line by line
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To scroll by the windowful

Note the position of the small white box in the gray scroll bar.

1.

If the scroll box is at the very top or bottom of the scroll bar, you can
scroll in only one direction. If the gray area shows above and below the
box, you can scroll in either direction.
Click in the gray area of the scroll bar.

2.

If you press in the gray area of the scroll bar, you can scroll continuously
by the windowful.
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Scrolling by the windowful
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To scroll quickly to any part
of a directory or document

1.

Determine what part of the directory or document you want to
see.
The vertical scroll bar represents the length of the directory or
document. (The horizontal scroll bar represents the width.)

Drag the scroll box to a place in the scroll bar that represents
that approximate position.

2.

For example, if you want to go to about the middle of a directory or
document, drag the scroll box to the middle of the vertical scroll bar.
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Scrolling quickly

Some applications show the document's page numbers in the vertical scroll
box.
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Editing text
Editing text involves the same basic operations whether you are renaming an
icon, reversing the order of two sentences, or revising an entire novel. In its
simplest form, editing involves selecting the text you want to work on and
making the necessary changes. For most editing, you use both the mouse
and the keyboard-and, of course, the Edit menu.
In the Finder, you can enter and edit
• the names of icons-disks, folders, applications, and documents
• text in desk accessories such as the Scrapbook and Note Pad
• text in the comment box of information windows (which you open by
choosing Get Info from the File menu)
See each application's manual for more on how to enter and edit text in that
application. Also see "Menu Command Shortcuts," near the end of Chapter 6.

Inserting text

1. Use the mouse to move the I-beam pointer to the place where
you want to insert text, and then click.
The blinking vertical insertion point appears where you clicked. (You can
.also use the arrow keys to move the insertion point.)
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Placing the insertion point

When there's no existing text (in certain dialog boxes, for example), the
insertion point may already be at the proper place.
You can control the rate at which the insertion point blinks (slow,
medium, or fast). To find out how, see "Using the General Control
Panel" in Chapter 5.
2.
70

Type to add text at the insertion point.
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Selecting text

1. Use the mouse to move the I-beam pointer to the beginning of
the text you want to scl.ect, and then press the mouse button.
2. Drag across the text (diagonally if there's more than one line)
to the end of the text you want to scl.ect.

3. Release the mouse button.
You can now edit the selected text using the commands in the Edit
menu.
You can also select a single word by double-clicking that word.
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Selecting text

Editing text

71

Moving text

To cut and paste

Moving text amounts to picking up a word here, or a sentence there, and
placing the text in a new position. The ease with which you can do this is one
of the great advantages of using a computer for word processing instead of
a pencil or a typewriter. The commands you use to move text are Cut, Copy,
and Paste. How you use them depends on what you want to do.
When you want to remove text from one location and paste it into a
different place, you use the Cut and Paste commands.

1. Select the text by dragging across it.
2.

Choose Cut from the Edit menu.
The text you selected disappears from the screen. It moves to the
Clipboard, where it is safely stored until you use the Cut command
again, use the Copy command, or tum off your Macintosh, erasing the
Clipboard's contents.
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Cutting and pasting text

3. Move the insertion point to the place where you want the text
to go.

4. Choose Paste from the Edit menu.
A copy of the text moves from the Clipboard and appears in its new
location. The text also remains on the Clipboard until it's replaced by
something else (or you tum off the computer). As long as the text is on
the Clipboard, you can continue pasting it into different places.
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Pasting text

To copy and paste

When you want to leave some text in its present location and move a copy
of it to a different location, you use the Copy and Paste commands. This is
handy when you have a special paragraph or warning that you want to
repeat in different memos, for example.

1.

Select the text by dragging across it.

2.

Choose Copy from the Edit menu.
The text you selected will not disappear from the screen. A copy of it
moves to the Clipboard, where it is safely stored until you use the Copy
command again or turn off your Macintosh.

3.

Move the insertion point to the place where you want the
copied text to go.

4. Choose Paste from the Edit menu.
A copy of the text moves from the Clipboard and appears in its new
location. The text also remains on the Clipboard until it's replaced by
something else (or you turn off the computer). As long as the text is on
the Clipboard, you can continue pasting it into different places.

•:• Scrapbook: The Scrapbook desk accessory can play a part in copying and
pasting text and graphics. To find out how, see Chapter 5, "Desk
Accessories."
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Replacing text

Removing text

1.

Select the text by dragging across it.

2.

Type what you want to replace the text with, or choose Paste
from the Edit menu to replace the text with what was last cut or
copied.

1.

Select the text by dragging across it.

2.

Press the Backspace (or Delete) key, or choose Cut or Clear
from the Edit menu.
If you really want to remove the text (rather than move it somewhere
else), the Backspace (or Delete) key is the fastest way to do it.

Using the Backspace (or Delete) key does not affect the contents of the
Clipboard.

TeachText and Read Me documents
TeachText is an uncomplicated application that lets you write, read, and edit
your own text documents. If you went through the tutorial in Chapter 1,
you opened TeachText and learned some basics about its use.

fl
-

.

Figure 2-22
Read Me document
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TeachText also provides a means for Apple Computer and other software
developers to make sure that the information you get about a new product
is as up-to-date as possible. When you see a Read Me document on your
screen, it contains last-minute information that couldn't be included in the
manual. (It's a lot quicker to create a document on a disk than it is to
produce an insert for a book!) You use TeachText to gain access to this Read
Me information.
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The TeachText application is on the Macintosh System Tools disk, along with
a Read Me document. There are two ways to get to TeachText documents
you want to read:
• Open the TeachText application (by selecting its icon and choosing Open
from the File menu, or by double-clicking on the TeachText icon). The
first window you see will be empty and will say Untitled in the title bar.
Close the window (by clicking the close box or by choosing Close from
the File menu). Then choose Open from the File menu, and a dialog box
will appear with the names of folders and documents (including the Read
Me document) you can read in TeachText. Select and open the document
you want to read. (You can also use TeachText to read text-only
documents you've created in your favorite word processor.)
• In the Finder, open the Read Me document by selecting its icon and
choosing Open from the File menu, or by double-clicking the icon. The
TeachText application will start automatically.
You can print any document that appears in the TeachText window, but you
will not be able to change any part of a Read Me document.
When you are using TeachText to write your own documents, you can use all
the nonnal editing functions of the program. You can cut or copy from
TeachText to the Clipboard, and you can paste what you put on the
Clipboard. However, you will not be able to open up the Clipboard to see
what's on it.
If you want to try using TeachText to write or edit something, see the
tutorial in Chapter 1.

TeachText and Read Me documents
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Working With the Finder Desktop

T
HO NEEDS THIS CHAPTER?

If you are not yet familiar with the features of the Finder desktop, this
chapter provides explanations of some important concepts and step-by-step
procedures to help you perform common desktop tasks.
Two other chapters in this book also describe the Finder. Chapter 4, "Finder
Menu Commands," provides a summary of all the commands available from
the Finder menu bar. Chapter 10, "MultiFinder," tells you how to use the
Finder in a multitasking environment.
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What's in this chapter?
This chapter summarizes how to use the Finder to manage what's on your
desktop-the documents, folders, applications, and disks, all represented by
icons. You'll learn how to open, copy, move, discard, rename, lock, or just
rearrange them.

The desktop and the Finder
The term desktop is a metaphor for the area you see on your screen when
you tum on your Macintosh-the menu bar at the top, a gray work area,
assorted icons representing folders, documents, and applications, and the
Trash. The desktop is your base of operations, the place where you can
organize what you want to keep, where you want to keep it, what you
want to work with, what you want to duplicate or rename, and what you
want to discard. The desktop is created and maintained by a system
application called the Finder.
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Chapter 3: Working With the Finder Desktop

You often see the name Finder in this and other Macintosh manuals. Yet
some people get confused and frustrated when they look at their desktop
and can't find something called Finder. In fact, you can see an icon
representing the Finder in your System Folder. You can't open the icon the
way you can open other applications, but the Finder is opened automatically
every time you turn on your Macintosh. It is what makes it possible for you
to click an icon, open an application, or drag a document to the Trash.

•:• Choosing different startup applications: If you want, you can elect to
have an application other than the Finder start first when you turn on the
Macintosh. For details see "The Special Menu" in Chapter 4 and "The Set
Startup Command" in Chapter 10.

What the Finder manages
Common Finder tasks include
• organizing documents, applications, and folders on the desktop, in
folders, and on disks
• opening, closing, copying, moving, renaming, and discarding documents,
folders, applications, and disks
• ejecting disks
• initializing and erasing disks
• write-protecting documents
• getting information about your documents, folders, and applications
with the Get Info command from the File menu
• turning off or restarting your computer
You work in the Finder by selecting and dragging icons, by double-clicking,
and by choosing commands from menus in the Finder menu bar. (For
additional information on using these menus, see Chapter 4.)
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Who controls the Finder?
You do. The Finder is with you everywhere on the desktop, and is also
present behind the scenes, keeping track of all your folders and documents
and coordinating activities between you and your disks. Just as other
applications let you create and manipulate words, pictures, or numbers, the
Finder is designed to let you manipulate your documents, folders, and disks.
The Finder does what you tell it to-sometimes on the desktop where you
can see what's going on, and other times invisibly, without interrupting your
work to inform you bf demand attention.

Working with icons
On the desktop, you have four types of icons: disks, documents, folders, and
applications. Working with these icons is a basic part of performing tasks on
your Macintosh.

Renaming an icon

Every icon has a name. Application icons are identified by the name of the
application. You name disks when you initialize them. You name documents
when you save them for the first time (some applications ask you to name a
document as soon as you create it). You usually name folders when you
create them. You can change an icon's name at any time, and the Finder will
keep track of the changes.
You can rename a document, folder, application, or disk whenever its icon is
visible in the Finder. (You may need to insert the disk that contains what
you want to rename, open the disk icon and any folders you need to, and
scroll until you see the icon.)
•!• F.xceptions: Some icons, such as the System and Finder files, cannot be
renamed. (Their names are important to system operation.) If you click

one of these icons, the pointer doesn't change into an I-beam.
Documents or applications that have been locked cannot be renamed.
(You use the Get Info command from the File menu to lock and unlock
these files. See "Locking a Document or Application," later in this chapter.)
A locked 3.5-inch disk cannot be renamed. (See "Protecting the Contents
of 3.5-Inch Disks" in Chapter 7.)
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When you rename a disk, write its name on the disk label. That way, if the
computer asks you to insert a specific disk, you'll be able to identify the one
it needs.
1. Select the icon you want to rename.
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Figure 3-2
Selecting a document icon to rename

2.

If necessary, click to place the insertion point where you want
it.
If you want to replace the name entirely, it's already selected. Skip to
step 3.

If you want to add to the name, position the I-beam pointer and click
to set the insertion point.
If you want to delete or replace part of the name, you must drag the

pointer to select the text, even when the icon is already selected.
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3. Type the new name.
The selected text (the old name) is replaced by the new text you type.
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Figure 3-3
Renaming a document icon

You cannot give the same name to two icons in the same folder or disk
directory. If you try, you'll see an alert message informing you that it
can't be done.
Use names that help you identify the contents (the more specific, the
better). Document and folder names can be up to 31 characters, and disk
names can be up to 27 characters. You can use any character on the
keyboard except the colon (:), but you should not start a name with a
period. You can use uppercase or lowercase letters and put spaces
between words.

4. If necessary, use the Edit menu to edit the text.
See "Editing Text" in Chapter 2.

Another way to rename documents
When you are working on a document within an application, you can usually
use the Save As command to create a copy of the document with a new
name before saving it. See "Using the Save As Command," later in this
chapter.
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Duplicating documents,
folders, or applicadons

If you can see the icon of a document, folder, or application, you can use the
Finder to copy it. You might do this to make a backup copy. (See also
"Making Copies of 3.5-Inch Disks" in Chapter 7.) Or you might want to make
a copy of a document to work on without altering the original. For example,
you might do this to create forms, letterheads, or templates.

L Select the icon that represents the document, folder, or
application you want to copy.
If necessary, insert the disk or disks that contain what you want to
copy, open the disk icon and any folders you need to, and scroll until you
see the icon. See "Shift-Clicking" or "Selecting Grouped Icons by
Dragging" in Chapter 2 for help in selecting more than one icon to
duplicate.
2. Choose Duplicate from the File menu.

Anew icon appears. The duplicate icon has the same name as the
original, preceded by the words Copy of. You can drag the duplicate copy
to any folder or disk icon (or a directory window).

3. Rename the duplicate.
You can rename any duplicate copy of a document or folder by typing
immediately after you create the copy. Any other time, you must click
the icon that represents what you're renaming before you type the new
name. See "Renaming an Icon" earlier in this chapter.
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Figure 3-4
Copying an icon
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Moving a document, folder,
or application to a new place
on the same disk

1. Position the pointer on the icon you want to move.
2. Drag the icon to wherever you want to put it.
At its most basic, dragging an icon from one place to another moves that
icon to the new place. However, there are some variations in the results you
achieve:
• If you drag the icon for a document, folder, or application to any place
(except the Trash) on the same disk, you move the icon to the new place.
• If you drag the icon for a document, folder, or application to the Trash,
you remove the document, the folder and its contents, or the application.
(In the case of an application, you'll see an alert message asking you to
confirm the fact that you want to discard it. If the document or
application is locked, you will see an alert message telling you that the
item cannot be removed. For more information, see "Locking a Document
or Application" and "Using the Trash," later in this chapter.)

Copying a document, folder,
or application to a different
disk

You can copy a document, folder, or application from one disk to another
whenever both disk icons are present on the desktop. The disk that contains
the icon you want to copy is called the source disk. The disk where you want
the copy to go is called the destination disk.
1.

If necessary, insert the destination disk (so its icon will be

present on the desktop).
You must be able to see either the icon or the directory window for the
icon.

2. If necessary, insert the source disk that contains what you want
to copy.
If you're using a one-drive system, use the Eject command in the File
menu to eject the destination disk before you insert the source disk.
(The Eject command leaves a dimmed icon behind on the desktop.)
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3. Open the source disk icon and any folders you need to, and scroll
until you see the icon that represents what you want to copy.
The source disk must be opened into a directory window so you can
select the document, folder, or application you want to copy; the
destination disk can be either in icon form or opened into a directory
window.
See "Shift-Clicking" or "Selecting Grouped Icons by Dragging" in
Chapter 2 for help in selecting more than one icon to copy.

s
n

f le

Edit

Special
HD20

[~ j
J

Llie111

l:J ... r

'

[ J
It

Dlt"Q<t

=----1

D

T

Fr •rr1 :•.,.n.,.

LJ

T EC H>:1Jl

D

Al ph. :th(•n.

~

r,

in L•:ir·

o

<ir'J n

F·lec

LJ

fl:td 1rT

Ne

LJ

Pr· 1"'' ts

LJ

T:imjr::.

IB

l'lrt

F;,rif 'VA t 1• ·.'>:-r

T(• F':iul::.

T.,..:.ii:,hT-:- t

Figure 3-5
Copying to a different disk

4. Drag what you want to copy to its destination.
You can drag it to a disk or folder directory window, or to an icon (even
a dimmed icon) that represents the disk or folder you want the item to
be in.
If you drag to an open directory window, you can place the icon
wherever you want. If you drag to an icon, the Finder places the item in
the next available spot.
If you're using a one-drive system, the computer will present a series of
dialog boxes, asking you to insert alternately the source disk and the
destination disk.
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5. If necessary, confirm that you want to replace an item with the
same name already on the destination disk.
If the destination disk already contains an item with the same name,
you'll be asked to confirm that you want to replace the current
contents with what you're copying. If you click OK, you'll replace what
was there. (By the way, if the item is a folder, you will replace the
original folder and all of its contents with the one you dragged from the
source disk.)
The copy appears in the directory window you dragged to. (If you
dragged to a disk or folder icon, the copy will appear in the directory
window when you open the icon.)

6. If you don't want to keep the original on the source disk, drag
the original to the Trash.
Whenever you drag from one disk to another, a copy of what you move
is left behind for safekeeping. If you want to reclaim the space on the
original disk, you can drag the original icon to the Trash and choose
Empty Trash from the Special menu.
To make a copy of a document while using an application, see "Working With
Documents and Applications " later in this chapter.

Getting information about icons
When you want to know the version number of an application, the size of a
document, or the date an item was created, use the Get Info command from
the File menu. You can also use the Get Info command when you need to
lock a document or application (to prevent it from being renamed or thrown
away).

•:• MultiFinder and the information window: With MultiFinder turned on,
the Get Info command serves an additional purpose. You can use the
information window that appears to change the amount of memory set
aside for an application to use. This kind of change is not trivial, and you
should be familiar with its implications. For details, see "Some Technical
Points About Memory" in Chapter 10.
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Using the Get Info
command

1.

Select the icon of the document or application for which you
want the information.

You can select a group of icons. The Get Info command will act for all
of the selected icons.
Choose Get Info from the File menu.

2.

An information window like this one appears for each icon you selected

in step 1. (If you selected several icons, only one of the Get Info
windows will be active. You can move, activate, and close these
windows just as you do any windows on the desktop.)
~
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Figure 3-6
An information window

If you are looking at an information window for an application and have
MultiFinder turned on, you will see additional information below the text
box. For an explanation, see Chapter 10, "MultiFinder."
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Locking a document
or application

Locking a document or application prevents it from being renamed or
thrown away. Locking a document al.so prevents saving any changes to it.
You can, however, open and print locked documents.
See "Locking a 3.5-Inch Disk" in Chapter 7 to learn how to lock disks
physically.

1. Select the icon for the docwJ:ient or application ypu want to
lock.
Choose Get Info from the File menu.

2.

The information window appears.
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Figure 3-7
Locking a document

3. Click Locked.
The Locked box is checked.
Directories in text views indicate which of your documents a.pd
applications are locked by displaying a small padlock (to the right of the
document's name).
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Unlocking a qocument
or application

1.

Select the icon for the document or application you want to
unlock.

2.

Choose Get Info from the File menu.
The information window appears.

3.

Click the checked Locked box.
The document or application is now unlocked.

Working with folders, directories,
and the hierarchical file system
When you work with your Macintosh to write memos, create spreadsheets,
and design graphic presentations, you are using applications and creating and
saving documents. As you continue to work, the number of documents (and
probably the number of applications) you have will grow. Sooner or later
you'll have to arrange these items in logical groups-or run out of space on
the desktop.

Folders
How you organize your work on the desktop is up to you, but the basic tool
the Macintosh provides is the familiar file folder. You can create folders,
name them to suit your needs, and even nest folders inside other folders to
create as many as 12 levels.
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Macintosh folders

With folders, you can create a hierarchy of files, applications, and documents
so you can arrange your work however you want and find what you need
quickly.
Working with folders, directories, and the hierarchical file system
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Directories
One really useful feature of folders on the Macintosh is the way that the
Finder helps you keep track of what's in them-using directories. The
Finder creates a directory automatically for each folder you produce, and
instantly updates the directory with every change you make to any folder's
contents.
No matter how many folders you have, each one has its own directory. You
can see the contents of any folder by opening its icon into a directory
window (just as you can with a disk icon).
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Open folder showing its directory window

Like a telephone book, a directory window contains information about the
items located in its folder. But a Macintosh directory window offers added
flexibility that you won't find in your phone book: you can choose to change
your view of each folder's contents to focus on what you want to know.
It's as if your phone book offered the option of listing people in your
community by address or by the date their phone was installed.
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You can see the contents of a folder listed
• by icon Oarge or small)
• by name (in alphabetical order)
• by the date each item was last modified (most recent first)
• by the size of each item (largest first)
• by the type of item (documents first, applications second, and folders
third, with each group in alphabetical order)
• by color (available only on a Macintosh II with a color monitor)
Choosing a different view from the View menu instantly rearranges the
active directory window in the view you choose. For example, you can
quickly see which document is taking up the most space or which is the
latest version of a report you're preparing.
No matter how you choose to view a specific directory, you can still perform
all the usual tasks. Every item in a directory is represented by an icon, no
matter what arrangement you have the directory in. In any of the text views
(by name, date, size, or type) the icon is very small and appears to the left of
its name. You can click, double-click, drag, or Shift-dick this icon just as you
would its counterpart in an icon view of the directory.
The view you choose for the contents of one window has no effect on
other windows.
For more information, see "The View Menu" in Chapter 4.

The hierarchical file system
Folders let you arrange your applications and documents in a hierarchy. When
you open a disk and see a folder (or file) in the disk's directory window,
you're looking at the top level of the hierarchy. When you open that folder,
you see another window that shows you what's inside-probably more files
and folders. Now you're looking at the second level of the hierarchy. If when
you open one of the folders on this second level you see yet another folder,
that folder will open onto the third level-and so on.
You can nest files (that is, place files and folders within other folders within
other folders, and so on) until you have about 12 levels. Most people,
however, find that retrieving a file nested more than four levels deep
becomes tedious.

Working with folders, directories, and the hierarchical file system
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Hierarchical file structure

Luckily, you don't have to worry about misplacing a file, even a deeply nested
one. If you know its name, you can fmd any file or folder by using the Find
File desk accessory. See the Macintosh Utilities User's Guide for information
on installing and using Find File.

Creating a new folder

L Choose New Folde:t from the File menu.
Afolder named Empty Folder appears in the active window.
2. Type an appropriate name for the folde:t you just created.
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Moving a document,
folder, or application
from one folder to another

1. Drag the item you want to move from the folder it's in to the
folder icon (or window) you want to move it to.
If the destination folder is on a different disk, the item is copied, rather
than moved, to the new folder.

llDlO

Figure 3-11

Moving a document between folders
2.

If the destination folder already contains an item with the same
name, an alert box will appear, asking you whether you want to
replace the existing item.
If you want to replace the item in the destination folder, click OK.

You can keep documents (or folders) with the same name on the same
disk, as long as they're in different folders.
•!• Caution: If the items with the same name are folders, clicking OK

replaces the existing folder-and its contents-with the folder you
dragged to this destination. This happens whether or not the folders'
contents include duplicate names.
If you don't want to replace the item with the same name, click
Cancel. Rename one of the "twin" items. Then you can safely drag
the item to the destination folder.

Working with folders, directories, and the hierarchical file system

93

Working with documents and applications
Documents are the products of the work you do with your Macintosh.
Every memo you type or spreadsheet you create becomes a document as
soon as you save it, and its icon identifies it in the Finder.
Usually, creating a document is something you do with an application. This
manual does not attempt to tell you how that application works or how to
use it, but there are some general procedures that apply for all documents
and applications.
You can do quite a lot of document management without leaving the
application you're using. You can create documents, open them, close them,
save them, print them, and-in some applications-delete them. And you can
organize your work using the same folders you create in the Finder.

Creating a document
by opening an application

When you open most applications, the first window you see is named
Untitled. This window is effectively a blank slate where you can create
whatever you want, and as soon as you save it, it becomes a document.
1.

Select the icon for the application you want to use.

If necessary, insert the disk that contains that application, open the disk

icon and any folders you need to, and scroll until you see the application
icon.

2. Choose Open from the File menu.
You can also double-click the icon to open the application.
The appropriate application starts. Usually a new, untitled document
appears.

3. Enter text, graphics, statistics, and so on (depending on the
nature of the application).

4. Save the document and give it a name.
You've created a document.
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Creating a document
with the New command
in an application

These instructions assume you've already opened an application and have
been working on a document. Now you want to close that document and
start a new one.

L Choose Oose from the File menu to close the current document.
If there are any unsaved changes, the application will alert you and offer

the option of saving the changes before closing the document.
With some applications, you can have several documents open at a time.
In other words, it isn't always necessary to close one document before
you can open another.
2. Choose New from the application's File menu.

Figure 3-12
Creating a new document

A new document appears. In most applications, you name the
document the first time you save it; in a few applications, you must
name the document as soon as you create it.
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Opening an existing

document from the Finder

You can open an existing document by selecting and opening the icon that
represents the document you want to work on. The application you'll use
with that document starts automatically.
·

1. Select the icon that represents the document you want to work
on.
If necessary, insert the disk or disks that contain that document and
the application you used to create it, open the disk icon and any folders
you need to, and scroll until you can see the document icon.

Choose Open from the File menu.

2.

You can also double-click the icon to open it.
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Directory dialog boxes
The hierarchical file system can be especially helpful when you're working
within an application. Whenever you choose Open or Save As from the File
menu within an application, or save a document for the first time using the
Save command, you see the same hierarchy of folders you created in the
Finder (as long as the disk is initialized appropriately-explained in "Preparing
3.5-Inch Disks for Use" in Chapter 7).
A dialog box appears containing a directory of the current folder or disk. The
directory title (and a folder or disk icon) is above the alphabetized list of the
directory's contents; the name of the current disk (and a disk icon) appears
to the right.

l.
Figure 3-14

Directory dialog box
The folders in this dialog box correspond to the ones you create in the Finder,
with one notable difference: these folders show only the documents the
current application can open, even when the corresponding folders in the
Finder contain other documents or applications.
You open these folders in the same way you open folders in the Finder-by
selecting them and clicking the Open button, or by double-clicking them.
You can also use the scroll bar (or drag the mouse) to move up and down the
list of names until you find what you want to select and open.
You can move through the entire hierarchy of folders in this way, opening
folders within the currently open folder, until you reach the document you
want to open.

Working with documents and applications
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•:• A shortcut when you know what you want: If you know the name of a
document or folder in the current directory and want to select it quickly,
type the character or characters you want to find. As you type each
character, the system highlights any documents or folders that "qualify."
For example, as you type M, the selection bar moves to the first name
beginning with M in the list. As soon as you type a second letter, the
system will find the first name that begins with both letters, and so on.
However, if you are hesitant and pause too long while typing, the next
character you type is considered a new request rather than a continuation
of the old. (The Delay Until Repeat setting in the Keyboard Control Panel
controls how long the pause can be before subsequent typing begins a
new request.)
When you choose Open or Save As, the first directory you see is for the folder
(or disk, if you're at the top level) that you last opened a document from or
saved a document to. You can move up or down the hierarchy to open or
save documents.

Opening an existing
document from within
an application

These instructions assume you have already opened the application, and
you're looking at a window containing a document (either an untitled
document or one you created earlier). What you want to do now is open
another document created with the same application.
1.

Choose Close from the File menu to close the current document.
If there are any unsaved changes, the application will alert you and offer
the option of saving the changes before closing the document.

With some applications, you can have several documents open at a time.
In other words, it isn't always necessary to close one document before
you can open another.
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2. Choose Open from the application's File menu.
A dialog box appears, containing a directory of the current folder or disk.
The directory title (and a folder or disk icon) is above the alphabetized
list of the directory's contents. The name of the current disk (and a disk
icon) appears to the right.

Directory title - - - - - - - - - - - - - - List of the directory's contents
Current disk
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Figure 3-15
Directory dialog box for opening a document

The folders in this dialog box correspond to the folders you create in the
Finder.
Within applications, folders show only those documents the current
application can open, even if the corresponding folders in the Finder
contain other documents or applications.

3. To see the contents of a folder in the current directory, select
its name and click Open, or just double-click its name.
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Figure 3-16
Opening a folder in the directory dialog box
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You can move through the entire hierarchy of folders in this way,
opening folders within the currently open folder, until you reach the
document you want to open.

4. To trace your way back through the hierarchy of folders, press
on the directory title and choose the folder you want
Alist appears below the directory title when you press on the title or
anywhere in the bar that contains the title. Each folder in the hierarchy is
in the list, and the disk directory is at the end of the list. (By the way,
the disk directory shows you any items on the desktop as well as items
in the disk's directory window.)

5, To close the currently opened folder and drop back to the
preceding level in the directory, click the disk icon that appears
above the Eject and Drive buttons.
You can repeat this process until you get to the top of the hierarchy.

6. To see documents and folders on other disks, use the Drive and
Eject buttons.
Each time you click Drive (or press the Tab key), the Macintosh goes to
the next disk in a disk drive, cycling through any that are available.
7. To open the document you want to work on, click its name and
then click Open (or double-click its name).
To select a document or folder in the current directory quickly, type the
character or characters you want to find and to select. If you pause
while typing, the next character you type is considered a new request
rather than a continuation of the old.
You can also use the arrow keys to move up and down the list of
names.
You always enter the hierarchy of documents and folders at the place
where you last opened or saved a document.
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Using the Save command

A document is stored in the computer's memory only temporarily until you
save it on a disk.
1.

Choose Save from the application's File menu.
Use the Save rather than the Save As command for routine, periodic
saving of your document. The Save command saves a document with
the original name you gave it and puts it exactly where it came from
when you opened it. (When you want to save the current document
with a different name, or copy it to a different folder or disk, choose the
Save As command.)

2.

If this is a new document that's never been saved before, type a
name for it in the directory dialog box.
You see a directory dialog box like the one that comes up when you
choose the Open command. But this one has a place for you to type
names for the documents you save. (In fact, it's similar to the dialog
box you get when you choose the Save As command. )
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Figure 3-17
Directory dialog box for the Save command

Using the Save As command

Use the Save As command when you want to save a document with a
different name, in a different folder, or on a different disk.
1.

Choose Save As from the application's File menu.
A dialog box appears, containing a directory of the folders contained in
the current folder or disk. You see the directory name (and a folder or
disk icon) above the alphabetized list of the folders it contains; the name
of the current disk (and a disk icon) appears to the right. The folder
names in this dialog box correspond to the folders you create in the
Finder.
Working with documents and applications
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• To see folders or documents inside a folder in the directory, select the
folder and click Open (or double-click the folder's name). You see any
folders within the folder you opened.
You can move through successively deeper levels of the hierarchy this
way. Open folders within the currently open folder until you open the one
in which you want to save your document.
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Figure 3-18

Save As directory dialog box
When you're saving (rather than opening) documents, you see the entire
contents of the folders you open. Except for folders, the names of items
appear dimmed. (But the names are readable, allowing you to determine
whether there is an existing document with the same name as the
document you're saving.)
• To move back through the hierarchy of folders, press on the directory
title (or anywhere in the bar that contains it). The list that appears shows
the names of all the folders you moved through in the hierarchy. At the
end of the list is the "top" level-the directory for the disk you're
working with. (By the way, the disk directory shows you any items on
the desktop as well as items in the disk's directory window.) Simply drag
to the name you want, and release the mouse button.
• To close the currently opened folder and drop back to the preceding level
in the directory, click the name of the current disk.
• To cycle through any other disks available in other disk drives, click the
Drive button (or press the Tab key). If the Drive button is dimmed, there
are no disks in other disk drives.
• To exchange a 3.5-inch disk for one that's already inserted, click Drive until
you see the name of the disk you want to eject. Then click the Eject
button. The disk will be ejected, and you can insert another disk.
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2.

Type a new name for the document if it's a new document or if
you want to change the current name; otherwise, it will be saved

with the same name.
You can use any character or symbol on the keyboard except a colon(:),
and you shouldn't use a period as the first character. You can use
uppercase or lowercase letters and put spaces between words. Names
can be any length up to 31 characters, but long names can become
unwieldy. It's usually best to limit them to the space you have to type
them in.
Even though more than one document on a disk can have the same
name as long as they're in separate folders, it may be easier to keep track
of documents if you give each version a different name.

3. To save the current document in the folder named at the top of
the list, click Save.
You always enter the hierarchy of documents and folders at the place
you where you last opened or saved a document.
•!• Two items with the same name? When you click Save, if there's

another item with the same name in the same directory, you'll be
asked whether you want to replace the existing one. Clicking Yes
means the earlier version will be replaced by the one you are saving.

Where does your information go?
When you open an existing document so you can revise it (the perfect first
draft has yet to be created), the computer leaves the original on the disk and
brings a copy into the computer's memory. When you've finished making
changes on the copy, you decide whether you want to keep the new version
or not.
You usually have the option of saving the new version with the original
name, saving it with a different name, or not saving it at all. If you save the
new version with the same name as the original, it replaces the original on the
disk. If you don't use the same name, with most applications the original on
the disk isn't changed. It's like having an original document and making
photocopies of it to edit. When you've tried different changes and are
satisfied with a particular version, you can change the original.

Working with documents and applications
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Save often
Any document you're working on is being held temporarily in the computer's
memory. If you accidentally trip over the power cord or the electricity goes
off, everything you've done-but haven't saved-vanishes forever. To
ensure that your work will be there when you need it, save it on a disk by
choosing Save from the File menu every 15 minutes or so. That way you'll
never lose more than a coffee break's worth of work. (With certain database
programs you can lose everything-even what you've saved-if there's a
power failure of any sort. If the work you're doing in a database application
is important, it's a good idea to make frequent backup copies of your work
on 3.5-inch disks for insurance.)
If you have a hard disk, you should regularly back up the information on it.
See the Macintosh Utilities User's Guide for instructions on using HD Backup
to help back up a hard disk.

•:• Automatic saves: Some applications save changes you make to a
document as soon as you make them; the manual that comes with the
application lets you know if this is the case.
Copy you're working on

Original on disk
Original on disk
Copy replaces
original on disk

Figure 3·19

Where information goes
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Printing
From the Finder desktop, you can print a document, a group of documents
(if they were created with the same application), the contents of the entire
screen, or a disk or folder directory. (With an ImageWriter® II printer you can
also print the contents of the active window.) You can print a document
whenever you can see its icon and a disk that contains its application is
currently inserted. When you print from the Finder, the document's
application is opened automatically.
If you're using an ImageWriter II, make sure that the printer is ready, the
select light is on, and the paper is at the top of a form.
If you're using a printer other than the ImageWriter II, if you have more
than one printer, or if your printer is attached somewhere other than the
printer port, use the Chooser desk accessory to tell the computer which
printer to use. See "The Chooser" in Chapter 5.

•:• MultiFinder and background printing: The infonnation in this chapter is
true for printing whether you are working in the MultiFinder
environment or the single Finder environment. However, with a
LaserWriter® printer and MultiFinder, you can take advantage of the
background printing feature. (With this feature, you don't have to wait
for a document to finish printing before you can use the Macintosh
again.)
To find out how to use background printing, see Chapter 10,
"MultiFinder. "

Choosing a printer

1.

Choose the Chooser desk accessory from the Apple menu.

2.

In the Chooser window, select the type of printer you want.

3. In the Select box, select the name of the printer you want to
print to.
For more infonnation, see "The Chooser" in Chapter 5.

Printing
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Using Page Setup
with LaserWriter printers

The Page Setup command lets you define a number of printing features, such
as the size of the paper you print on and the orientation of your document
on the printed page. Because the most commonly used options are preset,
you are not required to use this command every time you print. However,
it's useful to know what's available-in case you want to do something
special with a document you're printing. Many of these features are explained
in your LaserWriter manual, but some features are so new they were not
included in the printer manual. The newest features are explained here.

1. Choose Page Setup from the File menu.
You see this dialog box:

r Help '

Figure 3-20

LaserWriter Page Setup dialog box
Faster Bitmap Printing preprocesses your bitmaps (such as MacPaint or
Kanji-text bitmaps). Generally, this results in faster printing. In rare
cases, however, some documents may not print with this option turned
on. You may receive an error message that concludes with something
like, "...document is OK but cannot be printed." If this happens, tum
off Faster Bitmap Printing and try again.
•!• For expert users: Some of these printing enhancements may be

meaningful only to expert users. For example, to understand the
advantages of Precision Bitmap Alignment, you should be familiar
with terms such as bitmap and object-oriented graphics. If you want
to see what difference a particular Page Setup setting makes, tum it
on and select an unimportant document to print.
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2.

To see additional features, click Options.
la~erWriter Option~

This picture changes to reflect
the options you select
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O lnuert Image
O Precision Bitmap Alignment 14% reduction)
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Figure 3-21
LaserWriter Options dialog box

• The first two options, Flip Horizontal and Flip Vertical, change the image
of your page along a horizontal or vertical axis.
• Invert Image prints a negative image of your document. What was white
is black, and vice versa.
• Precision Bitmap Alignment prints your bitmap images at precisely four
times the resolution of the Macintosh screen. (Bitmap images are created
in applications such as MacPaint.) The resulting printed image is 4%
smaller than normal. Consequently, the other elements of your page,
object-oriented graphics and text, are also reduced by 4%. This option is
useful for avoiding minor distortion of bitmaps. For example, if you paste
a picture from MacPaint into MacDraw, your picture could be slightly
distorted unless you use this option.
• Larger Print Area lets you print on more of the total page area-if your
application will allow it. However, when you select this option, you'll be
using some memory in the LaserWriter that can hold downloadable fonts.
If you tum on this option and can't download all the fonts you need,
tum off Larger Print Area to make room for the fonts.
All five of these options are portrayed graphically in the picture are.ii on the
left side of the dialog box. As you select an option, you can see its effect on
the example. The default setting for each of these options is off (not
selected).
For a brief reminder of how to use these options, you can click the Help
button in the Page Setup dialog box.
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Printing a document
from within the Finder

1. Select the icon that represents the document you want to print.
If necessary, insert the disk or disks that contain the document and the
application you used to create it, open the disk icon and any folders you
need to, and scroll until you see the document icon.
•!• Page Setup: When you are printing documents from the Finder, the
printer uses the last Page Setup chosen for that document. If you

want to change the settings at this point, see "Printing a Document
From Within an Application," later in this chapter.
2.

Choose Print from the File menu.
One or more dialog boxes might appear, with options for printing your
document.
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Figure 3-22
Print dialog box

Printing a group of
documents from
within the Finder

1. Select the document icons.
To select more than one document to print, hold down the Shift key as
you click the icons.
If necessary, insert the disk or disks that contain those documents and

the application you used to create them, open the disk icons and any
folders you need to, and scroll until you see the document icons.
2.

Choose Print from the File menu.
The selected documents will be printed.
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Figure 3-23
Documents selected for printing

Printing a document from
within an application

To print a document from within an application, the application must
be open and the document must appear in an active window.

1. Choose Page Setup to set printing options such as page
orientation and paper size.
If you tend to use the same setup all the time, you can skip this step.
2.

Choose Print from the File menu.
In most applications, one or more dialog boxes appear. You can click the
various options to control the way your printed document will look. If
you're using a printer other than an ImageWriter II, if you have more
than one printer, or if your printer is attached somewhere other than the
printer port, use the Chooser desk accessory to tell the computer which
printer to use. Some applications may not let you use the Chooser;
choose Quit and use the Chooser in the Finder. See "The Chooser" in
Chapters.

Printing the directory
of a disk or folder

1. In the Finder, select the disk or folder icon whose directory you
want to print, or make the directory window active.
2.

Choose Page Setup from the File menu to set paper size,
printing orientation, and other options.
Printing
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3. Choose Print Directory from the File menu.
Adialog box will appear.

4. Select printing options from the choices that appear in the
dialog box, and click OK or press Return.
The printing options will vary depending on the application on the disk
or in the folder.
The directory is printed in whatever view you have it arranged.
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Printouts of different views of one directory
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Using the Trash
When you need to free up space on a disk, or have grown tired of clutter or
confused by redundant copies of memos that are now irrelevant, the Trash is
a receptacle for items you want to throw away. You can throw away a
document, folder, or application whenever you can see its icon. The Trash can
be visible as an icon or opened into a directory window.
When you put an item in the Trash, the Trash icon "bulges" to let you know
there's something in it. If you want to empty it-and reclaim the space the
discarded files take up-choose Empty Trash from the Special menu.
In fact, whether you empty it or not, files won't stay in the Trash
indefinitely. However, you can usually recover what you've thrown away
unless one of these events occurs:
• You choose Empty Trash, Restart, or Shut Down from the Special menu.
• You copy, duplicate, or rename other items.
• You start an application.
• You eject a disk by dragging it to the Trash.
If you open the Trash and can see the icon for a document, folder, or

application in the Trash window, you can recover it.
Another common use for the Trash is to eject disks. Dragging a disk to the
Trash ejects the disk and removes its icon from the desktop; it has no effect
on the contents of the disk. (If the disk is the current startup disk, dragging
its icon to the Trash ejects it but leaves the dimmed icon on the desktop.)
See Chapter 7, "3.5-Inch Disks," for details on ejecting disks.

Using the Trash
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Removing a document,
folder, or application

1. Open the window that contains what you want to remove, and
scroll until you see the icon or icons.
2.

Drag the icon or icons that represent what you want to remove
to the Trash icon or window.
To select more than one icon, hold down the Shift key as you click the
icons. Discard the contents of an entire disk by choosing Select All from
the Edit menu and then dragging any item to the Trash; the rest will
follow.
When you discard a folder, the folder and all its contents disappear.
To reclaim the space immediately, choose Empty Trash from the Special
menu. (But be aware that you won't be able to recover anything once
you've emptied the Trash.)

Figure 3-25

Dragging to the Trash

Recovering an item
from the Trash

You can't throw away anything on a locked disk or any documents that
have been individually locked; you must unlock the disk or document first.
(For instructions on unlocking a disk, see Chapter 7, "3.5-Inch Disks." For
instructions on unlocking documents, see "Unlocking a Document or
Application," earlier in this chapter.)
You can recover an item as long as you can see its icon in the Trash window.

1. Open the Trash window and scroll until you can see the icon that
represents what you want to recover.
2. Drag the icon out of the Trash window onto the desktop or into
another window.
To select more than one icon to recover, hold down the Shift key as you
click the icons.
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If you can't remember where items in the Trash came from, you can
select what you want to recover and choose Put Away from the File
menu. This puts the items back where they came from originally.
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Figure 3-26

Recovering an item from the Trash
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Finder Menu Commands

HO NEEDS THIS CHAPTER?

If you want a quick reminder of what happens when you choose any of the

commands from the Finder menus, this chapter has the information.
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What's in this chapter?
The Finder's menus allow you to do all your desktop-related tasks. The
menus are presented in the order in which they appear on the Finder menu
bar, reading from left to right:
• Applemenu
• Filemenu
• Edit menu
• View menu
• Special menu
• Color menu (available on a Macintosh II with a color monitor)

This chapter provides a brief explanation of each menu command. You'll find
detailed descriptions of the commands in other chapters of this manual-in
connection with tasks you perform on your Macintosh.

About the Finder. ..

The Apple menu

Alarm Clock
( alculator
Chooser
Control Panel
Key Caps
Scrapbook

The Apple menu gives you access to the About the Finder window and any
desk accessories installed on your Macintosh. (In addition, with MultiFinder
on, you can use the Apple menu to move among open applications. For
details, see Chapter 10, "MultiFinder. ")

Figure 4-1

Apple menu

About the Finder
This item shows the version number (and the authors) of the Finder and
System files on your startup disk. You can also see the total memory (RAM)
in your Macintosh and, in the lower half of the window, a memory graph.
The graph in Figure 4-2 shows how much memory has been set aside for the
operating system and the Finder.
The memory graph is especially important when you tum on MultiFinder.
Then it shows how much memory has been allocated to any applications
you have opened (in addition to the memory for the System and Finder).
With MultiFinder, this graph is an important aid in helping you manage
available memory on your Macintosh. (For details, see Chapter 10,
"MultiFinder. ")
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Figure 4-2
About the Finder window

Desk accessories
Choosing a desk accessory makes that accessory appear on the desktop. You
can use the Edit menu to cut, copy, and paste the information in many desk
accessories.
The desk accessories are explained more fully in Chapter 5.

~
New Folder

*N

The File menu

J€W

The commands in the File menu operate on icons and windows.
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• New Folder. New Folder creates an empty folder that can hold

Open
Print
(IO\e

.:ii;o

Get Info
Ouplitate
Put Away

Page Setup ...
Print Directory ...

Eject

documents, applications, or other folders. New folders appear in the
active window on the desktop (as opposed to on the desktop itself), and
you can type a name immediately after creating an empty folder. If no
directory windows are open, the New Folder command is dimmed.

:ltE

Figure 4-3
File menu

The File menu
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• Open. The Open command opens the selected icon into a window. If the
icon represents a document, opening it also starts the application used to
create that document, and loads the document so you can work on it. If
the icon represents an application, opening it usually gives you a new,
untitled document.

For you to open a document, the application that created it must be on a
currently inserted disk. Sometimes the application and document must be
in the same folder.
If you select a document and an application, the Finder attempts to use
that application with the document. For example, selecting MacWrite (a
word processing program) along with a text-only document you created
with MacTerminal® (a telecommunications program) opens MacWrite to
work on the text-only document.
If you select several document icons and choose Open, the Finder tries to
open the first icon's application to work on all the selected documents.

• Print (from the Finder). Most of the time you'll print a document
while you're actually working in the application that created it. However,
you can also use the Print command from the Finder desktop.
The Print command prints the documents represented by the selected
icon or icons (assuming, of course, your printer is hooked up correctly). If
you select a group of icons, as long as all of them were created with the
same application, they'll all be printed.
•!• With MultiFinder turned on: If you are working in the MultiFinder

environment, it is possible to select documents for printing that were
created with different applications. However, since MultiFinder will
attempt to open all the relevant applications before beginning to print,
the Macintosh may run out of memory.
To print a document, you must have the application that created it on a
disk whose icon appears on the desktop. Document printing from the
Finder follows the rules and printing procedures of that document's
application.
With most applications when you choose Print, a dialog box appears.
Select the options you want, and click OK or press Return. See each
application's manual for more information on how to print with that
application. See each printer's manual for information about using that
printer.
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• Close. Like the close box, the Close command closes the active window,
zooming it back down to its icon. The icon remains selected. (If the active
window is a desk accessory, it just disappears.) The next frontmost
window, if there is one, becomes the active window.
Chapter 4: Finder Menu Commands

• Get Info. Get Info opens a window that displays infonnation about
whatever the selected icon represents. The displayed infonnation includes
o the kind of item (document, folder, or application)
o if it's a document, which application created it
o its size

o which disk and drive it belongs to
o the date it was created

o the date it was last changed
o the version number of an application (if available)

o a comment box where you can make notes about the icon

o the Suggested Memory Size (for use with MultiFinder)
o the Application Memory Size (also for use with MultiFinder)

You can add text by typing in the comment box and editing it as you edit
any text.
The Locked check box lets you lock a document or application (but not a
folder). When the Locked box is checked, that document or application
can't be thrown away and its name can't be changed. You can't save any
changes to a locked document.
You can still drag or open a selected icon while its information window is
open.

• Duplicate. The Duplicate command duplicates the selected items on the
same disk. The duplicates are named Copy of, followed by the name of the
original.
Duplicating a folder duplicates the folder and all its contents. If you had
previously moved a document, folder, or application from the folder to
the desktop or a different window, that item will not be duplicated. (The
system will assume that you meant not to include the item.)
•

Put Away.

Put Away returns any selected documents, folders, or
applications on the desktop or in the Trash window back to the folders
and disks they belong to. This command is dimmed when no icons are
selected on the desktop or in the Trash window.

• Page Setup. Page Setup lets you set up the page size, orientation, and

other options for directories that you print using the Print Directory
command. The Page Setup command doesn't work with documents that
you print from the Finder; each document's page setup is controlled by
the Page Setup command within the application that created it.
The File menu
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• Print Directory. Print Directory prints the actual contents of the active
directory window, in whatever view you have the directory arranged. (See
"The View Menu" later in this chapter.) What you see gets printed-icons,
document names, and so on-as opposed to the contents of documents.
•

The Eject command ejects the selected disk or the disk represented
by the active window. If no disk is selected, the Finder looks for an
inserted disk to eject, starting with the current startup disk. Whenever a
disk has been ejected, its icon and the icons belonging to it are dimmed to
show they're no longer available. (You can also eject a disk by dragging its
icon to the Trash.)

Eject

The Edit menu
Cut
Copy
Paste
Clear
Select All
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Shotu Clipboard

Figure 4-4
Edit menu

The Finder's Edit menu helps you to edit
• the names of disks, documents, applications, or folders
• text in the comment box of an information window (opened by selecting
the icon and choosing Get Info from the File menu)
• text or pictures in some desk accessories
•:• Icons: You cannot use this menu to cut or copy icons. You reproduce
icons by dragging or duplicating them. See "Duplicating Documents,
Folders, or Applications" and "Copying an Icon to a Different Disk" in
Chapter 3.

Selecting an icon also selects its title. Anything you subsequently type
replaces the old text. Clicking the selected text itself makes an insertion point
appear. You can edit this text the same way you edit any text.

• Undo. This command undoes your last text-editing action in some
applications and desk accessories that use text. (It may undo other
actions in some applications.) For example, if you choose Get Info from
the File menu and type something wrong in the text box, you can choose
Undo to erase the typing and start fresh.
• Cut Cut removes the selected material and places it on the Clipboard

(replacing the previous contents, if any).

• Copy. Copy puts a copy of the selected material on the Clipboard
(replacing the previous contents, if any). The "original" stays where it was
when you selected it.
See also "Duplicate," earlier in this chapter.
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• Paste. Paste puts a copy of the contents of the Clipboard at the insertion
point. You can continue to paste copies until you cut or copy a new
selection (which replaces the old contents of the Clipboard).

• Clear. Clear removes the selected material without placing it on the
Clipboard. The contents of the Clipboard (if any) remain intact.
• Select All. This command selects all icons in the active window or, if no
windows are open, all icons on the desktop.

• Show Clipboard. Show Clipboard displays a window with the current
contents of the Clipboard-that is, whatever you last cut or copied.

by
./by
by
by
by
by
by

Sn1all Icon
Icon
Name
Date
Size
Kind

Color

Figure 4-5

View menu

The View menu
You might keep your directory windows arranged by icon most of the time.
But the commands in the View menu also let you view directories of disks,
folders, or the Trash in other arrangements.
In any text view of a disk or folder directory, small icons appear to the left of
each document, folder, or application title. Icons and text in titles behave the
same way in whatever view you choose. Clicking either an icon or its title
selects the item; the pointer then becomes an arrow when you move it over
the icon itself (in case you want to move or copy the item, or to select
something else) and an I-beam when you move it over the item's title (in
case you want to place an insertion point for editing). Dragging an
unselected icon or title moves or copies the item-depending on where you
drag it to. See "Duplicating Documents, Folders, or Applications" and
"Copying an Icon to a Different Disk" in Chapter 3.
The current view of the active window is marked in the View menu by a
check.

• By Small Icon. By Small Icon shows the contents of the active directory
window with small icons to the left of the icon names. This view is
especially helpful when you have large numbers of documents and
applications on a disk-when looking at your hard disk, for example. You
can see more icons per square inch in this view.
• By Icon. By Icon shows the contents of the active directory window as
icons, just as they would appear on the desktop.
• By Name. By Name lists the contents of the active directory window
alphabetically by name. Uppercase and lowercase letters are considered
equivalent.
The View menu
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• By Date. By Date lists the contents of the active directory window
chronologically by modification date. The document you changed most
recently is listed first. Folders' modification dates indicate when you
created them or when you changed their contents by adding or removing
items from them. This view is useful when you need to find files you
changed recently.
• By Size. By Size lists the applications and documents in the active
directory window by size, largest first. By Size is useful for seeing which
documents are taking up the most room on the disk. Folders are listed
alphabetically by title at the bottom of the list, following the applications
and documents (but their size is not shown).
• By Kind. By Kind lists the contents of the active directory window by
whether each item is a document, application, or folder. For a document,
the window shows which application created it.
• By Color. If you have a Macintosh II with a color monitor, you can view
icons according to their color. (See "The Color Menu," later in this chapter.)
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The Special menu
• Clean Up. Clean Up is only available when you have chosen By Small Icon
or By Icon views of your directories. The command you see will change
slightly, depending on certain variables:

Figure 4-6
Special menu

o If you have an active directory window with no icons selected, the
command will say Clean Up Window. If you choose it, the icons will be
arranged in neat rows and columns on an invisible grid, filling in from
left to right and top to bottom.
o If you have one or more icons selected, the command will say Clean Up
Selection. When you choose it, each selected icon will move to the
nearest available space on the grid-not necessarily filling in from left
to right and top to bottom. (To deselect all icons, click in the gray area
of the desktop.)
o If no directory windows are open and no icons are selected, the
command will say Clean Up Desktop and will move icons on the
desktop to the nearest available space on the grid.
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•:• Neater icons: If you hold down the Option key while you press the
Special menu, the command will simply say Clean Up. Choose it (while still
holding down the Option key) to display the contents of an active
directory window (or the desktop, if there is no active window) neatly
and compactly.
• Empty Trash. Empty Trash permanently discards the contents of the

Trash and makes the space it took on the disk available for immediate use.
(The Finder empties the Trash automatically whenever it needs the space,
when you choose Shut Down or Restart from this menu, or when you
start an application.)
• Erase Disk. Erase Disk completely erases and initializes the disk whose

icon you've selected. Adialog box will offer the usual choices about
initializing the disk.
You can't erase the current startup disk because your computer needs
information on that disk in order to work. If you want to erase a startup
disk, start your computer using a different disk.
See "Preparing 3.5-Inch Disks for Use" in Chapter 7 for more information
about initializing.
• Set Startup. Set Startup lets you tum MultiFinder on or off.

o With MultiFinder off, you can select one document or application and
use Set Startup so that application will open automatically upon
startup.
o With MultiFinder on, you can also use Set Startup to select applications
(and documents) to open automatically upon startup. This is helpful if
you use the same set of applications every day. For details, see
Chapter 10, "MultiFinder."
• Restart. Restart ejects any inserted disks (first saving any necessary

information) and empties the Trash, and then restarts the computer. This
is not only a shortcut, but the best way to restart the Macintosh when
you need to use a different startup disk.

• Shut Down. Shut Down ejects any inserted disks (first saving any
necessary information) and empties the Trash. On a Macintosh II, Shut
Down also turns off the computer.

The Special menu
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The Color menu
If you have a Macintosh II with a color monitor, the menu title Color

Figure 4-7
Color menu
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appears in the Finder menu bar. The menu itself is a pull-down palette of
colors. If you select any icons on the desktop and then choose a color from
the Color menu, the selected icons will be drawn in that color. This gives you
another way to organize items on your desktop-according to color. The
View menu has a By Color option. (It sorts colored icons in the same order as
the colors in the color menu.)

Chapter 4: Finder Menu Commands
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Desk Accessories
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NEEDS TI!IS CHAPTER?

This chapter tells you what you need to know to use the Apple menu's desk
accessories-mini-applications available when you're working in the Finder
and in most applications. Desk accessories let you do simple calculations
while you're working on a word processing document, tell the computer
which printer to use, and even keep a scrapbook full of your favorite
illustrations or text you use in a variety of documents.
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What's in this chapter?
This chapter explains how to use the basic Apple desk accessories, presenting
them in the order they appear on the Apple menu:
• Alann Clock
• Calculator
• Chooser
• Control Panel
• KeyCaps
• Scrapbook
Some desk accessories are relatively simple to use. (You may be able to figure
out how to use them without reading the infonnation here.) Others offer a
variety of options and require some step-by-step explanation. When this is
the case, the numbered steps (printed in boldface type) describe the actions
you must take to use that desk accessory.

About the F1ncl!'r ..
Alarm Clock
(ale ulator
Choo~er

Control Panrl
Key Caps
Scrapbook

Figure 5·1

Desk accessories automatically
installed in your System file

Where do desk accessories come from?
Six desk accessories-the Alann Clock, Calculator, Chooser, Control Panel, Key
Caps, and Scrapbook-are included with officially released versions of Apple's
system software, and are installed automatically on your startup disks. (See
Chapter 9, "Startup Disks.") Any desk accessories installed on a startup disk
are available in the Apple menu whenever that disk is the current startup
disk. You can also use the Font/DA Mover to add desk accessories to or
remove them from your startup disks. (See the Macintosh Utilities User's
Guide for infonnation on using the Font/DA Mover.)
The Macintosh Utilities disks include three additional desk accessories you
might want to add to your startup disks: Find File on disk l; Note Pad and
Puzzle on disk 2. You can also purchase additional desk accessories and add
them to your startup disks.
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•:• Find File: The hierarchical file system makes it easy to store dozens of
documents away in different folders-especially on a hard disk. You can
even store several documents or folders with the same name in different
places, or in folders within folders within folders. But with all that
flexibility you may sometimes lose track of where you've stored a
particular document. Find File locates the file or folder you need. If you
decide you want to add Find File to the Apple menu on your startup disk,
you need to use the Font/DA Mover utility to install it. For details on
installing and using Find File, see the Macintosh Utilities User's Guide.
You choose desk accessories from the Apple menu on the far-left side of the
menu bar.
With most applications, you can keep one or more desk accessories open on
your desktop while you work on documents. (However, other active
windows may overlap or cover a desk accessory window.) You can make a
desk accessory window active by clicking it or choosing the accessory again
from the Apple menu, and you can move it by dragging its title bar.
You close desk accessories either by clicking their close boxes or by choosing
Close from the File menu. (With some applications, you need to close desk
accessories before you can work on a document.) In general, desk accessories
close automatically when you open a document or an application from the
Finder, or when you quit an application. However, if you turn MultiFinder on,
any desk accessories you open will stay open until you choose to close them.
(See Chapter 10, "MultiFinder," for details.)

The Alarm Clock
The Alann Clock desk accessory is handy when you want to check the time
or date, and you can use it to alert you when it's time for a meeting or a
coffee break.

•:• Note: The Alann Clock settings are stored in the computer itself, and are
independent of the startup disk you're using. This means that if you set
the alann to go off at a specific time, it will alert you when the time
arrives, regardless of the current startup disk. (Moreover, changing the
startup disk will not unset the alann-you have to do that yourself.)

The Alarm Clock
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Figure 5·2

Compact Alarm Clock

When you choose Alarm Clock from the Apple menu, a compact clock
displays the hour, minute, and second. When the clock is active, the current
settings for time and date are automatically selected (even though they
aren't highlighted), so you can copy and paste them into a document you're
working on or into a desk accessory that accepts text.
To see more, click the lever on the right side of the time. With the lever
down, two more panels appear. The bottom panel displays icons for time,
date, and alarm. Select one of these icons, and use the middle panel to "set"
whatever item you selected. To go back to the compact clock, click the lever
again.
To reset the time or date, for example, click the corresponding icon in the
bottom panel. Then click again in the middle panel to select the digits you
want to change. Click the small arrows to scroll the numbers higher or lower,
or type the numbers you want. You can use the Tab key to move to the next
field you want to change (from hour to minute to second, for example).
When you're satisfied with the setting, click the lever to return to the
compact clock. You can close the Alarm Clock completely by clicking the
close box or choosing Close from the File menu.
You can also change the time and date using the Control Panel. See "The
Control Panel," later in this chapter.

Alarm-------------=;:L=
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Date
Time _
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Figure 5·3

Expanded Alarm Clock

Set/unset

button ---"

Figure 5-4

Alarm button settings
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To set the alarm, follow the same procedure you would for setting the time
and date; then click the set/unset button in the middle panel. When the alarm
is set, the small marker moves to the top of the button. Another cue that
you've set the alarm is the alarm clock icon itself. When the alarm is set, the
clock displays small lines radiating away from its bell. Note that you must
select another panel or click the lever to return to the compact clock, or the
alarm will not go off.
Once you've set the alarm, you can forget it. When the time you set arrives,
your Macintosh will alert you with a sound or by blinking the menu bar
(depending on how you've set the speaker volume in the Control Panel). If
you miss the alarm, the Apple symbol (ti) in the menu bar will blink
persistently until you respond. To unset the alarm, open the expanded clock
and click the set/unset button.

The Calculator

Figure 5-5

Calculator

To use the calculator, simply choose it from the Apple menu and enter the
calculations as you would on any four-function pocket calculator. You can
use the mouse to click numbers and functions, or you can use the keyboard.
But using the numeric keypad is probably the easiest way to work. (The
Calculator keys correspond exactly to what's on your keypad, no matter
which keyboard you have.)
You can copy the calculation results (which are automatically selected) and
paste them into any document or another desk accessory. You can also select
and copy numbers from a document and paste them into the calculator's
display.

The Chooser
The Chooser is a multipurpose desk accessory and, depending on your
particular setup, you may use it often-or rarely. While its primary purpose is
to let you communicate with devices such as printers, the variety of printers
available (especially if your computer is connected to a network) require the
Chooser to accommodate a number of different possibilities.
A zone is one part of a series

of interconnected networks.
Connecting networks together
makes it possible to share
expensive devices (printers,
for example).
A resource is a system file that

resides on the startup disk and
makes it possible for your system
to communicate with devices
such as printers and the mouse.
These files usually have the same
name as the device they support.

You can use the Chooser to choose between devices connected directly to
your Macintosh's printer and modem ports, or among printers, file servers, or
other devices on an AppleTalk® network system. If you have zones on your
AppleTalk network, the Chooser lets you scan those zones for available
devices. You also use the Chooser to connect to or disconnect from an
AppleTalk network.
The Chooser lets you select any device or print from any attached printer for
which there's a resource file installed on the current startup disk. The
Macintosh Printing Tools disk contains all the printing resources currently
available for use with Apple printers. If you have not installed the resource
for your printer on your startup disk, see Chapter 9, "Startup Disks."

The Chooser
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Using the Chooser
with a directly connected
Apple printer

If you have a printer (such as an ImageWriter) directly connected to a port
on the back of your Macintosh, follow these instructions.

1. Choose the Chooser desk accessory from the Apple menu.
The printer icon appears at the upper left.

Icon for type of device

p

Chooser
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available - - - - - - - - - -...........
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Figure 5-6
ImageWriter icon in the Chooser window

•:• Don't see everything you expected? If the printer icon you expected is
missing, you haven't installed the necessary printer resources on your
startup disk. (See "Using the Installer" in Chapter 9.)
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2.

Select the icon for your directly connected printer.
Icons representing the ports on your Macintosh appear in the Select box.

Ports available to you
(click the one you attached
the printer to)

£r

AppleTalk should be Inactive - - - - - - - - - -====-==-=-

--J

Figure 5-7
Printer ports in the Chooser window

3. Select the port you used to attach the printer to your Macintosh.

4. If necessary, click Inactive for the AppleTalk option.
Because your Apple printer is directly connected to your Macintosh (not
connected by an AppleTalk network), AppleTalk should be inactive.

5. To confirm your choice, close the Chooser window.
Choose Close from the File menu or click the close box on the Chooser
window.
As long as you continue using the printer you identified, there is no need to

open the Chooser again. If your needs change (for example, if you are able to
connect to an AppleTalk network and use shared devices), open the Chooser
and make the appropriate selections.

The Chooser
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If you have a LaserWriter printer or an ImageWriter II or LQ printer with an
installed AppleTalk Option card, you can connect it to your Macintosh on an
AppleTalk network. Depending on the size and complexity of the network,
you can also connect to file servers and other shared devices.

Using the Chooser
with devices on AppleTalk

1. Choose the Chooser desk accessory from the Apple menu.
The Chooser shows icons for various devices, depending on what you've
installed on the current startup disk.
=
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Figure 5-8
Chooser window showing device icons
•!• Don't see everything you expected? If something is missing (for

example, you have a LaserWriter printer and don't see the LaserWriter
icon), you haven't installed the necessary printer resources on your
startup disk. (See "Using the Installer" in Chapter 9.)
2.

Click the icon that represents the type of device you want to use.
What you select depends on the devices available on the network you
are connected to. For example:
• If you are connected by AppleTalk to one or more LaserWriter
printers, click the LaserWriter icon.
• If you are connected by AppleTalk to an ImageWriter II, click the
AppleTalk ImageWriter icon.
• If you are connected by AppleTalk to a file server, click its icon.

When you click an icon, the Select box lists the names of all the devices
of that type available on your network.
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3. Click the device name to select the device you want
On most networks it is a common practice to assign names to identify
different devices. Even if there is only one name listed, select it.
( hOO\

r

·REfsearcn
AppleTalk should be Active - - - - - ----------=- -- - - - - "

Figure 5·9
Selecting a specific device by name

4. If necessary, click Active for the AppleTalk option.
Because the device you identified is connected to your Macintosh on an
AppleTalk network, AppleTalk should be active.

5. Type your name in the User Name box so the network can let
other users know when you're using a shared device.

6. To confirm your choices, close the Chooser window.
Choose Close from the File menu or click the close box in the Chooser
window.
As long as you continue using the printer or other network device you
identified, there is no need to open the Chooser again. If your needs change

(for example, you want to use a different printer or access a file server), open
the Chooser and make the appropriate selections.

The Chooser
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Connecting or disconnecting
AppleTalk

AppleTalk is a network system you can use to connect computers and to
share printers and other devices. (See your AppleTalk manual for details.)
1. Choose the Chooser desk accessory from the Apple menu.
2.

Make the selection you want

• Click Inactive if you're physically disconnected from AppleTalk.
• Click Active if you're physically connected to AppleTalk.
h
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Figure 5-10
Chooser window

The AppleTalk connection setting should always match whether you're
connected to AppleTalk or not. When you physically connect or
disconnect AppleTalk, always open the Chooser immediately and click
the appropriate box.
3. Type your name in the User Name box so the network can let
other users know when you're using a shared device.

This is a courtesy-helpful if several documents are waiting to print.
When you send a document to the printer, your Macintosh displays the
name of any user whose document is currently printing (ahead of
yours). That way, if you want to know how big the document is or
how long it may take, you know who to ask.

132

Chapter 5: Desk Accessories

Choosing devices on other
AppleTalk networks

AppleTalk networks can be linked together to form an interconnected series
of AppleTalk zones. If your network is linked with other AppleTalk
networks and you have access to other zones, use the Chooser to scan for
devices in those zones.
1.

Choose the Chooser desk accessory from the Apple menu.

2.

Click the icon that represents the type of device you want to use.
If necessary, use the scroll bar to find the icon you want.

At the lower left, the Zones box lists all zones you have access to, and
the zone that first appears highlighted is the one your computer is in. At
the upper right, the Select box lists the names of all devices (of the type
you just chose) that are connected to the highlighted zone.

3. Scan each wne by clicking its name until the device you want to
use appears in the Select box.

4. Click the device name to select it.

5. Type your name in the User Name box so the network can let
other users know when you're using a shared device.
If you use the Chooser from within an application to change printers, choose
Page Setup and confirm the settings you want before you choose Print.

The Control Panel
The Control Panel lets you set your preferences for such things as speaker
volume, repeating key rate, location of the startup disk, and even the
background pattern and color of your desktop. Control Panel settings are
remembered by the computer itself, even when you switch your system off.
(A built-in battery provides power for the computer to remember the
settings.)
The Control Panel desk accessory has a number of options. First, on the left
side of the panel is a list of scrollable icons. (If you have a Macintosh Plus, the
list may be short enough to fit without scrolling; with a Macintosh II, you
will need to scroll to see all the options.) When you select any of the icons, a
set of features related to that icon appears at the right.
The Control Panel
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You'll find the settings for such items as Desktop Pattern in the panel that
appears when the General icon is selected in the list. Settings for Keyboard,
Monitors, Mouse, Sound, and Startup Device all appear in when you select
those icons. (There is also a Color panel for use on a Macintosh II with a color
monitor.)
•) Do you have a Macintosh II? Most of the panels contain options available

on all Macintosh computers. Two exceptions are Color and Monitors. If
you have a Macintosh II you can use a color monitor and attach multiple
monitors.

Using the General Control
Panel

Scrollable list of icons
(for panels related
to each icon) - - - --

1. Choose Control Panel from the Apple menu.
The General Control Panel window appears. (The General icon is
highlighted by default when you first open the Control Panel.)

--------l
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•

Figure 5-11

General Control Panel
2. Make selections and change settings to suit your needs.
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To set Desktop Pattern
(monochrome monitor)

You can customize your desktop by selecting from a variety of desktop
patterns or designing your own.

1. Click the General icon if it isn't already highlighted
The Control Panel shows a miniature desktop where you can look at a
pattern and a magnified view of the pattern.

Desktop Pattern

•

Figure 5-12
Desktop Pattern in the General Control Panel

2.

Change the pattern as you wish.
• Click (or drag through) individual dots to change them from black to
white or vice versa.
• Click the white "menu bar" in the miniature desktop to see a sample
pattern. (Click on the right to see the next pattern; click on the left to
see the preceding pattern.)
• Set the pattern by clicking the miniature desktop below the white
bar.

To set Desktop Pattern
(color monitor)

If you have a Macintosh Il with a color monitor, you can change the color of
your desktop pattern and change the highlight color for text you are editing.
In addition, there is a new Color menu in the Finder menu bar that lets you
select colors for the icons on your desktop.

Changing the pattern of your desktop is the same whether you have a color
or monochrome monitor. You can click the white "menu bar" in the
miniature desktop to see sample patterns. When you find one you want,
click the miniature desktop below the white bar.
The Control Panel
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1. Click the General icon if it isn't already highlighted.
The Control Panel shows a miniature desktop where you can look at a
pattern and a magnified view of the pattern. With a color monitor, you
also see eight colors in a color bar (or eight shades of gray from a true
gray scale).

Magnified view of pattern

------- -===-====::::i:=a=-:::::
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Figure 5·13
Desktop Pattern with color bar
2.

To see the preset patterns, click the white menu bar of the
miniature desktop.
Each time you click, a different pattern will appear until you cycle
through all the preset patterns.

3. To change a color in the desktop pattern, click one of the eight
colors in the color bar to select the color you want to work with.

4. In the pattern box at the left of the miniature desktop, click the
dots you want to change.
You can also drag the pointer in the pattern box to change a group of
dots.
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5. If you want to save a pattern you've created, double-click the
miniature desktop.

The new pattern will replace the original you started with.
6.

To update your desktop with a pattern, click once on the
miniature desktop showing the pattern.

•:• Want different colors?To change a color in the color bar, double-click
it. This brings up a color wheel. (For instructions on using the color
wheel, see "Using the Color Control Panel," later in this chapter.)
To set Rate of Insertion Point
Blinking

When you click the pointer to insert text in a document, the insertion point
blinks so it's easier to see on the screen. You can adjust the rate of its
blinking.
1.

Click the General icon if it isn't already highlighted.

Use the scroll bar if necessary to bring the General icon into view.

To set Menu Blinking

2.

Click any button from Slow to Fast to set the rate at which the
vertical bar marking the insertion point blinks.

1.

Click the General icon if it isn't already highlighted.

Use the scroll bar if necessary to bring the General icon into view.
2.

Click any button from 1 to 3 to determine the number of times
menu items blink.

If you don't want the menu to alert you by blinking, click Off.
To set the Time

To set the Date

1.

Click the General icon if it isn't already highlighted.

2.

To select a time format, click either 12 hr or 24 hr.

3.

Click the digits you want to change; then click the up or down
arrow to scroll the numbers higher or lower.

1.

Click the General icon if it isn't already highlighted.

2.

Click the digits you want to change; then click the up or down
arrow to scroll the numbers higher or lower.

The Control Panel
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To use the RAM cache

RAM is an acronym for the tenn random-access memory. Generally, when
people talk about how much memory their computer has, RAM is what they
are referring to.
Using the RAM cache can greatly speed up your work, allowing an application
to store some of the infonnation it needs in a part of memory you reserve
just for this purpose. When the application needs the infonnation again, it
doesn't have to go to the disk but can get it much more quickly from the
RAM cache in memory.

1. Click the General icon if it isn't aJready highlighted.
2

Set RAM Cache to On.

3. Use the arrows to scroll to the amount of memory you want to
use for the RAM cache.
Because the RAM cache takes some space in memory, you may not
want to use it with applications that require large amounts of memory.
A rule of thumb is to use no more than one-fourth of the computer's
available memory for the RAM cache (that is, no more than 256K on a
system with 1 MB of RAM).

•:• RAM cache and MultiFinder: When you tum MultiFinder on, the
system software will check the current RAM cache setting. If it is
higher than 384K on a Macintosh with a total of 1 MB of memory, it
will automatically be lowered to 384K. MultiFinder cannot operate
with more than 384K set aside for the RAM cache on a 1 MB system.
If you choose to install a RAM expansion kit to increase the
computer's memory, the ceiling for the RAM cache with MultiFinder
goes up proportionally. (The ceiling is 384K for each megabyte of
RAM.)

With MultiFinder, available memory may be shared by several open
applications at one time. For this reason, Apple recommends setting
the RAM cache no higher than 32K for each megabyte of memory (or
turning it off) when you are working in the MultiFinder
environment. For more infonnation, see Chapter 10, "MultiFinder."

138

Chapter 5: Desk Accessories

To set Speaker Volume

1. Click the General icon if it isn't already highlighted.
2.

Adjust for the volume you want by dragging the knob up or down.
If you set the lowest volume, the computer will alert you by blinking
the menu bar rather than by making an alert sound.
•!•

Ifyou have a Macintosh II: The special sound chip in a Macintosh II
gives you additional control over the sounds you hear. To find out
how you can set preferences for the alert sound, see "Using the
Sound Control Panel" later in this chapter.

Using the Color Control
Panel

To change highlight color

With a Macintosh II and a color monitor, the Color Control Panel gives you a
way to change the highlight color on your screen.
You see a highlight when you select text to be edited-for example, when
you select the name of an icon or a sentence within a paragraph. On a
monochrome monitor, the highlight is always black or gray, but on a color
monitor you can make your highlights as colorful as you want.

1. Choose Control Panel from the Apple menu.
2.

Click the Color icon in the list on the left side of the panel

The Color Control Panel appears.
ontro

n

ne

Color icon selected

Figure 5-14
Color Control Panel

You see an example of the current highlight color and a Change Color
button.
The Control Panel
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3. Click Change Color to bring up the color wheel dialog box.
Scroll bar for brightness control

f"""

----------------------~\

o Mghl•ghl rnOo•

""

New highlight color you select

I
Current highlight color - - -- -- - .

- - - -

Colors to choose from - - - - - -- '+--- -- -- - - - -___,
1

Red
Cir een
Blue

2..J'i 76
!0960

[_!l 19_2

Figure 5-15

Color wheel dialog box

4. Click anywhere on the color wheel to try out a new highlight
color.
Clicking on the color wheel or dragging the pointer around the wheel is
the simplest way to select a new highlight color. When you do this, the
color appears in the top half of the small display box (in the upper-left
comer of the window). The bottom half of the display box continues to
show the current highlight color.
The colors at the outer edge of the wheel are the purest in hue. As you
move toward the center of the wheel you increase the amount of white
added to the pure hue (known as saturation). If you want to tone
down the brightness of the colors, use the scroll bar to the right of the
color wheel. (Down makes colors darker; up makes them brighter.)
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In the lower-left comer of the window are two sets of three small
boxes. Each set shows a numerical representation of any color you
choose from the color wheel, and you can use either set to enter a color
choice by typing numbers. For example, if you use the color wheel to
come up with a really unusual color, you can write down the numbers
representing that color-from either trio of boxes. Then, if you want to,
you can contact friends anywhere on the planet (as long as they have a
Macintosh II with a color monitor) and give them the numbers. They
can enter the numbers in the appropriate set of boxes on their screens
and see the identical highlight color.

5. When you are satisfied with the color you selected, click OK.
Until you change it, that color will appear when you select text (for
example, when you select the title of an icon to edit it). In some word
processing applications, the color will not show; you'll see a black (or
gray) highlight when you select text.
•!• How many colors do you have? With the Apple video card, you can display a

maximum of 16 colors on the screen. If your Apple dealer has installed the
video card expansion kit, you can display a maximum of 256 colors, chosen
from a palette of over 16 million!
If you have not installed the video card expansion kit (or you choose to
limit the number of colors displayed to fewer than 256), the results you
get in choosing a highlight color from the color wheel dialog box may be
unpredictable. You'll get a color, but not necessarily the color you
expected. Applications that use color may also impose their own
definitions of colors you can choose.

The Control Panel
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Using the Keyboard Control
Panel
To set Key Repeat Rate

The Keyboard Control Panel lets you customize some features of the
keyboard to suit your touch.
When you press and hold down a character key, you see that character
repeating on the screen. You can set the rate at which a key you press will
repeat.
1. Click the Keyboard icon if it isn't already highHghted.
If necessary, use the scroll bar to bring the Keyboard icon into view.
Click any button from Slow to Fast to set the rate.

2.

rf[f~-==-~ i_i;c;t,c;: ;-,3; __:•: ____________ _
r-~--:::::---1.
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Delay Until R•p•at
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Off Long

Short
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Figure 5-16
Keyboard items in the Control Panel

To set Delay Until Repeat

1. Click the Keyboard icon.

Use the scroll bar if necessary to bring the Keyboard icon into view.
2.

Click any button from Long to Short to set the length of time
the computer waits before repeating a key you're pressing.
Click Off to turn off key repeating.

Set a longer delay if you're getting a lot of repeated characters when you
don't want them.
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Using the Monitors Control
Panel
To set monitor status
for a single monitor

With a Macintosh II it is possible to attach as many as six monitors to your
computer-mixing monochrome and color. And even if you have only one
monitor, you use this control panel to define its status, depending on the
features available with your video card.

1. Click the Monitors icon if it isn't already highlighted.
The Monitors Control Panel appears.
Control Panel ~~~~=

Click here for Grays or Color - - - - --+----,,l=_
"""ll___,~1

3 .2

Gray s

Select the number of colors
= 1
or shades of gray you want - - -- ---r- - --j---i1--;=======-- t
_•o?r1"'1- ~

. (• c

Click here to test convergence
(~;·., '
on a color monitor ---------+-~.,;.,,----+-4-'

Figure 5·17
Monitors Control Panel for a single monitor
2.

Click Grays or Color.
With a color monitor, though you may prefer color most of the time,
you might want monochrome when you're doing word processing.
Clicking Grays gives you a true gray scale-evenly spaced shades of gray.
Monochrome monitors won't show color, of course, and you'll get the
best quality grays if you click Grays. If you do click Color, you'll see
grays that represent the luminance of the green color only.

3. Select the number of colors or shades of gray you want.
With the standard Apple video card, you can get a maximum of 16 colors
or grays. With the video card expansion kit installed, you can get a
maximum of 256. (More colors or grays means drawing to the screen will
be a bit slower.)
If you choose to limit the number of grays to two, you will not be
seeing a true gray scale. Black and white will be the only colors on your
screen. (It will look the same as the screen on a Macintosh Plus or
Macintosh SE.)

The Control Panel
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4. If your monitor is color, click the Convergence Test button to
check the convergence pattern.
This will help you verify that the red, green, and blue light beams are
aimed correctly for the best color picture. (To learn how to adjust color
convergence, see the monitor manual.)

With a monochrome monitor the convergence pattern is not an issue,
but it's OK to click the test button if you're curious.
Once you've completed these selections, your monitor is ready to go.
And you can always change your choices when your needs change.
With multiple monitors (all connected to your Macintosh II), you make the
same choices as you would with a single monitor-and you repeat some
parts of the process for each of your monitors. You also position your
monitors to suit your needs, select a main monitor, and fine-tune the way
your monitors relate to each other.

To set monitor status
for multiple monitors

1. Click the Monitors icon if it isn't already highlighted.
The Monitors Control Panel appears.
(on tr I Panel
Ch.ar .acte,.-ist ics of selected monitor :

3 .2

Conuergence Test

Click here to test convergence
on a color monitor - - - - --

Drag monitors .and menu bar- lo re.arrange

- --+-----r,rim----r

Select the monitor whose status
i= ·'I
you want to define (the border
t<o:.•.ibo:ir•j
of its icon will appear darkened) - - -- -+-- -- ;---;;----- - -

.,,._~----"--I Pos ition/menu b.ar moves take effe ct at ,.-.,.shrt .

Figure 5-18
Monitors Control Panel for multiple monitors
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Select the number of colors
or shades of gray you want
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Arrange monitor icons here
to match the relative positions
of your monitors

The box at the bottom of the panel shows an icon for each of the
monitors connected to your Macintosh II. The first time you bring up
the panel, monitor 1 will be highlighted to show that it is the "selected
monitor." (You will select each monitor in turn when you are ready to
make choices about that monitor's status. See step 5.)

•:• Aren't sure which monitor is which? Identifying which monitor is number
1, 2, and so on can be confusing when you've got several plugged in. In
fact, the number assigned is dependent on which expansion slot was used
for the video card the monitor is connected to. Rather than take the lid
off the main unit to identify cards in slots, you can use the Convergence
Test button to help you locate each monitor.
Select the icon for a monitor you want to identify, and click the
Convergence Test button. The test pattern will appear on the monitor
that corresponds to the icon you selected. In other words, if you selected
the icon numbered 3, the test pattern appears on the monitor represented
by that icon.

2. Click Grays or Color.
With a color monitor, even though you may prefer color most of the
time, you might want monochrome when you're doing a lot of word
processing.
Clicking Grays gives you a true gray scale-evenly spaced shades of gray.
Monochrome monitors won't show color, of course, and you'll get the
best quality display if you click Grays. If you do click Color, you'll see
grays that represent the luminance of the green color only.

3. Select the number of colors or shades of gray you want
With the standard Apple video card, you can get a maximum of 16 colors
or grays. With the video card expansion kit installed, you can get a
maximum of 256. (More colors or grays means drawing to the screen will
be a bit slower.)
If you choose to limit the number of grays to two, you will not be
seeing a true gray scale. Black and white will be the only colors on your
screen. (It will look the same as the screen on a Macintosh Plus or
Macintosh SE.)

•:• Close View: If you plan to use the CloseView™ utility (to assist users with
visual impairment), do not select 16 or 256 colors or grays. CloseView does
not perform well with more than 8 colors or grays. (See the Macintosh
Utilities User's Guide for details.)
The Control Panel
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4. If the selected monitor is color, click the Convergence Test
button to check the convergence pattern.
This will help you verify that the red, green, and blue light beams are
aimed correctly for the best color picture. (If you don't know how to
adjust color convergence, see the monitor manual.)

With a monochrome monitor the convergence pattern is not an issue,
but it's OK to click the test button if you're curious.

5,

In the box at the bottom of the panel, click an icon to select the

next monitor for which you want to deftne chataderistics.
Repeat steps 2 through S for each of your monitors.

6. Identify the positions of your monitors.
In the lower part of the panel, drag each icon to the correct position
according to the actual location of the corresponding monitor in your

work area. That is, if monitor 2 sits on a shelf above monitor 1, drag its
icon to sit on top of the icon for monitor 1, and so on. Continue to place
the icons until you've reproduced your entire monitor setup.
Remember, if you've lost track of which monitor is which, you can use
the convergence test to identify them. See the explanation at the end of
step 1.

Figure 5-19

Arranging monitor icons to match the real thing
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Put simply, to coordinate activities among multiple monitors, your
computer needs to know where they are. (Assuming you want to make
use of all the monitors, you have to tell the Macintosh which "borders"
between monitors should be open for the pointer to pass through.)
In this part of the panel, you create a replica of your actual setup by
positioning monitor icons to correspond to the physical arrangement of
monitors in your work area.

7. Identify your main monitor by dragging the miniature menu bar
to the appropriate icon.
The main monitor is the one on which you'll find the standard Finder
menu bar. In effect, it's your base of operations. You can designate any
one of your monitors as the main monitor.
( ontrol Panel
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Figure 5-20

Identifying the main monitor
When you first use this panel, monitor 1 will automatically be selected as
the main monitor. You can change that setting or leave it as is.
8.

If you have changed the positions of any monitor icons or
identified a new main monitor, close the Control Panel and

choose Restart from the Special menu.
You must restart the computer for these changes to take effect.

The Control Panel
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Using the Mouse Control
Panel

To set Mouse Tracking

When you first install the newest system software, the speed of mouse
tracking is preset to slow. This means that when you move the mouse, the
pointer moves an equivalent distance on the screen. If you have never used a
mouse before, this slow speed may be the most comfortable for you.
However, it is possible to increase the mouse tracking speed so that moving
the mouse one inch will move the pointer two inches. The advantage of this
is that you can use a smaller surface area for moving the mouse.
1. Click the Mouse icon.
Use the scroll bar if necessary to bring the Mouse icon into view.
2.

Change the mouse tracking speed to suit your preference.
• Click one of the Mouse buttons to make the pointer movement
speed variable. You won't have to move the mouse as far as you
otherwise would when you want to jump to another part of the
screen.
OR

• Click the Tablet button to keep the pointer speed constant.
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Figure 5-21
Mouse items in the Control Panel
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To set Double-Click Speed

1. Click the Mouse icon.
Use the scroll bar if necessary to bring the Mouse icon into view.

2. Change the double-click speed to suit your preference.
• Click the leftmost button for the computer to interpret fairly slow
successive clicks as a double-click.
• Click the rightmost button if you've got a fast mouse-button finger.
• Click the middle button if you're somewhere in between.

Using the Sound Control
Panel

1. Click the Sound icon.
2.

Set the volume you want by dragging the knob up or down.

At the lowest level, the computer blinks the menu bar to alert you
instead of making a sound. ('Ibis control is the same one that appears
when you click the General icon. Setting the volume in either place
moves the knob in both places.)

3. In the Alert Sound Setting box, click the sound that you like.
There are several choices available. The speaker plays back each sound as
you click it, and you can try them all to find the one you prefer to hear.
_
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Figure 5-22
Sound items in the Control Panel
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Using the Startup Device

Control Panel

If you have more than one hard disk drive attached to your Macintosh SE or
Macintosh II, you should identify one of them as your startup device. This
will be the disk the computer looks for first at startup.
1.

Click the Startup Device icon.

Use the scroll bar if necessary to bring the Startup Device icon into view.

----=- lantral PanFI
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c=:J
• 2 HD
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Figure 5-23

Startup Device Control Panel
The icons you see represent all the devices that might contain the
information the computer needs to get started.
2.

Click the device you want your computer to start from.

Until you change it, this will be the disk drive your computer will start
from each time you tum your computer on (assuming there's no
startup disk in one of the 3.5-inch disk drives).

Key Caps
If you make use of a number of different fonts, the Key Caps desk accessory
lets you verify what each set of characters looks like. This is especially useful
when you need to use diacritical marks with international characters (as in
soupfon or mafiana).
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Using Key Caps

Choose Key Caps from the Apple menu.

1.

The menu bar changes and this window appears:

Text box - -- - - -- - - - - - -Click Key Caps keys
to display characters
in the text box - - - - - -- - - - - - 1

Figure 5-24
Key

Caps
The window shows a keyboard template, and the font displayed first is
the system font, Chicago, used extensively by the Macintosh. But you
can change the template to show any font installed in the startup
System file.

2.

To see different characters, pull down the Key Caps menu and
choose another font from the list displayed.

Athens
Auant Garde
B Auant Garde Demi
B Garamond Bold
B Heluetica Bold
Bl Auant Garde OemiOblique

The font currently displayed
has a check mark beside it - - - - -- --

- - --

-

Bl Garamond Boldltalic
BI Heluetica BoldDblique
ca i ro
- - - - ; - ---t./Chicago
Courier
Garamond
Geneua
Heluetica
I Auant Garde BookOblique
I Garamond light Italic
I Heluetica Oblique
London

]
~·
oJ

6

_

+

3
. D

i

Tn_h

Figure 5·25
Key Caps menu
Key Caps
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Choosing a font lets you see its characters in the Key Caps window as
they'd appear as typed text. With any font you choose, you can use the
Option, Shift, and Caps Lock keys to see the characters each key or key
combination produces.

3, To try out characters, type on your keyboard or click Key Caps
keys.
Text you type on the keyboard or enter by clicking Key Caps keys
appears in the text box at the top of the Key Caps window. You can edit
this text in the usual way and cut and paste it into other desk
accessories or any document (although pasted characters may not be in
the same font).
See "Optional Characters" in Chapter 6 to learn how to produce accented
characters using the diacritical marks in the optional character set.

The Scrapbook
You can paste your favorite pictures and text into the Scrapbook and retrieve
them whenever you want to use them again. You can cut, copy, and paste
images among the Scrapbook, your documents, and any desk accessory that
uses text. (For example, you might keep your letterheads there.)
The contents of the Scrapbook are stored in the Scrapbook file on the current
startup disk. You can move these Scrapbook files among your startup disks
to customize the disks with the contents you want.
Depending on the size and contents of the image you paste into the
Scrapbook, you might not see the entire image until you paste it somewhere
else.

Adding an image
to

the Scrapbook

1. With a document or desk accessory open, select the text or
picture you want to add to the Scrapbook.

See each application's manual for how to select using that application.
2.

Choose Cut or Copy from the Edit menu.

Choosing Cut removes the original; choosing Copy just copies it. What
you selected is placed on the Clipboard, where it remains until you next
choose Cut or Copy.
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3, Choose Scrapbook from the Apple menu.

4. Choose Paste from the Edit menu.
The image is pasted in front of the current image in the Scrapbook. The
text at the lower left tells you the position this image has in the
Scrapbook. The text at the lower right tells whether the image is text or
a picture. You can use the scroll bar to look at the different items in the
Scrapbook.
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Figure 5-26
Scrapbook window

Removing an image
from the Scrapbook

L Choose Scrapbook from the Apple menu.
2.

Scroll to the image you want to remove.
As each image appears in the Scrapbook window, it is automatically

selected.

3, Choose Cut or Clear from the Edit menu.
The image is removed from the Scrapbook.

Moving an image from the
Scrapbook to a document

1. Choose Scrapbook from the Apple menu.
2. Scroll to the image you want to move or copy.

The current image is automatically selected.
The Scrapbook
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3. Choose Cot or Copy from the Edit menu.
The image is placed on the Clipboard, where it remains until you next
choose Cut or Copy.

4. Open the document you want to add the image to.
If the document is already open, just click in it to make it the active
window.

5. Select the place you want the image pasted.

6. Choose Paste from the Edit menu.
The image is pasted into the document.

Duplicating a Scrapbook
file

You can make copies of a Scrapbook file and drag them to other startup
disks where you want to use the same Scrapbook contents.
1. Open the System Folder and select the Scrapbook File icon.
2. Choose Duplicate from the File menu.

An icon labeled Copy ofScrapbook File appears.

3. Drag the icon to the System Folder on another startup cUsk.
If there is an existing Scrapbook file on this startup disk, drag it to the
Trash to remove it. Or, if you want to save it, drag it to a different
folder on the same disk. (You may want to rename it to help identify
what's in it.)

4. In the System Folder, select Copy of Scrapbook File and edit its
name.
Click the icon if it's not already highlighted. Then select the words Copy
ofand press the Backspace (or Delete) key.
The file must be in the System Folder and must be named Scrapbook File
or the Macintosh will not be able to identify it and use it.
You can use this technique to create different versions of the Scrapbook File
on the same startup disk-as long as each file has its own name. The only file
the Macintosh will recognize and use is the one in the System Folder named
Scrapbook File.
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Along with the mouse, you use the keyboard to communicate with your
Macintosh. This chapter will help you understand how to use all the features
of your keyboard.
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The size, shape, and layout of the available keyboards vary slightly,
depending on which Macintosh you have:
• The Macintosh Plus comes with one keyboard.
• With a Macintosh SE or Macintosh II you have a choice of two keyboards,
the Apple Keyboard or the Apple Extended Keyboard.

Macintosh Plus

keyboard -----------------------~

Apple Keyboard
for Macintosh SE and Macintosh II _ _ _ ____......

·W ~ 1;;,1;,1.,1;;,11;;,1;;1;r,1i,1 ~ = : =iw·
'' ~lf~lf"'' Oif• ~~ ···- ~
for Macintosh SE and Macintosh 11 - - - - - - - - - -Qi:m;<~:+>.J:K$.1fL
}:fu~

Apple Extended Keyboard

I

Figure 6-1
Different Macintosh keyboards

In most significant respects the three keyboards are similar. However, there
are some small differences in the positions of some keys, and both
keyboards for the Macintosh SE and Macintosh II have keys that don't
appear on the Macintosh Plus keyboard. (For technical information on the
differences between these keyboards, see the owner's guide that came with
your computer.)
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What's in this chapter?
No matter which version of the keyboard you have, it includes character
keys, numeric keys, arrow keys, and other special keys. This chapter provides
an illustrated map of each keyboard, annotated to explain what different
keys do.
These are the topics covered in this chapter:
• Macintosh Plus keyboard
• Apple Keyboard (for Macintosh SE and Macintosh II)
• Apple Extended Keyboard (for Macintosh SE and Macintosh II)
• optional characters
• Easy Access
• menu command shortcuts
• keyboard shortcuts in the Finder
You don't have to read this chapter in any particular order. Locate the map of
your keyboard in one of the first three sections. Following the keyboard
maps are instructions for typing optional characters and international
characters. Next, there's a section on how to use the Easy Access sticky keys
and mouse keys (features that assist users who have difficulty using both
hands on the keyboard or manipulating the mouse). And finally, there is
information on using Command key shortcuts.

What's in this chapter?
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Macintosh Plus keyboard

Tab key: Moves the insertion
point horizontally to the next
stopping place (such as a tab
stop or data field).

Caps Lock key: AShift key for

letters only (numbers and
symbols aren't affected).

Shift key: Produces ----~
uppercase letters (or the upper
character on the key).
Option key: The Option key in

combination with other
character keys produces an
optional set of special
characters.

Command key: The
Command key in combination
with another key is often a
shortcut to choosing a
command from a menu or (in
some applications) canceling a
long operation in progress,
such as printing.

Figure 6-2
Macintosh Plus keyboard
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Numeric keys: The arrangement of keys
on the numeric keypad matches that on
the Calculator desk accessory.

Return key:

Moves the
insertion point to the beginning
of the next line. In a dialog
box, pressing Return is the
same as clicking the outlined
button that confirms the default
command .

tekspace key: Deletes any text
rrently selected, or whatever
.aracter is to the left of the
>ertion point.

Arrow keys:

Use the arrow
keys to move the insertion
point, as an alternative to using
the mouse.

Enter key: In a dialog box,
pressing Enter is the same as
clicking the outlined button
that confirms the default
command. Some applications
require that you press Enter
(not Return) to put data into
specific fields.
Clear key: Deletes the current
selection, just as the Backspace
key does. In some applications,
Clear may have other functions.

Macintosh Plus keyboard
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Power On key: If you have a
Macintosh II, you press this key
to turn on your system when
it's been turned off.

Apple Keyboard

Esc key: Esc stands for Escape,

and the function of this key
depends on the application
you're using.

Tab key: Moves the insertion
point horizontally to the next
stopping place (such as a tab
stop or data field)

Control key: Like the - - -----i
Command key, works in
combination with other keys to
provide shortcuts or modify
other actions.
Shift key: Produces
uppercase letters (or the upper
character on the key).

Option key: The Option key in
combination with other
character keys produces an
optional set of special
characters.

Figure 6-3
Apple Keyboard
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Caps Lock key: AShift key for
letters only (numbers and
symbols aren't affected).

Command key: The
Command key in combination
with another key is often a
shortcut to choosing a
command from a menu or (in
some applications) canceling a
long operation in progress,
such as printing.

Numeric keys: The
arrangement of keys on the
numeric keypad matches that
on the Calculator desk
accessory.

Arrow keys: Use the arrow

keys to move the insertion
point, as an alternative to using
the mouse.

Delete key: Deletes any text
currently selected, or whatever
character is to the left of the
insertion point.

Return key:

Moves the
insertion point to the beginning
of the next line. In a dialog
box, pressing Return is the
same as clicking the outlined
button that confirms the default
command.

Enter key: In a dialog box,
pressing Enter is the same as
clicking the outlined button
that confirms the default
command. Some applications
require that you press Enter
(not Return) to put data into
specific fields.

dear key: Deletes the current
selection, just as the Backspace
key does. In some applications,
Clear may have other functions.

Apple Keyboard
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Apple Extended Keyboard

Function keys: These keys are designed to work in
alternative operating systems such as UNIX® or MS-DOS.
With the help of the MacroMaker™ utility program, you
can also use these keys in the Macintosh operating system
to produce recorded characters and commands.

Esc key: Esc stands for Escape, _ _____;....,.

and the function of this key
depends on the application
you're using.
Tab key: Moves the insertion
point horizontally to the next
stopping place (such as a tab
stop or data field).

----,'-~

Caps Lock key: AShift key for

letters only (numbers and
symbols aren't affected).
Shift key: Produces
uppercase leners (or the upper
character on the key).

Control key: Like the ----~~
Command key, works in
combination with other keys to
provide shortcuts or modify
other actions.
Option key: The Option key in
combination with other
character keys produces an
optional set of special
characters.

Figure 6-4
Apple Extended Keyboard
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Command key: the
Command key in combination
with another key is often a
shortcut to choosing a
command from a menu or (in
some applications) canceling a
long operation in progress,
such as printing.

Special keys: These keys are designed to
work in alternative operating systems. In
most cases, the function of these keys
depends on the operating system and
application you're using.

.
.
.
.
..Rettini key:· Moves the

insertion point to the beginning
of the next line. In a dialog
box, pressing Return is the
same as clicking the outlined
button that confirms the default
command.
Delete key: Deletes any text

currently selected, or whatever
character is to the left of the
insertion point.

Numeric keys: The
arrangement of keys on the
numeric keypad matches that
on the Calculator desk
accessory.

Arrow keys: Use the arrow

keys to move the insertion
point, as an alternative to using
the mouse.

Clear key: Deletes the current
selection, just as the Backspace
key does. In some applications,
Clear may have other functions.

Power On key: If you have a

Macintosh II, you press this key
to turn on your system when
it's been turned off.

Enter key: In a dialog box,
pressing Enter is the same as
clicking the outlined button
that confirms the default
command. Some applications
require that you press Enter
(not Return) to put data into
specific fields.

Apple Extended Keyboard
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Optional characters
When you press the Option key or Option-Shift, you get optional versions of
some characters. Figure 6-5 shows the optional characters in the Chicago font
on the Apple Keyboard. If you have a different keyboard, you may have
different optional characters available to you; use the Key Caps desk
accessory to find out what they are. You can also use the Key Caps desk
accessory to see the optional characters in any font installed in the current
startup disk's System file. See Chapter 5, "Desk Accessories," for details on
using Key Caps.
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Figure 6-5
Optional characters on the Apple Keyboard
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Typing accented characters

Using the Option key with certain other keys lets you enter international
language characters.

1. Determine what accent or diacritical mark you want.
Here are some commonly used diacritical marks and the Option-key
combinations that produce them:
• For a grave accent (') as in levre, type Option-', then type the
character you want to accent.
• For an acute accent (') as in ecole, type Option-e, then type the
character.
• For a circumflex (A) as in maftre, type Option-i, then type the
character.
• For an umlaut (") as in B6b/ingen, type Option-u, then type the
character.
• For a tilde (-) as in manana, type Option-n, then type the character.
• For a c with a cedilla(\:) as infafade, type Option-c.
2.

Press and hold down the Option key, then type the accent or
diacritical mark you want
In general, typing the Option-key combination (for example, Option-u)
produces nothing until you type a character as well. (An exception to
this is the c with a cedilla, as in soupfon. In this case, 'typing Option-c
gives you the special character directly.)

3. If necessary, type the character that you want to accent
For example, if you hold down the Option key and press the grave key,
then release those keys and type a, you'll get a-as in ala carte.
If for some reason a character can't be accented by the mark you've

chosen, you get the mark, followed by the character. Typing the
Option-key combination followed by a space gives you the diacritical
mark alone.

Optional characters
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Easy Access
Easy Access is a new ftle in your System Folder containing two features,
"sticky keys" and "mouse keys." These features assist people with
disabilities who have difficulty typing with both hands on the keyboard, or
manipulating the mouse. And they're useful to anyone who wants to be able
to use the keyboard one-handed, or make very fine movements of the
pointer with better control.

Using sticky keys

This F.asy Access feature lets you type combination keystrokes, without
actually pressing the keys simultaneously, using these "modifier" keys:

[~'"

]

DD
Macintosh SE and Macintosh II

Macintosh Plus

Figure 6-6
Modifier keys

Modifier keys only work in conjunction with other keys; they do nothing by
themselves. Teamed up with other keys, modifier keys let you take
shortcuts or exercise your "power user" know-how.
1. To turn on the sticky keys feature, press the Shift key five
times-without moving the mouse.
If the mouse is bumped or moved in any way, it interrupts the Shift-

key sequence and you'll have to start over.
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Once the sticky keys feature is turned on, you'll see one of three icons at the
right end of the menu bar:
u

This icon means the multiple-key feature is ON.

b This icon means the modifier key you just pressed is SET. The next key
you press will be part of a combination keystroke.
For example, press the Command key once and you'll see the SET icon.
Then type D (a nonmodifier) to complete the Command-D command.
The icon will change back to the ON icon. (Typing a nonmodifier releases
the SET modifier.)
When you enter a three-key command (such as Command-Shift-3), the
Command key stays SET when you press Shift (a modifier) but is
released when you type 3 (a nonmodifier).

..tr This icon means the modifier key you just pressed twice is LOCKED,
useful when you want to use the same modifier to enter several
different commands. For example, you might want to do a lot of
copying and pasting. Press the Command key twice to LOCK it, then
alternate typing C (for Copy) and V(for Paste). To unlock the modifier,
simply press it once. The icon will change back to the ON icon.
Any time you press a modifier key, the icon changes to reflect your new
options.
2. To tum off the sticky keys feature, press the Shift key ftve times
again.
As an alternative, you can tum the feature off by pressing any two
modifier keys at the same time. (The Option-Command combination is

handy because the keys are close together.)

Easy Access
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Using mouse keys

This feature lets you manipulate the pointer using the numeric keypad on
your keyboard instead of the mouse. You can click, drag, and perform all the
usual mouse activities; and you'll find that it's easier to make fine
adjustments of the pointer with this feature.
1.

To turn on mouse keys, press Command-Shift-Clear.
Remember, you can use the sticky keys feature to do this:

Macintosh Plus

+

Macintosh SE and Macintosh II

Figure 6-7
Turning mouse keys on

2. Use the numeric keypad to move the pointer, click, drag, and so
on.

The number keys around the 5 key move the pointer. (The arrows in
Figure 6-8 show direction.) The 5 key operates as the mouse button:
• Press once to click.
• Press twice to double-click.
The 0 key locks down the mouse button (for dragging, and so on). The
decimal-point key unlocks the mouse button.

3. To turn off the mouse keys feature, press Command-Shift-Clear.
Some additional tips:
Figure 6-8
Using the numeric keypad
with mouse keys on
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• When you use one of the number keys around the 5 to move the pointer,
you'll notice that the longer you press the key, the faster the pointer
moves. If it's moving too fast for comfort, choose Control Panel from
the Apple menu and change the mouse speed. (Tablet is the slowest
speed.)

• For very fine pointer movements (one pixel at a time), press and release
the number key for the direction you want to go. (In effect, you "tap"
the key.) You'll probably find that what works best is a mix of holding
down a key to move the pointer longer distances and tapping a key for
fine adjustments.
• When you need to Shift-dick, you'll use a combination of sticky keys and
mouse keys. First, make sure the sticky keys feature is ON. (Press Shift
five times.) With the ON icon in the menu bar, press Shift twice to LOCK
it (so you don't have to hold it down). Finally, go to the keypad and press
the 5 key to click and select. To extend the selection, use the other
number keys to move the pointer where you want it and click as
appropriate.
It may take some time to become skilled at using these new features, but
with practice you'll find them helpful.
If you don't plan to use these features, you can remove the Easy Access icon
from the System Folder on your startup disk, dragging the icon to the Trash.
(Please don't do this if the computer is meant for public access.) At a later
date, if you change your mind, you can copy Easy Access again from the
Macintosh System Tools disk into your System Folder. (Easy Access must be
in the System Folder or it won't work.)

Menu command shortcuts

rt~!
Cut

JtZ

H

Copy

~[

Paste
Clear
Select All

~u

WA

Show Clipboard

Figure 6-9
Command-key equivalents

On all the menus except the Apple menu (which doesn't show commands, as
such) you will see keyboard equivalents for most commands. When there is a
Command-key shortcut, you see it in the menu to the right of the command
itself. For example, in the Edit menu you see the command Cut, and beside it
the Command-key shortcut, 3€-C.
These shortcuts make it possible for you to issue a command from the
keyboard rather than using the mouse to choose the command from a menu.
You simply press the Command key and type the character that represents
the command you want. When you're doing a lot of typing that involves
cutting and pasting, for example, you may find it handy to use the
shortcuts.

Menu command shortcuts
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Keyboard shortcuts in the Finder
These shortcuts are specific to the Finder. Most of them let you do "expert"
functions.

• Option key. Holding down the Option key while you choose Close from
the File menu closes all open windows.
If your directory is in an icon view, holding down the Option key while
you choose Clean Up from the Special menu will realign the icons in the
active window to a grid pattern.
Holding down the Option key while you double-click a disk or folder icon
opens the icon as usual, and you can open an application or document in
the resulting window. The shortcut is that once you return to the Finder,
the window will be closed and the application or document put away.

• Command key. Holding down the Command key while you drag a
window moves the window without making it active.
With your directory in an icon view, you can hold down the Command
key while you drag and then release an icon. When you release the icon, it
will snap into alignment with the grid used by the Clean Up command (in
the Special menu).
Holding down the Command key while you double-click a dimmed icon
makes that icon's window active.

• Option and Command keys. Holding down the Option and Command
keys while you double-click a Finder icon makes the disk that Finder is on
become the current startup disk (if it also has a System file on it, and
MultiFinder is turned ofD.
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3.5-Inch Disks

HO NEEDS THIS CHAPTER?

It's likely that everyone with a Macintosh will need to refer to this chapter
from time to time. (All Macintosh computers have at least one 3.5-inch disk
drive.)
Obviously, 3.5-inch disks with SOOK (or 400K) of storage space cannot hold as
much information as hard disks. However, their small size and portability
make them ideal when you want to copy a file and mail it to a friend or take
a spreadsheet home to work on. You also use these disks to make backup
copies of files on your hard disk, if you have one.
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What's in this chapter?
This chapter contains infonnation on these topics:
• preparing 3.5-inch disks for use (initializing)
• ejecting 3.5-inch disks
• making copies of 3.5-inch disks
• protecting the contents of 3.5-inch disks (locking)

Different capacities and different formats
Capacity refers to the maximum amount of storage space available on a disk.
For example, Apple 3.5-inch disks that are labeled Double Sided can store a
maximum of 800 kilobytes (SOOK), or about 160 pages of text per disk. And
from time to time you'll come across disks labeled Single Sided (or not
labeled at all). These are disks on which you can store a maximum of 400K of
information.

•
This disk is single-sided
(able to hold a maximum
of 400K of information)

D.

The directory window of the
double-sided disk shows that
even though the disk looks
empty, some space (13K) has
been reserved for directory
information (the reserved
amount changes as you add
items to the disk)

-Or
-=

•
t

m d1.k
-~~=====.=!

The label tells you
this disk is double-sided
(able to hold a maximum
of SOOK of information)

"'

o~

-Or

/

Figure 7-1
Disks with different capacities
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Format refers to how you have prepared a disk for use-called initializing.

A disk with 800K capacity can be initialized with the two-sided format (using
all the available space) or the one-sided fo!lilat. A disk with 400K capacity
must be initialized with the one-sided format.
Aside from the capacity and format of the disk itself, another factor in the
equation is the capability of the disk drive in which you use the disk. While
800K disk drives are standard with the Macintosh Plus, Macintosh SE, and
Macintosh II, older Macintosh computers have 400K disk drives-requiring
disks that have been initialized with the one-sided format. An 800K disk drive
can use a disk whether it's been initialized with the two-sided or one-sided
fo!lilat, and can use the older-style 400K disks. A 400K disk drive can only use
a disk that's been initialized with the one-sided format.
Table 7-1 summarizes which disks you can use in different disk drives.
Table 7-1

Disks and drives
Disk
capacity

Disk
format

Useina400K
disk drive?

Use in an SOOK
disk drive?

400K
SOOK
SOOK

One-Sided
One-Sided
Two-Sided

Yes
Yes
No

Yes
Yes
Yes

Preparing 3.5-inch disks for use
Before your Macintosh can get information from or save information onto
disks, the disks need to be initialized in a format your computer understands.
(A blank disk is like a parking lot without divider lines. Before it can "park the
cars," your computer has to "draw in the white lines.") Any time you insert
an uninitialized disk or a disk your computer can't read (because it's damaged
or it's been initialized for a different kind of computer), a message appears
asking you whether you want to initialize the disk for the computer and
letting you choose to initialize the disk in the one-sided or two-sided format.
If you are using an application and insert an unformatted disk, most
applications allow you to initialize the disk from within the application
without losing any information currently in the computer's memory.
(During initialization, some messages may use slightly different wording,
depending on the application.)
Preparing 3.5-inch disks for use
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•!• False "unreadable" message: On rare occasions, you may insert an
initialized disk that you've been using for some time, and see a dialog box
informing you that the disk is unreadable and asking whether you want
to initialize it. (Clicking initialize will erase everything on the disk, so you
may not want to do that.) Try ejecting the disk (by clicking the Eject
button in the dialog box) and reinserting it. If the problem was only a
temporary glitch, the dialog box will not reappear.
If the "unreadable" message appears again, the disk may have been
damaged in some way. Try using the Disk First Aid™ utility to repair it.
(See the Macintosh Utilities User's Guide for details.) Or the problem may
be with the disk drive hardware. For example, the disk drive may need to
be cleaned. Your authorized Apple dealer can help you with a problem disk
drive.
It is also possible that the disk has sustained serious damage and is simply

unusable. Try using it in another disk drive or on another Macintosh. If it
still fails, you may have to throw it away.

Initializing both sides

of an SOOK disk
D. Important

If you're using SOOK disks, you'll usually initialize them with the two-sided
format. This gives you the full SOOK of available space to store applications
and data.
If you initialize an SOOK disk with the two-sided format, you cannot use it in
a 400K disk drive. If you try, you will get a dialog box asking whether you
want to initialize the disk with a format the drive can read. Clicking Initialize
erases all the information on the disk and initializes it with the one-sided
format. 6

1.

Insert the SOOK disk you want to initialize.

Adialog box appears.

r-1

I_

nm

d1~k 1~ unreadable:

Oo you u•ant to inil1al1ze ii?
0

JJ j One-Sided] T11•0-Sided]
Click here ----------ti~~~~~~~~~~:;,:::;,dj
([

Eject

Figure 7-2
Initialization dialog box

174

Chapter 7: 3.5-Inch Disks

2. In the dialog box, click Two-Sided.

3. In the next dialog box that appears, click Erase.

Figure 7-3

Dialog box to confinn that you want initiali1.ation to continue

This second dialog box is provided as insurance. You must conflrm that
you want to proceed, understanding that anything on the disk will be
erased during initiali1.ation.

4. Type a name for the disk and click OK.

Figure 7-4

Naming a disk during initiali1.ation

There are a few restrictions on the names you can give. A disk name can
contain up to 27 characters (including spaces). The name can't contain a
colon (:), and you shouldn't use a period as the first character. Other than
that, you can use any characters you can type on the keyboard.
To avoid confusion, be sure to give disks different names.

If you find you have more than one disk with the same name at any
time, you can rename them on the desktop (unless the disk is locked).
Renaming a disk works the same way as renaming any icon. See
"Renaming an Icon" in Chapter 3.

Preparing 3.5-inch diSks for use
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5.

Wait about a minute for initialization to finish.

During the process, you will see a succession of three small status boxes
containing these messages:
• Formatting Disk ...
• Verifying Format...
• Creating Directory .. .
When the final status box disappears, initialization is finished.
Initializing a disk this way installs the hierarchical file system, letting you use
folders within an application as well as in the Finder. Whenever you choose
Open or Save As, or save an untitled document while you're in an application,
you'll see and be able to use folders at different levels in the directory dialog
box. See "Working With Folders, Directories, and the Hierarchical File System"
and "Working With Documents and Applications" in Chapter 3.

Initializing a disk for use
in a 400K disk drive

D. Important
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You can initialize an SOOK disk so you can use it in a 400K disk drive. But it
makes only half the disk space available to you and doesn't install the
hierarchical file system, so you won't be able to see folders in the directory
dialog box when you choose Open or Save As from the File menu.
Be sure to initialize 400K disks with the one-sided format. Although the
computer will sometimes let you initialize a 400K disk with the two-sided
format, the second side of the disk has not been tested for reliability, and
you run the risk of losing all the information on the disk. 6

1. Insert the disk you want to initialize.
A dialog box appears.

[--I

This disk is unreadable·
Oo you want to initialize it>

Figure 7-5

Initializing a disk for a 400K disk drive

2. In the dialog box, click One-Sided.

3. In the next dialog box that appears, click Erase.

/.'..

m

This process will ernse 111
information on this disk.

([

Erns~J

Figure 7-6

Dialog box to confirm that you want initialization to continue
This second dialog box is provided as insurance. You must confirm that
you want to proceed, understanding that anything on the disk will be
erased during initialization.
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4. Type a name for the disk and click OK.

-i

Please name this disk:

_,

1

n

OK

J)

Figure 7-7
Naming a disk during initialization

There are a few restrictions on the names you can give. Adisk name can
contain up to 27 characters (including spaces). The name can't contain a
colon(:), and you shouldn't use a period as the first character. Other than
that, you can use any characters you can type on the keyboard.
To avoid confusion, be sure to give disks different names.

5. Wait about a minute for initialization to finish.
During the process, you will see a succession of three small status boxes
containing these messages:
• Formatting Disk .. .
• Verifying Format .. .
• Creating Directory .. .
When the final status box disappears, initialization is finished.

Reinitializing disks

Sometimes you want to reinitialize a 3.5-inch disk. For example, suppose you
have an 800K disk that you initialized one-sided, but now you want to use
both sides. Or you may just want to erase a lot of bits and pieces of
information you've collected on a disk and start fresh. Reinitializing is as easy
as initializing.

1. Insert the disk you want to reinitialize.
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2.

Choose Erase Disk from the Special menu.
Adialog box appears.

I I

Completely erase di~k named
"Fred" (e11ternal driuel?

n Cancel J)

(One-Sided J (Two-Sided:

Figure 7-8
Erase Disk dialog box

3. In the dialog box, choose the format you want, One-Sided or
Two-Sided.
This erases everything on the disk.
You will not be asked to give the disk a name because it already has one.
However, you can rename the disk on the desktop (unless the disk is
locked). Renaming a disk works the same way as renaming any icon. See
"Renaming an Icon" in Chapter 3.

4. Wait about a minute for the process to finish.
You will see a succession of three small status boxes containing these
messages:
• Formatting Disk ...
• Verifying Format .. .
• Creating Directory .. .
When the final status box disappears, the disk has been erased and
reinitialized.

Preparing 3.5-inch disks for use
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Ejecting 3.5-inch disks
To get information from or save information onto a disk not currently in a
disk drive, sometimes you need to eject another disk first. To do this, you
can choose the Eject command from the Finder's File menu or drag the disk
to the Trash. Your decision determines what remains on the desktop for the
Finder to manage.
If the computer needs an ejected disk later, it will ask for it.

Using the Eject command
in the Finder

1.

Select the icon that represents the disk you want to eject.

If you've opened the disk icon, you can also select it by clicking its
directory window (making the window active).
2.

Choose Eject from the File menu.

The disk will be ejected and a dimmed icon will stay on the desktop. If
you have a single 3.5-inch drive and want to copy files from one disk to
another, this is the way to eject.
Even if no disk has been selected, choosing Eject usually ejects a disk (if
one is inserted and it's not a hard disk). The Finder looks for an inserted
disk to eject.
.6. Important
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Occasionally, a disk will eject only part way and will resist being pulled out of
the disk drive. If this happens, do not forcibly remove the disk. Push it back
into the disk drive and try ejecting it again. t:::,

[lieu•

Edit

Selected disk
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Figure 7-9
Choosing the Eject command

Nothing on the disk is erased, and the Macintosh will remember the
information it needs about the ejected disk as long as its dimmed icon is
visible on the screen.
If you try to open any dimmed icons related to a disk you've ejected
this way, an alert box tells you to reinsert the disk.
You can drag a dimmed icon just as you would an icon that's not
dimmed.
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Results of using the Eject command
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As long as the ejected disk's icon remains on the desktop, the Finder will
ask you to reinsert the ejected disk any time it is needed.

Please insert the disk:
Destination Ohl<

Figure 7-11
Message requesting that you reinsert an ejected disk

Dragging a 3.5-inch disk
totheTnsh

L Drag the icon of the dJsk you want to eject to the Trash.
Make sure the tip of the pointer is over the Trash icon (and the icon
itself is highlighted).
~
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Figure 7-12
Dmgging a disk to the Trash
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2. Release the mouse button.
The disk will be ejected and its icon will be removed from the desktop.
The Finder forgets that the disk was inserted, and many times that's
exactly what you want.
Nothing on the disk is erased .
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Results of dragging a disk to the Trash
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F.xception: If there are any files open on the disk icon you drag to the
Trash (for example, if it's the current startup disk with the Finder and
System files open), its dimmed icon will remain on the desktop. You will
not be able to remove or open the icon without reinserting the disk. (But
you can choose Restart or Shut Down from the Special menu, insert
another startup disk, and restart the computer. For more information, see
"Switching Startup Disks" in Chapter 9.)
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Other ways to eject 3.5-inch disks
Choosing Restart or Shut Down from the Special menu ejects all inserted
disks (and their icons).
You can use combination keystrokes to select and eject specific disks:
• To eject a disk from drive 1, press Command-Shift-1.
• To eject a disk from drive 2, press Command-Shift-2.
• To eject a disk from a third drive, press Command-Shift-0.
These shortcuts do leave a dimmed icon on the desktop. (The Finder
remembers the disk and will ask for it if necessary.) To avoid this, eject the
disk by dragging it to the Trash.
•:• Stuck disk? On rare occasions, you may encounter a problem with a
3.5-inch disk that won't eject with any of these techniques. As a last
resort, switch off the Macintosh. Press and hold down the mouse button
while you switch the computer on again. Keep pressing on the mouse
button until the disk is ejected, then release the mouse button.

Another trick is to insert an object such as a straightened paperclip into
the small hole just to the right of the disk drive opening. Press gently to
trigger the eject mechanism.
Neither of these techniques is an ideal way to eject a disk because the
Macintosh will not be able to save the information on the current status
of that disk before it is ejected. The next time you insert the disk, the
Finder will take some time to identify and update the directory.
Sometimes a problem ejecting a disk may be a symptom of actual damage
to the disk. If that is the case, it may not be usable as is, and you will have
to reinitialize the disk, erasing its current contents.
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Making copies of 3.5-inch disks
You'll find that you want to copy disks for different reasons at different
times. You should always make backup copies of application disks and any
disk that contains essential information (for example, the Macintosh System
Tools and Macintosh Printing Tools disks that came with your computer).
That way, if the working copy is damaged in any way, you still have the
master disk and can make another copy.

Copying a 3.5-inch disk
to a hard disk

If you have a hard disk, you'll copy information from 3.5-inch disks to your
hard disk.

1. Insert the disk you want to copy (the source disk) into a disk
drive.
2. Drag the icon of the source disk to the icon of the hard disk you
want to copy to.
Adialog box appears.

Click here to copy
the source disk
to your hard disk - - - - - - ----H---{1
-tt-:-

The two disks are different types. so
the contents of "Sourrn Disk" will be
placed in a folder on "HD20".
OK

]

I Cantel

j

Figure 7-14
Dialog box to confirm that you want to copy to a hard disk

3. Click OK.
When the destination disk is a hard disk, items with the same name on
the hard disk aren't replaced. Instead, the system creates a folder with
the name of the source disk, and all its contents are copied into that
folder.

6. Important

Having more than one System Folder on a disk can cause problems. (A
startup disk is the only disk on which you need a System Folder.) When you
use this technique to copy the contents of a 3.5-inch disk onto a hard disk,
make sure you haven't added an extra System Folder to your hard disk. Open
the folder representing the disk you copied and check for the presence of a
System Folder. If one is there, drag it to the Trash. 6
Making copies of 3.5-inch disks
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Copying a 3.5-inch disk
to another 3.5-inch disk

You can copy any 3.5-inch disk whenever you can see both its icon (called the
source disk icon, because it contains the information you want to copy) and
the icon of the disk you want to copy to (called the destination disk icon,
because it's where the information is going).
There are two ways to copy one 3.5-inch disk to another 3.5-inch disk. The
difference depends on whether you have a hard disk or not.

To copy with a hard disk
as intermediary

If you have one 3.5-inch disk drive and a hard disk, you can use the hard disk

as intermediary when copying one 3.5-inch disk to another. This helps you
avoid some disk swapping. (It is also possible to do this kind of copying
without using the hard disk at all. For details, see "If You Have a Single
3.5-Inch Disk Drive," later in this section of the manual.)
1. Insert the source disk (the disk you want to copy) into the
3.5-inch disk drive.
2.

If it's not already open, select the hard disk icon and choose

Open from the File menu.
You can also double-click the icon to open it
3. Drag the icon of the source disk to the directory window of your
bard disk.
Adialog box appears.

The turn disks are different types. so
the contents or "Source 01sk" unll be
placed in a folde1 on · H020 .

Figure 7-15
Dialog box for copying a 3.5-inch disk to a hard disk
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4. Click OK.
Afew seconds will pass while the copy is being made. When the copy is
complete, a folder icon with the name of the source disk appears in the
directory window.
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Copying a source disk to a hard disk

5. Eject the source disk by dragging its icon to the Trash.

6.

Insert the 3.5-inch destination disk (the disk you want to copy

to) into a disk drive.
If the destination disk is brand-new, you'll be asked whether you want
to initialize it. You do. (If you're not sure how to initialize, see "Preparing
3.5-Inch Disks for Use," earlier in this chapter.)
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7. Drag the folder containing the somce disk's contents to the icon
of the destination disk.
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Pigure7-17
Copying from a hard disk to a 3.5-inch destination disk

8. In the dialog box that appears, click OK.
The folder and its contents will be copied onto the destination disk. You
can drag the contents out of the folder and discard the empty folder if
you want to.
When the copying process is finished, eject the destination disk. It is now a
copy of the original source disk. If it's a backup copy, put it in a safe place.
Your hard disk still shows the folder containing the contents of the source
disk. If you have no use for the copy, drag it to the Trash.
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To copy with two 3.5-inch
disk drives and no hard disk

1. If necessary, first eject any irrelevant disks.

You want to empty both disk drives so you can insert the destination
disk you're copying to and the source disk you're copying from.
If there is another disk in the way, select its icon and drag it to the
Trash. (Or you can select it and choose Eject from the File menu.
However, this technique leaves a dimmed icon on the screen that may
be distracting. At times like this you can see the usefulness of giving
disks distinctive names.)
2. Insert both the source disk and the destination disk.

If the destination disk is brand new, you'll be asked whether you want
to initialize it. You do. (If you're not sure how to initialize, see "Preparing
3.5-Inch Disks for Use," earlier in this chapter.)

3, Drag the source disk icon to the destination disk icon.
You'll see a dialog box asking you to confirm that you want to replace
the existing contents of the destination disk with the contents of the
source disk. This happens even when you know that the destination
disk is blank-as insurance against mistakes in dragging disk icons, for
example.

Are you sure you want to completely
replace contents of
"Destination Disk" leHlernal clrit•el
11•ith contents of
"Source Disk" I internal clrit•e I?

Figure 7-18
Dialog box to confmn that you want to copy the disk

In this dialog box, the disk drive specified in parentheses-for example,
"(external drive)"-will change depending on where you actually insert each
disk. If you have a Macintosh SE or a Macintosh II with two internal 3.5-inch
disk drives, both disks will be identified as being in internal drives.
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189

4. Click OK.
The copying process will begin. The Macintosh erases everything on the
destination disk and replaces it with the contents of the source disk.
•!• Can't copy? When there's not enough room on the destination

disk-if you're trying to copy a filled SOOK disk to a disk with the
one-sided format, for example-the computer will tell you so. Eject
the 400K destination disk and insert a disk with the two-sided
format in its place.

If you have a single 3.5-inch disk drive
You can copy one 3.5-inch disk to another with a single 3.5-inch drive,
although it requires some disk swapping. (In fact, you can use this technique
on a Macintosh with a single 3.5-inch disk drive and a hard disk.)
If necessary, eject any irrelevant disk currently in the 3.5-inch drive. Insert the

destination disk first; then select its icon and choose Eject from the File
menu. This will eject the disk and leave its dimmed icon on the desktop.
(Because you are copying one disk to another, you need to see the dimmed
icon.) Then insert the source disk and drag its icon to the dimmed icon of the
destination disk. The Macintosh will ask you to confirm that you want to
replace the existing contents of the destination disk with the contents of
the source disk. Click OK. You'll see messages telling you to exchange one
disk for the other, as needed, until the copy is complete.

Protecting the contents of 3.5-inch disks
You can prevent any information on a 3.5-inch disk from being changed by
locking the disk. (You can also lock specific documents and
applications-and folders, if you're using the AppleShare® file server-by
choosing Get Info from the File menu. See "Locking a Document or
Application" in Chapter 3 for instructions.)
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Locking a 3.5-inch disk

1. Looking at the back of the disk, with the metal end away from
you, notice the colored tab in the lower right-hand corner.

Locked

Unlocked

Figure 7-19
Locking and unlocking a disk
2.

To lock the disk, slide the colored tab toward the outer edge of
the disk (revealing a small hole).

When a disk is Jocked, you can't add new infonnation to it or change any
infonnation on it. You can open (and usually print) the documents it
contains, but you won't be able to save, delete, rename, move, duplicate, or
edit any information on it.

•:• Locked disks and applications: Some applications might not work with a
Jocked disk, and the Finder can't remember anything you've done on the
desktop when you're using a locked disk. Some desk accessories might
not work properly if the current startup disk is locked.

Protecting the contents of 3.5-inch disks
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HO NEEDS THIS CHAPTER?

If your Macintosh has a hard disk drive, this chapter tells you how to prepare

it for use and keep it in good running order.
Some of the newer Macintosh computers come with SCSI hard disks. (SCSI is
an acronym for Small Computer System Interface, and is commonly
pronounced "SKUH-zee.") If you have a SCSI hard disk and want to initialize
it, you'll find the instructions you need here. And whether you have a SCSI or
non-SCSI hard disk, in the last part of this chapter you'll find some helpful
tips on working with a hard disk.
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What's in this chapter?
This chapter contains information on these topics:
• preparing a SCSI hard disk (initializing and reinitializing)
• getting the most out of your hard disk
A hard disk lets you work more quickly and more efficiently. You work more
quickly with a hard disk because it transfers information to and from your
computer's main memory much faster than a 3.5-inch disk does-cutting
down on waiting time. You work more efficiently with a hard disk because
you can store large amounts of information on it. (A 20 MB hard disk holds
about 25 times as much as you can store on an SOOK disk.)
You work with a hard disk and a 3.5-inch disk in the same way: opening a
hard disk icon, copying applications and documents, and organizing
information in folders are identical. In fact, the only real difference is that
you can't eject a hard disk. You can think of the hard disk as an oversized
3.5-inch disk that always stays in its drive.
To prepare your hard disk for use, you need to initialize it. Then, to make it
your startup disk (the disk from which your computer will start when you
switch on the power), you need to install the system software.

Preparing a SCSI hard disk for use
Initializing a SCSI hard disk prepares the disk to store information and installs
the driver resource, a file that tells your computer how to work with the
hard disk.

6. Important

Someone else may have already prepared the hard disk for use. Unless it was
prepared for you by someone in your work group, you'll have to decide
whether to initialize the hard disk again. Reinitializing a disk wipes out any
information stored on it.
To see if your hard disk has already been prepared, insert a startup disk into a
3.5-inch disk drive and switch on the Macintosh. (If the computer is already
on, choose Shut Down from the Special menu, insert the startup disk, and
restart the Macintosh.) In a few seconds, if you see the hard disk's icon on
the Finder desktop, the hard disk has been initialized. You can decide whether·
you want to reinitialize it. 6.
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•:• &temal hard disk drive: If you have an external SCSI hard disk, it may
need to be set up, too. The procedures are the same for both internal and
external Apple SCSI hard disks. To prepare a non-Apple hard disk, follow
the instructions in the manual that came with it.

Initializing a SC.SI hard disk

1. With your Macintosh turned on, choose Shut Down from the
Special menu.
This ejects any 3.5-inch disks you may have inserted.

If you have a Macintosh Plus or Macintosh SE, the screen will become
dark, and a dialog box will appear with a Restart button.
If you have a Macintosh II, the Shut Down command has completely
turned off the power to your system.
2.

Insert the Macintosh System Tools disk and restart the computer.

If you have a Macintosh Plus or a Macintosh SE, click the Restart button
on the screen.
If you have a Macintosh II, press the Power On key (on the keyboard)
to start the computer again.

After a few seconds, you see the System Tools disk icon on the
desktop.

3. Open the System Tools icon.
Select the icon and choose Open from the File menu. (You can also
double-click an icon to open it.)
In the System Tools directory window, find the Setup Folder.
S\!!tem Too!._S~~~~~~
lrl

j1

k

Figure 8-1
System Tools directory window
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4. Open the Setup Folder.
Among some other icons, you see the Apple HD SC Setup icon. This is
the utility you use to initialize a SCSI hard disk.

Apple HD SC Setup

------------~

Figure 8-2
Setup Folder directory window

5. Open the Apple HD SC Setup icon.
The Apple HD SC Setup dialog box appears:

Click here to select
a different disk - - -- - -- - - -- - - -- -

Figure 8-3
Apple HD SC Setup dialog box
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6. If necessary, click the Drive button to select the disk you will
initialize.

Make sure the disk drive named in the dialog box is the hard disk you
want to initialize. If it's not the correct name, click Drive until the name
you want appears.
If the drive you want doesn't show up at all, check the cable
connections and the position of any SCSI terminators. (See your
Macintosh owner's guide for details.)
7.

Click Initialize.

Another dialog box appears, giving you a chance to change your mind; it
warns you that the initialization process erases the whole disk.
8.

Click OK to start the process.
As the hard disk begins operating, various messages appear on the

screen, explaining what's going on in the meantime. The initialization
process takes about five minutes for a 20 MB hard disk drive.
A message tells you when the hard disk has been successfully initialized.
•:• Problem? If you see a message that the hard disk failed to initialize
properly, try again. If you are still unable to initialize the hard disk,

turn to Appendix B, "Troubleshooting," for help.
If the troubleshooting tips don't solve the problem, get help from a
more experienced Macintosh user or contact your authorized Apple
dealer or representative.

9, Name the disk and click OK.
After your hard disk is initialized, a dialog box appears, asking you to give
your hard disk a name. The name can have up to 27 characters, including
spaces. You can use any character except a colon(:), and don't begin the
name with a period (.) or a space.

Preparing a SCSI hard disk for use
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10. Click Quit.
You return to the Finder, and you see the hard disk icon on the right side
of the desktop with the name you've given it.

s

File

Edit

U1ew

~p Cl I

Figure 8-4

Initialization completed
•!• 'The next step: As soon as your disk has been initialized successfully, you

must install the system software so you can begin to use the hard disk as
your startup disk. See Chapter 9, "Startup Disks," for instructions on
using the Installer to create a startup disk.
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Reinitializing a SCSI
hard disk

If you have inherited a Macintosh with an internal or external Apple SCSI hard
disk that someone else has used for a while, you may want to clean it up and
start fresh. To do this, you use Apple HD SC Setup exactly as you would to
initialize a brand new hard disk. (Go back to the beginning of the previous
section, "Initializing a SCSI Hard Disk.")
•!• Do you want to save anything? Before you reinitialize the disk, check the

contents to see whether you want to save a copy of anything that's
already on the disk. For example, there may be applications or documents
you will find useful. If there are only a few items you want to copy, you
can drag their icons to 3.5-inch disks and save them that way.
If you decide that what you want to save is more substantial, you may
want to use the HD Backup utility (explained in the Macintosh Utilities
User's Guide). Another possibility is to use an Apple Tape Backup 40SC if
one is available. See the manual that came with the equipment for
instructions on its use.

Other Apple HD SC Setup functions
The Apple HD SC Setup dialog box has six buttons. You already know about
the Initialize and Quit buttons; the other four (Update, Partition, Test, and
Drive) let you perform maintenance functions on your hard disk.

Update
From time to time, Apple Computer releases improved versions of system
software. Your authorized Apple dealer or representative can tell you when a
system software update becomes available. Updating your hard disk
software gives you improved performance without any risk to the
information already stored on the disk. dick the Update button to install
updated driver resources on the hard disk.
You can also use this button to reinstall the driver resource if it becomes
damaged. (If the driver is damaged, the disk's icon won't appear on the
desktop, and the disk won't work as a startup disk.)

Preparing a SCSI hard disk for use
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•!• mfferent versions of Apple HD SC Setup: Apple HD SC Setup version 2.0,

which came with this manual, makes it possible to partition hard disks.
Because of this important change, version 2.0 is not compatible with
earlier versions.
This means that you cannot use the Update button to update a hard disk
that has been initialized already with version 1.5 of Apple HD SC Setup, or
earlier versions. (You'll get a message telling you that you cannot update.)
Instead, you must completely reinitialize the hard disk if you want to
take advantage of the features in the latest driver resources. (Reinitializing
erases the disk. Before you reinitialize, you may want to make backup
copies of what's on the hard disk.)

Partition
You can use Apple HD SC Setup to divide your hard disk into partitions.
This is an advanced feature that you will use only if you plan to store
information from other types of computers or different operating systems
on your SCSI hard disk. For example, you might use the Macintosh operating
system on one half of the disk and reserve the other half for the A!UX®
operating system (created at Apple for the Macintosh), a version of AT&T's
UNIX®. You'll find complete instructions for creating partitions in the
Macintosh Utilities User's Guide.

Test
Click the Test button to start a test of your hard disk. The test takes about
four minutes, and it checks to make sure your hardware is working properly.
(It doesn't check any software, and it has no effect on information you've
stored on the disk.)
You can run the test whenever you want. In fact, it makes sense to run this
test once a month or so to make sure that everything is working properly.
(Sometimes this test can spot a problem before it becomes obvious, and
before any of your information is affected.)
If your hard disk fails the test, try to back up any files you want to save. If
the backup process fails, run the Disk First Aid utility and try to back up the
files again. (You'll find instructions for using Disk First Aid in the Macintosh
Utilities User's Guide.) If the disk fails the test a second time, reinitialize it
(which will erase everything on the disk and reformat it). If it still fails after
reinitialization, stop using the disk and contact your authorized Apple dealer
or representative.
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Drive
In the initialization procedure, you click the Drive button when you want
your Macintosh to search for the next available SCSI disk drive. However,
letting you select the disk is not the only purpose of this button.
If you have more than one SCSI hard disk attached to your Macintosh, the
Drive button also tells you the device priority number for each Apple SCSI
drive it finds. (When you tum on your Macintosh, device priority determines
which disk the computer looks for first, second, and so on.) The device
priority number identified here is simply for your information; you cannot
change the device priority from this dialog box. For instructions on changing
the device priority number for an external SCSI hard disk, see the manual that
came with the disk. (Internal hard disk drives are always priority 0.)

•:• If you have a non-Apple SCSI disk drive: The Drive function may not
include any non-Apple SCSI disk drives in the search. And future updates
to system software cannot be guaranteed to work on all non-Apple
hardware.
See Appendix C, "SCSI Cables and Terminators," in your Macintosh owner's
guide for more information about SCSI devices and important instructions
on connecting SCSI devices to your system.

Getting the most out of your hard disk
While you can approach using your hard disk as though it were a big 3.5-inch
disk, there are certain precautions you should take.
• Organize your files carefully. Hard disks let you keep large numbers

of applications, documents, and other files a mouse click away. But
without careful organizing, files can become buried in layers of folders. Be
sure to organize your files into folders in a way that makes your job easier,
not harder. And if you happen to file a document or application in the
wrong place, the Find File desk accessory can help you locate it. (See the
Macintosh Utilities User's Guide for information about installing and
using Find File.)

Getting the most out of your hard disk
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• Leave the disk on during long work sessions to minimize wear.
While your hard disk has been designed to give you thousands of hours of
trouble-free use, you can extend its life considerably if you avoid shutting
it down every time you take a break. As a general rule, don't turn off a
hard disk unless you expect to be away from it for at least eight hours.
And it doesn't harm the disk to leave it running for long periods of time.
Running causes less wear and tear than frequent restarts.
• Always choose Shut Down from the Special menu before
switching off your computer. When you choose Shut Down, the
computer is able to put everything away safely and update directory
information before you switch off the system. Your Macintosh will start
faster the next time you switch it on-another advantage of using Shut
Down.
Turning off the computer without using Shut Down can cause the disk
to lose information, and restarting the computer will take longer.
Sometimes it can damage the disk directory. If this happens, use the Disk
First Aid utility. (Instructions are in the Macintosh Utilities User's Guide.)
Another possible remedy is to restart your computer from a different
startup disk (for example, a 3.5-inch startup disk inserted into a disk drive,
or another hard disk).

• Back up everything. Backing up means making an extra copy of a disk or
file. Having a backup copy is your insurance policy against damage to the
original. Hard disks are reliable, but accidents do happen, and if you value
the time you spent creating and revising documents, you'll take the extra
time to back up your work.
Some people back up information stored on their hard disks weekly; more
prudent people back up their work on a daily basis. The important thing is
to make backup copies regularly. Copy individual documents from your
hard disk to 3.5-inch disks just as you would copy documents from one
disk to another. Use the HD Backup program on the Macintosh Utilities
disk 1 to back up large groups of documents. You'll find instructions in
the Macintosh Utilities User's Guide. If you have an Apple Tape Backup
40SC available, you can use that.
• If you have problems using the hard disk, see Appendix B,

"Troubleshooting." Appendix B provides solutions to problems that
you may occasionally experience when using your hard disk. If you have a
problem that you cannot fix, see your authorized Apple dealer or
representative.
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Startup Disks

HO NEEDS THIS CHAPTER?

When you want to create or update a startup disk by installing system
software, you'll find the step-by-step procedure described in this chapter. If
you're curious about what makes a disk a startup disk, wonder about
customizing your startup disk, or want to learn how you can switch from
one startup disk to another, you'll find information on those topics here,
too.

203

What's in this chapter?
These are the topics covered in this chapter:
• what a startup disk is (including an explanation of the System Folder and
differences between hard and SOOK startup disks)
• creating or updating startup disks
• scanning order for startup disks
• switching startup disks
• customizing startup disks
• making a startup disk a nonstartup disk
• reclaiming space on an SOOK startup disk

What is a startup disk?
A startup disk is any disk that contains a group of special files stored in the

Figure 9-1
What you see when
there's no startup disk

System Folder. Your computer simply cannot operate without the
information in these files. Every time you switch on your Macintosh, it scans
the available disk drives for a startup disk. If the computer can't find the
folder and the files it needs, you'll see one of the icons shown in Figure 9-1.
The X means that the Macintosh has found a disk, but it's not a startup disk.
The question mark means that the Macintosh can't find a disk at all.
When you have a startup disk and use it to start your computer, it becomes
the current startup disk and appears at the top-right comer of the desktop.
•

A disk icon here always represents
the current startup disk - -- --
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Figure 9-2
Current startup disk
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What's inside a System Folder?
On some startup disks a System Folder can contain more than two dozen
different icons (depending on which version of the Macintosh and what
other equipment you have). Yet, at its most basic, a startup disk is any disk
that has a System Folder with a System file and Finder file stored in it.
--_0§

\ystem Folder
1 4

m

,j,_~

Figure 9-3
A minimal startup System Folder

The fact is, though, that the additional items in a full-blown System Folder
offer a variety of features that most users find essential. For example, a
typical System Folder will contain lmageWriter or LaserWriter printing
resources so you can print your documents, Control Panel resources so you
can adjust the speaker volume or mouse tracking speed, and so on. Figure 9-4
shows the System Folder on a startup disk for a Macintosh II with a color
monitor and a LaserWriter printer connected to it.
System and Finder files
(essential for operating
your Macintosh) ----------~-~

system Folder
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:i":t' j

Files to support your
Control Panel desk
accessory (General,
Mouse, Keyboard,
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(essential for the printers
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Files to support
so me desk accessories
(Key Caps, Scrapbook,
and so on)
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1

youuse) ------------~--~

Files that let you use
MultiFinder and
background printing
(if you have a hard disk
and LaserWriter printer)

Figure 9-4
Sample startup disk System Folder for a Macintosh II
What is a startup disk?
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What else does a startup disk do?
Besides giving your computer the information it needs to get itself started,
the System Folder on your current startup disk determines
• which versions of the system software you're using
• which devices you can control with the Control Panel
• the fonts you have available when you use an application (stored in the
System file)
• which desk accessories appear in the Apple menu (also stored in the
System file)
• the contents of the Scrapbook desk accessory

If one System Folder is good, will two be better?
No. Emphatically, no. With a hard disk, it is a common error to install
(sometimes inadvertently) multiple System Folders. One way this can
happen is in copying an application disk onto a hard disk. Because an
application disk is also a startup disk (containing a System Folder), copying
the entire disk will also copy the extra System Folder.
When you have multiple System Folders on a hard disk, your Macintosh has
no way of knowing which one you want it to use. In effect, the computer
takes its pick. You may wonder what has happened to the special fonts or
desk accessories you remember installing. (They're in the System ftle in the
System Folder the Macintosh did not use at startup.) Your Control Panel may
not have all the features or settings you've grown accustomed to. (They're
also in the "other" System Folder.) And so it goes. There is never any reason
to have more than one System Folder on a startup disk; it adds nothing but
complications.
Figure 9-5

Startup System Folder

The startup System Folder (the one the computer is currently operating
from) has an icon on it to highlight it.
If you aren't sure whether you have more than one System Folder on a
startup disk, use the Find File desk accessory to conduct a search. To install
Find File, use the Font/DA Mover utility. See the Macintosh Utilities User's
Guide for instructions. (You can also use the Font/DA Mover utility to copy
fonts and desk accessories from one System file to another.)
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Hard versus SOOK startup disks
A startup disk can take up a lot of room. For example, on a Macintosh II
decked out with a color monitor, MultiFinder, a LaserWriter printer,
background printing, and extra fonts and desk accessories, the System Folder
can take up more than 1 megabyte of space. Obviously, you can't fit that
System Folder onto an SOOK startup disk. On the other hand, it is possible to
create a pared-down version of a startup disk that will fit comfortably on an
SOOK disk with room to spare.
If you use a hard disk as your startup disk, you have the luxury of more than

enough space for a big System Folder. You can also keep a Setup Folder,
applications, and documents on the same disk. You can install fonts and desk
accessories in your System file with relative freedom. You can run
background printing confident that there's room on your startup disk for
the spooled files created.
When you don't have a hard disk, you don't have the same options. Even
with two SOOK disk drives, you need to use space wisely on an SOOK startup
disk so you can use the disk for more than one purpose. For example, you
may want it to contain an application (and have some space for saving
documents) in addition to the System Folder.

Small System files
In an effort to meet the needs of Macintosh users who don't have a hard
disk, Apple has provided scaled-down versions of the System file. These are
contained on the Macintosh Utilities disk 1 in the Mini System Setup Folder.
You can use the Installer in that folder to install the appropriate resources for
your Macintosh. (See the Macintosh Utilities User's Guide for details.)
If you install one of these small System files on your startup disk, it takes up

less space. However, there is a drawback: The startup disk you create only
works on one kind of Macintosh. In other words, if you install the
Macintosh Plus resources, you cannot use the same startup disk on a
Macintosh SE or Macintosh II.

•:• Systems with a single disk drive: With a single SOOK disk drive and no hard
disk, you may not want to install recent versions of the Macintosh
system software. In order to install and make practical use of the latest
system software, you need at least two SOOK drives.

What is a startup disk?
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Before you update existing startup disks
As a precaution, you should make a backup copy of any startup disk whose
system software you plan to update. If the disk is an application disk,
contact the manufacturer to find out whether the application is compatible
with the new Macintosh system software. If it is not compatible, ask the
manufacturer whether he can provide an updated version of the application.
If you are in doubt about compatibility, don't update the application disk.

Keep the copy containing the earlier system software and continue using it
as a startup disk when you need to use the application.

Creating or updating a startup disk
When you start with an initialized disk that does not already have the
system software on it (in the System Folder) and install system software,
you are creating a startup disk. When you start with an existing startup disk
and install the latest system software, you are updating a startup disk. In
either case, you use the Installer (found in the Setup Folder), and the
procedure you follow is identical.
The Macintosh System Tools disk can serve as a startup disk, but it's best to
create (or update) your own disk and keep the master disks in a safe place. To
create a startup disk for your Macintosh, you must install the necessary
system software found on the Macintosh System Tools disk.

•:• Back up your master disks: It is a good idea to make backup copies of the
two master disks, Macintosh System Tools and Macintosh Printing Tools.
Use the backup copies as working copies to install the system software.
That way you can keep the original master disks safe. If the backup
copies are damaged in any way, use the master disks to create new copies.
(For help, see "Making Copies of 3.5-Inch Disks" in Chapter 7.)
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For hard disk users
When your startup disk is a hard disk, there are some special considerations,
depending on whether the disk is brand new or has been used before.
• If your hard disk has never been used, you must initialize it according to
the manufacturer's instructions. (Initialize an Apple SCSI hard disk with
Apple HD SC Setup; use the version contained on the Macintosh System
Tools disk. See Chapter S, "Hard Disks," for instructions.)
• If you have inherited a used hard disk, it has already been initialized and it
may contain an earlier version of the system software (not the most
recent version, contained on the Macintosh System Tools disk that came
with this manual). It is also possible that some of the applications on the
disk will not be compatible with the new system software you are about
to install. This can result in the loss or corruption of data on the hard disk.
As insurance against such a mishap, before you install the new system
software you should back up your hard disk according to the instructions
in your owner's guide. (If you have the HD Backup utility, you can use
that with an Apple hard disk. Or you can simply copy the applications and
files from your hard disk onto 3.5-inch disks.)

Later, if you discover that an application does not work properly with the
new system software, contact the manufacturer and ask for an updated
version of the application. Meanwhile, you may need to use an earlier
version of the system software with that application. (For example, use a
copy of the original application disk as your startup disk when using the
application. See "Switching Startup Disks" later in this chapter.)

Using the Installer

These instructions assume your system has either two 3.5-inch disk drives or
a hard disk and at least one 3.5-inch disk drive. Using the Installer on a
system with a single 3.5-inch drive and no hard disk will require too much
disk swapping to be practical. (Apple does not recommend using this new
system software on a system with a single 3.5-inch drive and no hard disk.)

•:• Are you ready? If you are creating a startup disk and don't have a hard
disk, make sure you have an extra SOOK disk that you've initialized with
the SOOK format. It will be your new startup disk. (If it hasn't already
been initialized, see "Preparing 3.5-Inch Disks for Use" in Chapter 7. The
procedure is simple and takes about a minute.)
If you do have a hard disk, you should make it your startup disk.

Creating or updating a startup disk
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1. With your computer turned on, eject all disks and then turn off
the machine.

To install
MadntoshSyslem Tools

2. Insert theMacintosh System Tools disk into a 3.5-inch disk drive.
Insert the disk label side up, metal end first.

3. Turn on your Macintosh.
In a few moments, the desktop appears.

4. Select and open the System Tools icon.
Click the System Tools icon to select it. Then choose Open from the File
menu. (You can also double-click the icon to open it.)

5. Select and open the Setup Folder.
6. Select and open the Installer.
The Installer dialog box appears.
Name of disk
to be updated
appears here - - -- --

-

- --!E=
u =_::== = = = = = = =
,n=\ =
t d=ll=e,=----====--....::
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Figure 9-6
Installer dialog box for Macintosh System Tools
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7. If necessary, insert an initialized SOOK disk into the second
3.5-inch disk drive.
This is necessary if you are creating or updating an SOOK startup disk. If
your hard disk will be the startup disk, go to step S.
8. Use the Drive button to select the disk you will install to.

The name of the drive that's currently selected appears at the upperright comer of the box (above the buttons). If it's the name of the
startup disk you're creating or updating, go on to step 9. If it's not, click
the Drive button until you see the name you want.

9. Select the appropriate resources for your computer.
For example, if you have a Macintosh SE, select Macintosh SE
Installation.
When you select the resources, you'll see the message "Figuring sizes ... "
at the bottom of the dialog box. There will be a delay while the Installer
calculates how much space will be left on your startup disk after
installation.

•:• Installer can't continue? If you are updating an existing SOOK startup
disk, things can get crowded and you may get a message that the
Installer cannot complete installation on this disk. If that happens,
the problem is space. You will have to quit the Installer for now.
See "Reclaiming Space on an SOOK Startup Disk," later in this chapter,
for suggestions. Also, you may have too many fonts and desk
accessories installed in the current System file. (The Installer will not
arbitrarily erase them to create space.) Use the Font/DA Mover to
remove some fonts and desk accessories from the current System
file. See the Macintosh Utilities User's Guide for instructions on using
Font/DA Mover to do this.

10. Click the Install button.
The Installer automatically installs the system software onto the disk
you selected in step S. When the process is finished, you'll see a message
that installation was completed successfully.

11. Click Quit to exit from the Installer.
In a few seconds you'll see the desktop again.
Creating or updating a startup disk
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12. Choose Shut Down from the Special menu.
This ejects any 3.5-inch disks.
If you have a Macintosh Plus or Macintosh SE, the screen will darken,
and a dialog box will appear with a Restart button.
If you have a Macintosh II, the Shut Down command will completely

turn off the power to your system.
To install

Macinrosh Printing Tools

You've installed the required system software. Now, if you have a printer,
you need to install the necessary printing resources.

•:• Are you on a network? If you are connected by an AppleTalk network to a
LaserWriter printer that you share with other users on the network, make
sure everyone is ready to update to the same version of LaserWriter and
Laser Prep (version 5.2 in this release). Otherwise, you may experience
problems with the network.
If you have to wait a few days before everyone on the network can

update to version 5.2 of LaserWriter and Laser Prep, you will still be able to
print documents just as you always have, using the older version.
However, you will not be able to use the background printing feature of
MultiFinder (described in Chapter 10).
1. Turn on your computer.
2. When the desktop appears on the screen, insert the Macintosh
Printing Tools disk into a 3.5-inch disk drive.
Insert the disk label side up, metal end first.

3. If necessary, insert the SOOK startup disk you are installing to
into your second 3.5-inch drive.

This is necessary if you are creating or updating an BOOK startup disk. If
your hard disk will be the startup disk, go to step 4.

4. Select and open the Printing Tools icon.
Click the icon and choose Open from the File menu. (You can also
double-click the icon to open it.)
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5. Select the appropriate printing resources.
rr.nt11 g Toe.I

If you have a LaserWriter
and want to use
background printing
with MultiFinder,
select these three icons _ _ _ _ _ __ _ _____,,__ _ __;.__ _ ___/

If you have an ImageWriter
/
or ImageWriter II,
select this icon -----------~"

__,.
•9

t

Figure 9-7

Contents of the Macintosh Printing Tools disk
You can Shift-click to select more thar. one icon.
If you have a LaserWriter and want to use background printing with
MultiFinder, select three icons: LaserWriter, Laser Prep, and PrintMonitor.
(If you don't plan to use background printing, don't select
PrintMonitor.)

If you have an ImageWriter or Image Writer II, select the Image Writer
icon. (If you have an AppleTalk card installed in an Image Writer II, you
should select AppleTalk ImageWriter.)
If you have a LaserWriter Ilse and want to use background printing
with MultiFinder, select two icons: LaserWriter Ilse and PrintMonitor.
(If you don't plan to use background printing, don't select
PrintMonitor.)

If you have an ImageWriter LQ, select the LQ ImageWriter icon. (If you
have an AppleTalk card installed in your Image Writer LQ, select
LQ AppleTalk ImageWriter.)

Creating or updating a startup disk
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6. Drag the selected icon (or icons) to the System Folder on the
startup disk you are creating or updating.
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Figure 9-8
Dragging the printer icon to the System Folder

7. Release the mouse button.
When you release the button, the icons you dragged go into the System
Folder, where you should leave them. Do not put them into another
folder inside the System Folder. If you do, you won't be able to print.
You have installed the necessary printing resources.
Keep both disks, Macintosh System Tools and Macintosh Printing Tools, in a
safe place in case you need to reinstall any of the system software.

If you don't have a hard disk
If you don't have a hard disk, you may need to use the Installer to update
the system files on your application disks before using them as startup
disks.

•:• 400K disks? If you have applications on 400K disks, do not try to convert
those disks to startup disks. (There isn't room.) Instead, you'll have to
start the computer from another disk, then insert the 400K application
disk and start the application.
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Scanning order for startup disks
When you turn on your computer, it looks for a startup disk-the disk
whose system files the computer will use. Because you can have startup
disks in different drives at the same time, your computer uses an order of
precedence in looking for a startup disk. Searching in this order, it uses the
first startup disk it finds:
• internal 3.5-inch disk drive 1
• internal or external 3.5-inch disk drive 2 (if there is one)
• startup device set in the Control Panel of a Macintosh SE
or a Macintosh II
• internal hard disk or SCSI hard disk with device ID 0
• devices connected to the SCSI port in declining device priority number
(from 6 to 0)
If you're using more than one external hard disk with a System Folder, be
sure to set the proper startup device in the Control Panel. See "Using the
Startup Device Control Panel" in Chapter 5.
If you have an external hard disk, see the manual that came with the disk to
read about SCSI device priority numbers.

Switching startup disks
The startup disk is the one whose icon appears in the top-right comer of
your desktop. Sometimes you want to switch to a different startup disk
while you're working-to gain access to special desk accessories or fonts you
want to use. And sometimes the Macintosh will switch startup disks
because of an action you've taken, whether you wanted to switch or not.
The Macintosh switches to a different startup disk whenever you do any of
the following:
• Restart the computer using a different startup disk.
• Restart a Macintosh SE or Macintosh II after you've changed the startup
device (from the Control Panel).

Switching startup disks

215

• Hold down the Option key while you open an application that's on
another startup disk. (The second disk must contain a version of the
Finder that's the same as, or later than, the Finder on the current startup
disk. If the Finder is an earlier version, this will not work.)
• Hold down the Option and Command keys while you double-dick the
Finder icon on the disk you want to switch to. (Don't hold down these
keys too long or the Rebuild Desktop dialog box will appear. If it does,
simply click OK.)
Sometimes when you open an application on another startup disk
(containing the latest version of the System and Finder files), the Macintosh
will switch startup disks. However, this is unpredictable, and you cannot
always make it happen.

•:• With MultiFinder on: You cannot switch startup disks with MultiFinder
turned on. You'll get a message explaining that it can't be done. If you
really need to switch to a different startup disk, tum MultiFinder off and
restart the computer.

Customizing startup disks
Fonts and desk accessories are kept in the System file (inside the System
Folder). You can use the Font/DA Mover to customize the System file on a
startup disk so it contains your most useful fonts and desk accessories. (You
can't just open the System file and drag things back and forth.)
An application you purchase might have special fonts or desk accessories

suited to that particular application. The Font/DA Mover lets you copy these
to the System file on any other startup disk (as long as there's room on the
disk, of course). For instructions on using the Font/DA Mover, see the
Macintosh Utilities User's Guide.
You can also drag other files (not fonts or desk accessories) from the System
Folder on one disk to the System Folder on the startup disk you are
customizing. For example, you might want a copy of a Scrapbook file-to
have different Scrapbook contents available from time to time.
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To make a startup disk a nonstartup disk
You may want to tum a startup disk into a nonstartup disk (a disk just for
storing documents), especially if you're using a hard disk as your main
startup disk.

1. Start the system using any disk other than the one you want to
make a nonstartup disk.
2.

Insert the disk you want to change to a nonstartup disk into a
3.5-inch disk drive.

3. Open the icon representing the disk you inserted in step 2, and
drag its System Folder to the Trash.
You cannot drag the System Folder from the current startup disk to the
Trash. (It's in use.)

Reclaiming space on an SOOK startup disk
It may be stating the obvious to point out that one 3.5-inch startup disk
cannot hold everything that's on the two system tools disks you received
with your Macintosh. Fortunately, you don't need all the features and
resources provided.
Here are some suggestions that may help you create additional space on your
startup disk:
• If you have copied the Setup Folder to your startup disk, open the folder

and remove Apple HD SC Setup, dragging it to the Trash.
• Make sure you have installed only the printer resources you need. For
example, if you are directly connected to an ImageWriter printer, you
don't need AppleTalk ImageWriter, LaserWriter, or Laser Prep. If any of
these icons are on the disk, remove them.
• If you don't have a LaserWriter printer, you cannot use background
printing. If the icons for Backgrounder and PrintMonitor are on the disk,

drag them to the Trash.

Reclaiming space on an SOOK startup disk
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• If you don't expect to make use of Easy Access, remove it. (Easy Access is
a file in the System Folder that assists people who have difficulty
manipulating the mouse or typing with both hands on the keyboard. For
details, see Chapter 6, "Keyboards.")
• Once you've used TeachText to read (or print) the Read Me document,
drag TeachText and the Read Me document to the Trash. (TeachText is a
no-frills word processor included to support the tutorial in Chapter 1, and
to make it possible for you to read Read Me documents. If you want to
print the Read Me document later, you can restart your computer from
the Macintosh System Tools disk. Then select the Read Me icon and choose
Print from the File menu.)
• You can use the Installer in the Mini System Setup Folder on the
Macintosh Utilities disk 1 to install a smaller version of the System file.
This will mean that you cannot use the disk on different versions of the
Macintosh. (See the Macintosh Utilities User's Guide for details.)
All these items still exist on the master system tools disks, which you should
store in a safe place. Removing them from your startup disk does not mean
you won't have access to them in the future.
It's a good idea to keep about SOK available on your startup disks.
Applications usually need a little working space on the current startup disk,
even when the document you're working on is on another disk.
(Information about the space available appears in the window for that disk,
below the title bar. You can also select the startup disk's icon and choose Get
Info from the File menu to see how much space is free.)
•!• Outgrowing your disks? When the information you need spreads to more

disks than you can easily handle, the best solution is a hard disk drive. You
can then keep everything on the hard disk, and use 3.S-inch disks for
backup copies and to move information to or from the hard disk.
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MultiFinder

HO NEEDS TiilS CHAPTER?

If you are familiar with the single-Finder environment and want to use

MultiFinder, this chapter tells you what you need to know.

••

Figure 10-1
MultiFinder in action
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What is MultiFinder?
MultiFinder is the first-generation multitasking operating system for the

Apple Macintosh Plus, Macintosh SE, and Macintosh II computers-making
it possible for you to have several applications open at the same time,
including background applications that let you perform one task while your
Macintosh performs another.
• You can see and work with documents from different applications
concurrently. This means, for example, that you can copy and paste
information between documents (and applications) easily and
quickly-without having to save one document before you open the
other.
• You can have constant access to the Finder. This makes it possible to
start additional applications whenever you want, rename or delete
documents you aren't working on, and so on.
• Because MultiFinder has background processing capabilities, you'll be able
to run certain applications in the background while you continue working.
MultiFinder comes with one background application for use with a
LaserWriter printer: Background Printing. With this feature, you can print
documents and go on with your work while printing is in progress. If
you're sharing a LaserWriter on a network, you can even schedule
documents to print after hours or at a time of day when there's minimal
traffic at the printer.

What you should already know
MultiFinder is an advanced feature that will make your Macintosh more
powerful and more flexible. This chapter assumes that you are moderately
experienced with your Macintosh and that you already know basic
Macintosh skills, including how to
• use the mouse and keyboard
• open an application or document
• throw documents away
• drag, shrink, and enlarge windows
• manipulate objects on the desktop
• use the Font/DA Mover (see the Macintosh Utilities User's Guide)
• use the Finder
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If you don't know these techniques, take time now to learn them. Go
through the tutorial in Chapter 1, spend time working with a few
applications, and familiarize yourself with how you communicate with the
computer and how it responds. You will appreciate and enjoy MultiFinder
more fully when you are familiar with the Macintosh.

System requirements
MultiFinder is a feature of the system software that came with this manual.
To use MultiFinder you must have installed version 6.0 or version 5.0 (the
previous version) of the system software. (You'll find these numbers on the
disk labels.) MultiFinder will not work with earlier versions.
MultiFinder runs on all Macintosh Plus, Macintosh SE, and Macintosh II
computers with a minimum of 1 megabyte of memory (RAM). If you have
more than 1 megabyte, MultiFinder gives you even more power and
flexibility because you'll be able to open more applications at a time.
If you plan to use MultiFinder with more than one large application (the
more advanced applications tend to be large), a minimum of 2 megabytes of
memory is necessary for satisfactory performance. See your authorized Apple
dealer or representative for information about installing additional RAM.

Finding out how much memory you have
To find out how much memory your Macintosh has, choose About the
Finder from the Apple menu and look at the window that appears. You see
the heading Total Memory, followed by a number.
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Figure 10-2
Total Memory in the About the Finder window
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Divide the Total Memory number by 1,024. For example, the number 1,024
means you have 1 megabyte of RAM; the number 2,048 means you have 2
megabytes.

•:• Can't find the heading Total Memory? If you can't find Total Memory,
you haven't installed the latest version of the system software. See
"Using the Installer" in Chapter 9, "Startup Disks."

What's in this chapter?
Here's an oveiview of what you'll find in this chapter:
• how to prepare your system for background printing and turn
MultiFinder on (and off)
• a sample session showing you how to work with MultiFinder and switch
between applications
• an explanation of Background Printing in general and instructions for
printing documents on a LaserWriter printer while you work in an
application at the same time
• a discussion of how to manage the memory available for your
applications (especially important if you have not expanded beyond the
standard 1 megabyte)
• instructions for using the Set Startup dialog box to set your startup
applications
• some tips for working with MultiFinder

How to use this chapter
The first time through, it's probably a good idea to read (or at least skim)
this chapter from front to back.
• Follow the instructions for turning MultiFinder on.
• Go through the sample session.
• Read about background printing and memory management.
• If you use the same set of applications routinely, you may want to
follow the instructions for setting startup applications.
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As you become familiar with MultiFinder, you'll see that working with it

requires the same skills you use in the single Finder environment. Yet to take
advantage of MultiFinder's advanced features you need to understand some
important concepts.
•:• Are you ready? Before you can take advantage of MultiFinder, you must

install the latest system software. If you have not already done this, see
"Using the Installer," in Chapter 9.

Turning MultiFinder on
You turn MultiFinder on by clicking in the Set Startup dialog box. If you have
more than one disk icon on the desktop, make sure the one you plan to start
from is the one highlighted. (Click it to select it.)
L Choose Set Startup from the Special menu.

The Set Startup dialog box appears.

Start up
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•• "1ull1Finder Only
1:

Cancel
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OK
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Figure 10·3
Set Startup dialog box

2.

Click the button JabeledMultlFiiuler (the one with three icons
after it).

3. Click OK.
This conflllllS your choice and closes the Set Startup dialog box.

Turning

MultiFinder on
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4. If you want to tum MultiFinder on right away, choose Restart
from the Special menu.
If you'd just as soon continue what you're doing with things as they
are, that's fine. The next time you choose Restart or turn off your
computer and start it again, MultiFinder will be on.

Turning MultiFinder off
While most applications will run well with MultiFinder, now and then you
might find an application that is not compatible. If you encounter erratic
behavior in an application with MultiFinder on, you may want to turn
MultiFinder off. You use the Set Startup dialog box to do this.

1.

Choose Set Startup from the Special menu.
The Set Startup dialog box appears.

2.

Click the button labeled Finder (the one with one icon after it).

3.

Click OK.

The next time you choose Restart or Shut Down from the Special menu,
you'll be in the Finder with MultiFinder turned off.
•!• Quitting your applications: When you choose Restart or Shut Down with

MultiFinder on and applications open, MultiFinder will quit most
applications for you. If there are unsaved documents open, MultiFinder
will ask whether you want to save each document. If you click Yes,
MultiFinder will save the document and then quit the application. If you
click No, MultiFinder will not save the document but will quit the
application.
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A sample session
MultiFinder gives you a lot of flexibility, and once you've become
accustomed to working in this new environment, you'll make up your own
mind about how you want to use all its features. Meanwhile, the best way
to familiarize yourself with the possibilities is to get some hands-on
experience.
Make sure you've installed MultiFinder and have started up with it turned on.

What you'll work with
To keep things simple in this session with MultiFinder, you will be working
with two applications as you perform the procedures:
• Finder (a system application that gives you the
operations)

deskto~your

base of

• TeachText (a simple word processing application)
Make sure the TeachText icon appears in the directory window of your
startup disk. If you need to, you can copy TeachText to your startup disk
from the Macintosh System Tools disk that came with this manual. (The
Finder is available automatically, as soon as your system is turned on and you
see the desktop.)
The directory for your startup disk should be the only open window. If any
other windows are open, close them.

What you'll learn
In this sample session you'll see how easy it is to work with MultiFinder and
switch between applications. Specifically, you'll become familiar with
• what's different about the Finder desktop and the menu bar
• how to start applications
• four ways to move among open applications
• how desk accessories work with MultiFinder
In the procedures that follow, the actions you should take appear as
numbered steps, printed in bold type. Comments explaining what's
happening, or why something's happening, are in plain type. Read along and
follow the directions.
A sample session

225

The Finder desktop

With MultiFinder and your computer turned on, you are looking at the Finder
desktop. (The Finder is always the first application open.)

1. Notice the small icon at the right edge of the menu bar.
The desktop looks the same as it did before you turned MultiFinder
on-except that a small icon representing the currently active application
appears at the right edge of the menu bar. The Finder icon is the one you
see first because the Finder is the only thing running at this point.

Figure 10-4
Small Finder icon

Starting applications

You can start applications as you need them. When you start a new one, the
applications you've already started are still open and available to you.
2.

Figure 10-S
TeachText icon

Open the TeachText icon to start the application.
In a few seconds you see the TeachText window, "Untitled," empty
and filling the screen. The small icon at the right edge of the menu bar
has changed from Finder to TeachText.

3, Notice that the titles in the menu bat have changed.
The menu bar always holds menu titles for the application you're
interacting with-TeachText in this case.
Because many applications have similar menu titles, you may not notice
the titles changing as you move between applications. There are times,
though, when it's important to notice the menu bar and remember that
it belongs to the application you're using. (With several applications
open at once, you can lose track of where you are-especially when it's
time to quit an application.)

The first way to move
around: the Apple menu

The Apple menu is still what you use to open desk accessories, and now you
can also use it to move among open applications.

4. Move the pointer to the Apple menu, press the mouse button,
and hold it down while you look at the menu.
When you want to verify which application you're using, look at the
Apple menu. At the top of the menu, the About command tells you the
name of the active foreground application. (Right now, it says About
TeachText.)
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5. Pull down the Apple menu again and notice the section near the
About Teac hTettt ...

bottom (the one showing icons and names).

Alarm Clock
Calculator·
Chooser
Control Panel
Find File
Key Caps
Note Pad
Scrnpbool<

5j

Finder

.,,~ TeachTettt

With MultiFinder, the icons and names of all open applications appear in
this section of the Apple menu. Notice the check mark beside the icon
and name of the application you're using (TeachText).
You can use this menu to choose any other open application on the list,
bringing the application to the foreground where you can work with it.

6. Choose Finder from the Apple menu.
You just used the Apple menu to move from one open application
(TeachText) to another (Finder).

About Mult1Finder. ..

Open applications
are listed here _ _ ___,

As soon as you choose the Finder, the menu titles and the icon at the

Figure 10-6

right edge of the menu bar change again. In addition, the Finder window
comes forward. The TeachText window is still there in the background,
covering the desktop, but inactive.

Apple menu

•:• Reminder: If you inadvertently lose track of the window of any
application you want to work with, you can always return to the
Apple menu and choose the application there. This brings the
application forward and makes its window active.

The second way to move
around: windows

Clicking an application's inactive window is a second way to move among
open applications.

7. Click anywhere in the TeachText window (behind the Finder
window).
You just moved from one application (Finder) to another (TeachText)
by clicking in an inactive window.
8.

Use the size box to shrink the TeachText window so you can see
the desktop behind it.
Make the window as small as you can. When you can't drag the size box
any farther, release the mouse button. (You won't actually see the
desktop until you let go of the mouse button.)
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9, Click the zoom box.
As soon as you click the zoom box, the window expands to fill the
screen as before.
10. Click the 1.00m box again.

The TeachText window shrinks back to the smallest size it can be. This
zoom technique is a handy way to make windows big enough to work
in, then shrink them quickly so you can see more of the desktop and
other application windows.

Applications that use the whole desktop
Afew applications (MacPaint version 1.5 or earlier, for example) use the whole
desktop, and don't let you shrink them or move them aside to see windows
and icons that are "under" them. The windows and icons are still
there-they're just hidden.
When an application has taken over the desktop, you can still choose other
open applications (including the Finder) from the Apple menu. This way
you'll get an active window you can work in, and the menu bar will change
to the menu bar of the application whose window is active. However, you
still won't be able to see the Finder desktop. (You can tell because the Trash
icon isn't there.)
If you really need to get to the Trash, or some other item on your desktop,
simply quit the application that's taking up the screen. Use the Finder
desktop for what you need, and restart the application.

11. Drag the TeachText window toward the lower-left corner of
your screen to get it out of the way.
You should be able to see most of the desktop and at least part of the
Finder directory window. Right now the TeachText window is active,
and the directory window is inactive.
12. Click in the Finder directory window to make it active.

With MultiFinder, windows behave the same way they have in earlier
versions of the Macintosh system software. That is, only one window
can be active at a given time. As soon as you click in the Finder directory
window, it becomes active and comes forward-making the Finder
ready for you to interact with it. TeachText is still open, but its window
is inactive.
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Dimmed TeachText icon
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Figure 10·7
Active and inactive windows

The third way to move
around: dimmed
application icons

Here's a third way to move among open applications.

13. Find the TeachText icon in the Finder window.
Notice that the TeachText icon is dimmed, just as a folder is dimmed
when it's open.

14. Double-click the dlmmM. TeachText icon.
You've activated TeachText again. Double-clicking a dimmed application
icon tells the application you want to use it. (You can also select the icon
and choose Open from the File menu.)

The fourth way to move

around: small icon
in the menu bar

Here's the fourth way to move around-it's simple and fast.

15. Click the small TeachText icon at the right edge of the menu bar.
This immediately brings to the foreground the application that was
"behind" TeachText {Finder).
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16. Click the small Finder icon in the menu bar.
You're back to TeachText. Clicking the small icon in the menu bar brings
forward each open application in succession. In effect you are paging
through all the open applications.

•:• So far.. . You've used four techniques to let an open application know you
want to interact with it:
• You chose the application from the Apple menu.
• You clicked in the application's inactive window.
• You double-clicked the application's dimmed icon.
• You clicked the small icon in the menu bar.
In the final part of this sample session, you'll get a chance to see how
desk accessories work with MultiFinder.

Desk accessories

When you're using MultiFinder, desk accessories are still there when you
want them-and they don't close automatically when you start or quit an
application. Desk accessories continue to be available on the desktop when
you move between applications.

17. Choose Calculator from the Apple menu.
As the Calculator appears, the TeachText window becomes inactive and

the menu bar changes.

18. Click in the TeachText window, then choose Quit from the
TeachText File menu.
You just quit the application you were using when you opened the
Calculator desk accessory. (The TeachText icon is not dimmed now,
because the application is closed.) And as you can see, the Calculator is
still on your screen.

19. Click in the Finder window to make it active.
Activating the Finder window may have covered up the Calculator, but
it's still there-open and inactive.

20. Drag the Finder window down about 2 inches so you can see the
Calculator again.
You have to release the mouse button to finish dragging.
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21. Click in the Calculator to bring it forward, then choose Close
from the File menu (or click its close box).
In this sample session you've become familiar with the menu bar and with
starting applications, and you've practiced using the Apple menu, activating
windows, and opening and closing desk accessories. That's most of what
you need to know to work happily in the MultiFinder environment.

Background Printing
The tenn background processing describes what happens when the
computer does some work for you in the background-without interrupting
or disturbing you-while you use the same computer to work on something
else. With appropriate background applications (and MultiFinder), you are free
to continue using your Macintosh while it performs other tasks for you.
Background Printing (included with MultiFinder) is an example of a
background process. With Background Printing and a LaserWriter printer, you
can continue working in an application and print documents at the same
time.

How Background Printing works

Spooled files are files that the computer

places in temporary storage, out of the
way while other processing goes on.

When Background Printing is turned on, any time you use the Print
command (in the File menu), the document you are printing will be saved on
your startup disk and sent to the printer. (In technical jargon, the document
has been spooled.) If you send several documents to the printer, each will
be spooled, placed inside t.lie Spool Folder (in the System Folder), and then
printed in order.
Spooling requires just a fraction of the time it takes to print a document,
greatly reducing your waiting time. Once the document has been spooled,
the actual printing can go on in the background-freeing the computer for
your use.
Background Printing won't change how you use the Print command, but it
reduces the time your computer is tied up with printing.

Background Printing
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Making sure Background
Printing is on

MultiFinder comes with Background Printing preset to On. However, if
someone else has used your system, it may have been turned off. To take
advantage of Background Printing, first verify that it's on.
1. Choose the Chooser desk accessory from the Apple menu.
2. In the upper-left comer of the Chooser window, select the
LaserWriter icon.

Background Printing is an option only for LaserWriter printers.
As soon as you click the LaserWriter icon, yo1 '11 see the standard list of
LaserWriter printers you have access to. Below that box you'll find the
label Background Printing followed by the buttons On and Off.

0

Select the LaserWriter icon
-~
to see the Background Printing
. · T.
On/Offbuttons - - -- -- - - - -Ditifmli
- moomnm

l

••••••H-

IWmti'IHiim111mn.

Select the LaserWriter
printer you want to u:

1.

B6 ck ground Prin ting~ On

0

Off

Make sure On is selected
IOI

• ,.,. t
r

t

Figure 10-8
Background Printing On/Off buttons in the Chooser window

3. Make sure the On button is selected
4. If necessary, select the LaserWriter where you want to print
your documents.
If none of the LaserWriters named is selected, PrintMonitor won't know
where to print your document. (For information about PrintMonitor,
keep reading.)
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5. Close the Chooser window.
When Background Printing is turned on, you can print documents as you
always have-with added speed and convenience. On the other hand, you can
decide you want additional control over the printing process. For example,
you might want to review the status of a document you are printing,
schedule when it prints, and determine whether or not you receive
notification of what's going on. The application that lets you do all this is
called PrintMonitor.

PrintMonitor
With Background Printing turned on, as soon as you choose the Print
command you open PrintMonitor, a new application. PrintMonitor offers
options intended to give you additional control over what happens to
documents you are printing. At the same time, PrintMonitor is selfsufficient enough that you can ignore its presence and let it go about its
business in the background.
As with other applications in the MultiFinder environment, there are several

ways to bring the PrintMonitor window to the front of your screen so you
can interact with it:
• If nothing is printing at the moment, you can select and open the
PrintMonitor icon. (You'll find the icon in the System Folder.)
• If printing is going on, PrintMonitor is open and you have several ways to
bring its window to the front. You can choose PrintMonitor from the
Apple menu; you can click the small icon in the menu bar to cycle through
the open applications until PrintMonitor comes to the front; or you can
double-click the dimmed PrintMonitor icon (in the System Folder).

The menu bar now belongs to PrintMonitor.
Close

You use the PrintMonitor File menu for several purposes:

Preferences ...

• to open or close the PrintMonitor window

Stop Printing

• to open the Preferences dialog box

Figure 10-9

• to stop (or resume) printing

PrintMonitor File menu
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The PrlntMonitor window
Whenever you open PrintMonitor (by choosing its name from the Apple
menu or selecting and opening its icon in the System Folder), you'll see the
PrintMonitor window.

o

Document that's printing
and the name of the

Print Monitor

•!i!•lllmJmDm•••••
PrintinJL

1 -~,·-~•-IE·lfE~l!El!l•!lll·m·m·
LaserWriter printer -------1a
Documents that are waiting
111aiting _ _ _ _ _ _OA1
to print (numbered to show
if1 ~ ~n:i ~ect F'I an <~· V1•'yorn1 n1~
l:Q:_

J/i l2

i:s' ·~1q1_HI tnp rp1·t •'l' 11onUina

7 (

their place in the queue) - - -- - --r lf.:1i:s> Tr·~ p F'eport @• 3 1s am Si27i88
Document that's scheduled
lldy ·st.otus postpone1j in1je11nitely

flz:_IS'

to print at a specified time
Document that's postponed
indefinitely (won't print
untilyouscheduleit)

ca. ntel

Printing

:1

[

Set Print Time ...

Printing Statu~: 4th Quarter Rel)_o_rt_ _ _ _ ___,
Paqe·:. To Pnnt 14
}slat.us pnepann1~ 1jat.:i

Status of document
that's printing now

Figure 10-10

PrintMonitor window
The PrintMonitor window has a number of useful features. Going from top
to bottom, the following sections explain what they do.

• Printing. This part of the window tells you the name of the document
that is printing and the name of the printer you're using.
• Waiting. This part tells you the names of any other documents you've
elected to print, and general information about their status.
o Numbered documents are waiting to be printed as soon as possible,
and the numbers show which will print first, second, and so on. Along
with the name of the document, the list also shows the name of the
printer it's going to.
Any time you want to change the order in this list, simply drag a
numbered document to a different place in the sequence. (Move
document number 2 into position as number 1, for example.)
o When you've deferred printing until a specific time of day, the
document is identified by a small clock. (You use Set Print Time to
defer printing.) In addition, you see the time and date when the
document is scheduled to print.
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o Documents that you've postponed indefinitely appear with a short
blank line beside them (and the message "postponed indefinitely"),
indicating that there is no set time for them to print. They will stay
this way until you use Set Print Time to schedule printing.
If you have more than four documents in the Waiting list, you can scroll
to see the rest.
•!• More than one LaserWriter printer? If you are on a network with access
to more than one LaserWriter printer, you can send documents to
different printers. Use the Chooser to select the printer-before you
choose the Print command.

• Remove from List I Cancel Printing. Just below the Waiting list is a
button labeled Remove from List or Cancel Printing, depending on which
document you select.
o If you select one of the Waiting documents, the button reads Remove
from List. Click it to delete that particular printing request. (You can
Shift-click to select and delete more than one document.)
o If you select the document that is actively printing, the button reads
Cancel Printing. Click it if you want to cancel the printing that's in
progress.
• Set Print Time. This button allows you to specify a time and date to
print a document in the Waiting list. First select the document you want,
then click this button. The Set Print Time dialog box appears.

Set Pnnt Time:

•1

11 :23:55 AM

9iEll 87

1;1

Post pone Indefinitely

~·

OK

u

Figure 10-11
Set Print Time dialog box

When you get to this dialog box, you can set the time and date you want
your document to print, using a clock that works just like the Alarm
Clock desk accessory. (By the way, the current time and date always
appear first on this clock.)
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Change the time or date displayed by clicking the digits you want to
change. Arrows appear on the right. Click the up or down arrow to scroll
the numbers higher or lower. Or use the keyboard to type the numbers.
Press the Tab key to move to the next field (for example, from month to
, day to year). When the setting is what you want, click the close box. This
will also close the Set Print Time dialog box.
If you don't know when you want to print a document, click the button
beside Postpone Indefinitely. Later, when you're ready to schedule
printing, come back to this dialog box and use the clock to set the
appropriate time (and date, if necessary).
Once you've made your selection, click OK to confirm it. Or, if you change
your mind, you can click Cancel.
• Printing Status. This area at the bottom of the window gives you

information about any document you have selected from Printing or
Waiting.

The Preferences dialog box
When you choose Preferences from the PrintMonitor File menu, the
Preferences dialog box appears.
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Figure 10-12

Preferences dialog box
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No

E.

OK

~

• Hide PrintMonitor's window when printing. This option is preset to
Yes. Even when the setting is Yes, you can always use the Apple menu to
bring up the window.
If you change this setting to No, every time printing starts the
PrintMonitor window will appear on your desktop. However, it will not
come to the front to interrupt whatever else you're doing. You may have
to drag a few windows out of the way to find it (or you can choose
PrintMonitor from the Apple menu to bring the window forward).

• Notify immediately when problem occurs. This option is preset to
Yes. This means that if a problem develops that will prevent a document
from printing, an alert message will appear to inform you-even if it
means interrupting something else you're doing. If your computer is
short of memory or the printer is out of paper, you will be alerted.
If you change the setting to No, the alert messages will still be sent, but
they will be stored until you go looking for them. If you notice that a
particular document hasn't printed when you think it should have, choose
PrintMonitor from the Apple menu (or select and open its icon). Any alert
messages will appear, along with the PrintMonitor window.

• Notify when manual feed job starts. This option is preset to Yes. If
you have selected Manual Feed (in the LaserWriter dialog box), you need to
know when the job is going to print so you can feed the printer what it
needs. PrintMonitor will alert you, asking you to bring the PrintMonitor
window to the front. The PrintMonitor window will identify the
document you are printing, and name the printer involved.
If you change the setting to No, PrintMonitor will not alert you when
the manual feed job starts. If no one is there to "feed" the printer, the
LaserWriter will wait about a minute and then cancel the job.
If your LaserWriter has a non-Apple paper feeder that requires you to
select Manual Feed (even though the process is mechanical), you may
want to change the setting to No. With that kind of paper feeder in place,
you can assume that the printer will get the paper it needs, and you won't
need to be alerted every time a job starts.

Background Printing
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Stop Printing I Resume Printing
This label on the PrintMonitor File menu changes, depending on what you
chose most recently.
• If it says Stop Printing and you choose it, the printing process will stop as
soon as the current document finishes printing. (If you don't want to
wait for the document to finish printing, use the Cancel Printing button
in the PrintMonitor window, described earlier.) At that point, the label will
change to Resume Printing.
• If it says Resume Printing and you choose it, printing will begin again. The
label will change to Stop Printing.

Once you've chosen Stop Printing, none of your documents will print until
you come back to the PrintMonitor File menu and choose Resume Printing.

Some technical points about memory
Your Macintosh has a finite amount of memory that it sets aside for each
application and uses to keep track of what's going on. When you open two
or more applications with MultiFinder, you add to the complexity of the
computer's task in sorting out how much memory is available and how
much it can allocate. Once in a while, you may get a message that you can't
open an application because there's not enough memory available. When that
happens there are several possible ways to resolve the situation, but first you
need to understand how memory works in your Macintosh.
Think of your refrigerator at home. Certain areas are fixed in size (such as the
freezer compartment and vegetable drawers, which cannot shrink or expand).
Other areas can change; you can adjust shelves to meet your needs. When you
have a dozen 9-inch bottles of soda pop, and your shelves are arranged for
items 5 inches tall, you don't cut the bottles in half to make them fit; you
raise, lower, or remove one or more shelves to allow for 9 inches of vertical
space.
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Application B
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Application A
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Finder and
System

Free memory
480K

480K

Figure 10-13

How memory works in your Macintosh

The memory in your Macintosh is similar. Apart of it is reserved exclusively
for the System file and the Finder. The rest of your computer's memory is
more flexible.

The Finder memory graph
To find out how memory is allocated in your system, you use the Finder
memory graph. To see it, choose About the Finder from the Apple menu. In
the window that appears, the graph shows you how much memory each
open application is assigned and how much of that memory the application
is currently using.
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Figure 10-14

About the Finder window
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The number labeled La.rgest Unused Block just above the graph is the amount
of memory available for another application. This number, however, doesn't
necessarily represent the total amount of free memory in the system
because of something called fragmentation.

Fragmented memory
Fragmentation occurs when you start some applications, quit one or more,
and then start another application. The memory in the system is broken into
chunks-fragmented-so that it isn't all available as one contiguous block.
Macintosh applications can run only in contiguous blocks of memory.
Sometimes you'll get a message telling you that there's not enough memory
available when in fact the memory you need is not being used, but is
scattered in separate areas. If this is the case, you just have to tell the
computer to collect the smaller areas into a single larger one.

Application B
512K
Free memory that's fragmented
(not all in one chunk) - - - - - - - <
Application C
256K

Largest Unused Block of memory
(not the total amount
of free memory) - - - - - - - - - - - '

Finder and
System
480K

Figure 10-15

Fragmented memory
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Free memory
480K

Creating an unfragmented
block of memory

Follow these steps to reorganize free memory into an unfragmented block:
1.

Quit all applications.

2.

Start the applications again.

When you restart the applications, the fragmentation will be gone. The
largest available block size in the window will be a true gauge of the amount
of memory available for additional applications.

Changing application
memory size
in special situations

In general, as you start an application, it tells the computer how much
memory it wants reserved. As long as there is a big enough chunk of free
memory, the computer will accommodate the demands of each application.
Occasionally, though, you might need to adjust the amount of memory set
aside. Some older applications ask for more memory than they really need.
(These applications weren't expected to share computer memory with other
applications-as they must when you use MultiFinder.) Other times, when
you are working on a very large document, the application may not have
asked for enough space in memory.
You can tell the computer to set aside different amounts of memory for an
application's use-more if you get a message that the application is out of
memory, less if you want to try conserving memory to run more
applications. You modify memory size in the application's information
window.

6. Important

Before you lower the memory size of any application, make a backup copy of
the application. e:,
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To change an application's memory size:
1. Select the application's icon and choose Get Info from the File
metllL

The infonnation window for the application appears.
D
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Figure 10-16
An

infonnation window
Near the bottom of the window you see two lines:

• Suggested Memory Size specifies the amount of memory
recommended for this application. You cannot edit this number; it's
here for your infonnation (so you won't have to remember what the
recommended amount was).

• Application Memory Size shows the amount currently reserved for
the application. You can edit this number to increase (or decrease) the
memory to be used.
If you don't see these lines, MultiFinder is not turned on. (See "Turning
MultiFinder On" earlier in this chapter.)
!::,. Important

Do not change Application Memory Size to a number that is lower than
Suggested Memory Size. Doing so will cause the application to run with
unpredictable results (if it operates at all).
If the application does not include a Suggested Memory Size ("n/a" appears
instead of a number) or if you think the application is taking up more space
than it needs, contact the manufacturer and ask what memory size is
recommended. t:::.
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2. Use the mouse to select the Application Memory Size box.

When it's selected, the box is highlighted.
If you cannot select the Application Memory Size box for a particular
application, the application must be open. You cannot change the
memory size for an open application. Quit the application first.

3. Type a number to change the memory size.
For example, if you plan to work on an extra-large spreadsheet, you
might increase the size from 384K to 512K.

•:• To reinstate Suggested Memory Size: If you want to change this
number back to the recommended amount, leave the box blank. The
preset number will be filled in automatically.

4. Click the close box on the information window.
The next time you start the application, it will have the specified memory
area to work in.

The Set Startup command
MultiFinder lets you select two or more applications (and documents) to
open automatically upon startup. This is especially handy if you use the same
set of applications from one day to the next.
Using Set Startup requires a bit of advance planning. Once you choose the Set
Startup command, the Set Startup dialog box will appear, presenting these
options:

• Selected Items refers to any applications and documents you select in the
directory window before you choose Set Startup. When you select
multiple icons, they must all come from the same folder or they will not
all be included as startup applications and documents.
If you select only one application, its name will appear instead of
"Selected Items." (When no applications are selected, this option will be
dimmed and you can't use it.)

• Open Applications and DAs refers to any applications and desk accessories
that are open at the time you choose Set Startup. If the applications you
have already opened are the ones you want to see when you turn on your
computer, this is the button to click. (When no applications are open, this
option will be dimmed.)
The Set Startup command
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MultiFinder Only I Finder Only means that you want MultiFinder (or
the Finder, if MultiFinder is turned off) to be your startup application.
This button is selected automatically if you have not clicked one of the
other two buttons in the list.

Setting startup applications

1. Decide which Set Startup option you want to use.
The choices are Selected Items, Open Applications and DAs, and
MultiFinder Only I Finder Only. (The third choice changes depending on
whether MultiFinder is turned on or not.)
2.

If it isn't already active, activate the Finder.

You can only get to the Set Startup command from the Special menu in
the Finder.
If you can see the Finder window, click in it to activate the Finder. Or
choose Finder from the Apple menu.

3, Choose Set Startup from the Special menu.
The Set Startup dialog box appears.
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Figure 10-17

Set Startup dialog box

4. Click the button next to the option you want.
5. Click OK.
Any time you want to change your startup applications, you must click OK
for the changes to take effect.
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Tips for working with MultiFinder
This section gives you some suggestions that may enhance your working
relationship with MultiFinder. The first is a shortcut, and the second may be
useful if you haven't expanded your system to more than 1 megabyte of
memory.

• Temporarily starting without MultiFinder. If you are having
problems with an application and think it may not be happy in the
MultiFinder environment, you can start without MultiFinder temporarily.
Press the Command key and hold it down while you start (or restart)
your computer. Keep holding it down until the menu bar appears, then let
go. This turns MultiFinder off for this work session only. The next time
you start or restart your computer, MultiFinder will start as usual.
If you want to turn MultiFinder off altogether, use the Set Startup dialog
box. (See "Turning MultiFinder Off" earlier in this chapter.)

• Using the RAM cache. The RAM cache lets you set aside a part of
memory where applications can store information for quick retrieval. This
can speed up your work. However, the RAM cache takes memory that
could be used to start an application. For a system with 1 megabyte of
memory, a RAM cache of 32K is a good working size. (And if you're really
pressed for space, you can turn it off.)
To determine what setting you have on your system, choose Control
Panel from the Apple menu. In the Control Panel window, you'll see a
section labeled RAM Cache. If RAM Cache is turned on and the setting is
higher than 32K, lowering it will free up an equivalent amount of memory.
(For this change to take effect you must restart your Macintosh.)

• Using Font/DA Mover. The Font/DA Mover utility works best in the
single Finder environment (with MultiFinder turned oft).
• Using HD Backup. The HD Backup utility works unpredictably with
MultiFinder turned on. If you plan to use this utility to back up a number
of files on your hard disk, it is best to turn MultiFinder off first.
• Switching startup disks. Occasionally you may want to switch from
one startup disk to another without first shutting down your
Macintosh. (Changing startup disks this way is sometimes called switchlaunching.) You cannot do this with MultiFinder turned on, and you'll
get a message to that effect. If you really need to switch to a different
startup disk, turn MultiFinder off and restart the computer. Or you can
choose Shut Down and restart from the other startup disk.
Tips for working with MultiFinder
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A History of Macintosh
System Software

As

A GENERAL RULE, IT IB BEST TO USE THE MOST RECENT VERSION OF

Macintosh system software recommended for your Macintosh-so you can
take advantage of new features and enhancements. However, not all
versions of system software will work on all Macintosh computers. The
chart in Figure A-1 shows which generations of system software are
compatible with different versions of the Macintosh.
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Macintosh Macintosh Macintosh Macintosh Macintosh
II
Plus
SE
512K
512Ke
Finder file
version 4.1
System file
version 3.0
System file
version 3.2
System file
version 4.0

~ ~
~ ~ ~
~ ~ ~
~ ~ ~ ~ ~

System file
version 4.2

~ ~ ~ ~ ~
~ ~ ~

System file
version 6.0

~ ~ ~

System file
version 4.1

FigureA-1

Recommended system software for different Macintosh computers
Some of the changes Apple makes to system software do not produce
noticeable differences in what you see on your screen. Occasionally, the
engineers have to repair a problem, and many times they simply improve the
speed and efficiency of a feature.
On the other hand, there are changes that create important new features, and
some of these add to the size and complexity of the system software. The
end result is improved performance, but because of the increased file size, not
all versions of the Macintosh computer can take advantage of some new
features.
In general, when anything is modified, the change is reflected in a change in
version number and file size. To learn the version number of a system
software file on any of your startup disks, select the file icon and choose Get
Info from the File menu.
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Infonnation window for a System file

There is a new scheme for displaying the version numbers of the files
included in the latest Macintosh system software. When you get
information about one of these files, along with each file's version number
you'll see the overall version number for this generation of system software.
For example, if you select the System file and choose Get Info, you'll see the
version number 6.0.
On the next few pages you'll find a series of tables, each identified by a
specific Macintosh computer (starting with the Macintosh 512K). These
tables provide specific information about the contents of the System Folder
in different generations of Macintosh system software.

Missing versions? If you read the tables carefully, you may notice times
when version numbers seem to skip a beat. In fact, the tables do not
account for every single version of every feature ever created. For
example, there is a version 3.3 of the System file (created in the fall of 1986
to be shipped with the AppleShare file server). Because that version was
never included on a System Tools disk, it has not been mentioned here.
These tables reflect changes that appeared in different generations of
System Tools disks.
Some of the files listed in the tables were not assigned version numbers,
but you can use the Get Info command from the File menu to identify
the creation date.
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System software for the Macintosh 512K

e
e
~
e
e
.

.

.

.

.

Filename

Created
Jan. '85

Created
Sept. '85

Created
Jan. '86

Created
June'86

Created
Jan. '87

System
Version
File size

None
79K

None
No change

3.0
179K

3.2
186.SK

4.0
208.SK

Finder
Version
File size

4.1
46K

4.1
No change

5.1
55.SK

5.3
55.SK

5.4
78K

ImageWriter
Version
File size

None
25K

2.0
27K

2.1
30.SK

2.3
31K

2.5
36.SK

Clipboard
Version
File size

None
OK

None
OK

None
OK

None
OK

None
0.5K

Scrapbook
Version
File size

None
9K

None
No change

2.0
12.5K

No change
No change

2.1
11.5K

1.1

3.1
33.SK

3.3
39.SK

~

LaserWriter
Version
File size

27.SK

.~

LaserPrep
Version
File size

20.SK

3.1
23.SK

3.3
25K

AppleTalk lmageWriter
Version
File size

2.1
39.SK

2.3
40K

2.5
41.5K

Font/DA Mover
Version
File size

3.0
39.SK

3.2
40K

Moved to
Utilities disk

~
.

..

IB

e
.
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General(ControlPaneO
Version
File size
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1.1

1.0
9.SK

Filename

Created
Jan. '85

Created
Sept. '85

Created
Jan. '86

Created
June '86

Created
Jan. '87

Key layout

···:.

OJ

Version
File size

2.0
3K

Keyboard(ControlPaneQ
Version
File size

1.0
1.5K

Mouse (Control PaneQ
Version
File size

1.0
3.SK

System software
for the Macintosh 512K enhanced
Filename

Created
Jan. '86

Created
June '86

Created
Jan. '87

Created
Apr. '87

~
~

System
Version
File size

3.0
179K

3.2
186.5K

4.0
208.SK

4.1
311.SK

Finder
Version
File size

5.1
55.5K

5.3
55.5K

5.4
78K

5.5
78.5K

~

ImageWriter
Version
File size

2.1
30.5K

2.3
31K

2.5
36.SK

2.6
36K

.

[9
[9

Clipboard
Version
File size

None
OK

None
OK

None
0.5K

None
0.5K

.

Scrapbook
Version
File size

2.0
12.SK

No change
No change

2.1
11.5K

No change
No change

.

.

.

System software for the Macintosh 512K enhanced
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Filename

Created
Jan. 186

Created
June '86

Created
Jan. '87

Created
Apr. '87

~

LaserWriter
Version
rile size

1.1
27.SK

3.1
33.SK

3.3
39.SK

4.0
49.SK

.~

LaserPrep
Version
File size

1.1
20.SK

3.1
23.SK

3.3
25K

4.0
No change

~

AppleTalk ImageWriter
Version
2.1
File size
39.SK

2.3
40K

2.5
41.SK

2.6
41K

Font/DA Mover
Version
3.0
File size
39.SK

3.2
40K

Moved to
Utilities disk

.

..

w

[g

General (Control Panel)
Version
File size

Ba

.

[:::::·:-:-:·:·:-:-:·:-:;)

c

···:,,

~
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1.0
9.SK

3.1
13K

Version
File size

2.0
3K

2.1
3.5K

Keyboard (Control Panel)
Version
File size

1.0

1.SK

3.1
1.SK

Mouse (Control Panel)
Version
File size

1.0
3.5K

3.1
3.5K

Key layout

Easy Access

Version
File size
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1.0
3.5K

System software for the Macintosh Plus
Created
Filename

Jan. '86

Created
June '86

Created
Jan. '87

Created
Apr. '87

Created
Sept '87

Created
Apr. '88°

System
Version
File size

3.0
179K

3.2
186.5K

4.0
208.5K

4.1
311.5K

4.2
312.5K

6.0
361K

Finder
Version
File size

5.1
55.5K

5.3
55.5K

5.4
78K

5.5
78.5K

6.0
97K

6.1
103K

~

ImageWriter
Version
File size

2.1
30.5K

2.3
31K

2.5
36.5K

2.6
36K

No change
No change

2.7
39K

[9J

Clipboard
Version
File size

None

None

OK

OK

None
0.5K

None
0.5K

None
0.5K

OK

e

Version
File size

2.0
12.5K

No chan e
No change

2.1
11.5K

No change
No change

No change
No change

2.3
lK

~

LaserWriter
Version
File size

1.1

3.1

27.5K

33.5K

3.3
39.5K

4.0
49.5K

5.0
58.5K

5.2
61K

5:

laser Prep
1.1

3.1

3.3

20.5K

23.5K

25K

4.0
No change

5.0
No change

5.2
26K

~'

AppleTalk ImageWriter
Version
2.1
File size
39.5K

2.3
40K

2.5
41.5K

2.6
41K

No change
No change

2.7
44K

Font/DA Mover
Version
3.0
File size
39.5K

3.2
40K

Moved to
Utilities disk
1.0
9.5K

3.1
13K

3.2
13K

3.3

2.0
3K

2.1
3.SK

2.2
4K

No change
No change

e

e

w

4.2

Scrapbook

Version
File size

General (Control Panel)
Version
File size

14K

Key Layout

Version
File size

System software for the Macintosh Plus
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Created
Jan. '87

Created
Apr. '87

Sept. '87

Created
Apr. '88*

Keyboard(ControlPanel)
Version
File size

1.0
1.SK

3.1
1.SK

3.2
4.SK

3.3
4K

Mouse (Control Panel)
Version
File size

1.0
3.SK

3.1
3.5K

3.2
3.5K

3.3
3K

Filename
['::::·:-:::-:-:-:-:-:::;)

c

···~

~ ))»

r£J

Created
Jan. '86

Created
June'86

Created

Sound (Control Panel)
Version
File size
Easy Access
Version
File size

3.3
4K
No change
No change

No change
No change

LID

DA Handler
Version
File size

1.0
SK

6K

.

~
~
~

MultiFinder
Version
File size

1.0
41K

6.0
16K

.

Backgrounder
Version
File size

1.0
3.5K

SK

PrintMonitor
Version
File size

1.0
20.SK

1.2
34K

cl'.La :~

LQ ImageWriter
Version
File size

1.0
46K

~

LQ AppleTaJk ImageWriter
Version
File size

1.0
55K

1.0
3.5K

1.1

1.1

* The file sizes specified in the column for April '88 were the latest infonnation at the time this manual went to press. However,
it is possible that some of the numbers have changed since then. You can use the Get Info command (from the Finder File
menu) to verify the final size of any items in the System Folder.
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System software for the Macintosh SE
and Macintosh II
Filename

Created
Jan. '87

Created
April '87

Created
Sept. '87

Created
Apr. '88*

~
~

System
Version
File size

4.0
208.5K

4.1
311.5K

4.2
312.5K

6.0
361K

Finder
Version
File size

5.4
78K

5.5
78.5K

6.0
97K

6.1
103K

~

ImageWriter
Version
File size

2.5
36.5K

2.6
36K

No change
No change

2.7
39K

~
[g

Clipboard
Version
File size

None
0.5K

None
No change

None
No change

4.2
OK

Scrapbook
Version
File size

2.1
ll.5K

No change
No change

No change
No change

2.3
lK

LaserWriter
Version
File size

3.3
39.5K

4.0
49.5K

5.0
58.SK

5.2
61K

::I

Laser Prep
Version
File size

3.3
25K

4.0
No change

5.0
No change

5.2
26K

~

AppleTalk ImageWriter
Version
2.5
File size
41.5K

2.6
41K

No change
No change

2.7
44K

General (Control Panel)
Version
1.0
File size
9.5K

3.1
13K

3.2
13K

3.3
14K

Key layout
Version
File size

2.1
3.5K

2.2
4K

No change
No change

.

.

.

.

.

::r
:

.

:

e
.

tH

2.0
3K

System software for the Macintosh SE and Macintosh II
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Created
April '87

Created
Sept. '87

Created
Apr. '88*

Keyboard (Control Panel)
Version
1.0
File size
1.5K

3.1
1.5K

3.2
4.5K

3.3
4K

Mouse (Control Panel)
Version
1.0
File size
3.5K

3.1
3.5K

3.2
3.5K

3.3
3K

Monitors (Control Panel)
Version
File size

1.0
16.5K

No change
No change

3.3
16K

Sound (Control Panel)
Version
File size

3.1
3.5K

3.2
No change

3.3
4K

Startup Device (Control Panel)
Version
3.1
File size
2.5K

3.2
No change

3.3
2K

~
~

Easy Access
Version
File size

No change
No change

No change
No change

Color (Control Panel)
Version
File size

3.2
2K

3.3
2K

00

DA Handler
Version
File size

1.0
5K

6K

MultiFinder
Version
File size

1.0
41K

6.0
16K

Version
File size

1.0
3.5K

5K

PrintMonitor
Version
File size

1.0
20.5K

1.2
34K

Created

File name

··~

g
<J ))»

m
e

e

~
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Jan. '87

1.0
3.5K

1.1

Backgrounder
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1.1

Created
File name

Jan. '87

Created
April '87

Created
Sept. '87

Created
Apr. '88•

LQ ImageWriter
Version
File size

46K

LQ AppleTalk ImageWriter
Version
File size

1.0
55K

LaserWriter Ilse
Version
File size

74K

1.0

1.0

* The file sizes specified in the column for April '88 were the latest information at the time this manual went to press. However,
it is possible that some of the numbers have changed since then. You can use the Get Info command (from the Finder File
menu) to verify the final size of any items in the System Folder.

System software for the Macintosh SE and Macintosh II

257

A

p

p

E

N

D

x

B

Troubleshooting

ROBLEMS WITH YOUR MACINTOSH CAN BE CAUSED BY SOMETHING AS MINOR

as the fact that someone has unplugged your power cord-or as major as a
damaged hard disk. The information in this appendix is designed to help you
fix the minor problems. If you try all the suggested remedies and nothing
works, it is best to take your computer to an authorized Apple dealer who is
equipped to diagnose and correct such problems .

.&

Warning Any time you detect a serious problem with the operation of your computer,
unplug the power cord. This is the easiest way to turn off the power in an
emergency.•
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What's in this appendix?
This appendix will help you solve problems that may arise as you work with
your Macintosh. The information is presented according to obvious
symptoms of trouble, followed by an explanation of the probable cause and
suggestions for fixing the problem.
The symptoms are arranged in two groups:
• general problems with the Macintosh (for example, the screen is dark, the
desktop doesn't appear, a disk won't eject, or the mouse or keyboard is
not working properly)
• problems working with MultiFinder turned on (for example, an
application won't open, or Background Printing won't work)

General problems with the Macintosh
The symptoms included in this group are often the result of loose
connections, blocked air vents, or damaged disks.

• The screen is dark. First, verify that the computer is getting power.
Make sure the computer is turned on and the power cord is firmly
attached to the Macintosh and to the outlet you are using.
o If the outlet is controlled by a wall switch, see that the switch is on.
o If the outlet is controlled by a dimmer switch, use a different outlet.
o If your computer is plugged into a power strip with an on/off switch,
make sure the switch is on.
o If you have a separate monitor, the screen is dark, and the indicator
light is off, make sure the monitor is plugged into a power supply.
Also make sure that the monitor's power switch is in the on position.
(See the manual that came with the monitor.)
Second, check the brightness and contrast controls for your screen or
monitor. If someone has turned the controls way down, the screen will
be dark. (If you don't know how to adjust these controls, see your
owner's guide. If you have a separate monitor, see the manual that came
with your monitor.)

General problems with the Macintosh
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• The desktop doesn't appear. When you start the computer (or insert a
disk), the computer presents one of several icons that give you
information about itself or the disk you inserted. The different icons
indicate different situations:
Figure B-1
Question mark icon

o The question mark means the computer is switched on but cannot
find a startup disk. Insert a startup disk.
o An X usually means that the disk you inserted to start the computer
isn't a startup disk. It can also mean that the disk is damaged. Switch
off the computer and try restarting with a different disk.
o The "sad Macintosh" appears when the computer can't go any further
because of a problem with the system software. Sometimes this
indicates a hardware problem. See your Apple dealer. (You may have to
eject the disk manually and unplug the system.)

Figure B-2
X icon

o The "happy Macintosh" means everything's fine to this point.

[~
Figure B-3
Sad Macintosh icon

If you use the Installer in the Mini System Setup Folder to create a
startup disk for a specific version of the Macintosh-for example, a
Macintosh SE-you can't use the startup disk in a Macintosh Plus or a
Macintosh II. If you try, you will get a message informing you that the
startup disk won't work. (See the Macintosh Utilities User's Guide for
details.)

• Moving the mouse doesn't move the pointer. You should be moving
the mouse on a clean, smooth surface.

Figure B-4
Happy Macintosh icon

Make sure the mouse is firmly connected. (Unplug the mouse and plug it
back in.) If you have a Macintosh SE or Macintosh II, the mouse may be
plugged into the keyboard. Make sure the keyboard itself is plugged in at
both ends. It may help to unplug and firmly replug all the connections
just to make sure they are good.
If you are confident that the connection between the mouse and the
computer is good, the mouse may not be working properly. Try cleaning
it. (For instructions, see your Macintosh owner's guide.)

Occasionally, the problem is not with the mouse but with the software.
Try restarting your computer with a different startup disk. If the mouse
works normally, the problem is with the earlier disk.
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• Typing on the keyboard produces nothing on the screen. Make sure
the keyboard is connected securely to your Macintosh.
You might be in a situation that doesn't allow typing. (For example, while
in a graphics application you might have to select the tool for entering
text, or typing won't work.) Open the Key Caps desk accessory to see
whether typing works there. If it does, there's nothing wrong with your
keyboard. If you still see nothing on the screen when you type, contact
your authorized Apple dealer.

• A dialog box with a bomb appears. This means there's a problem with
the software, and you'll have to restart. Try clicking the Restart button in
the dialog box (restarting the computer with the same startup disk).
Occasionally, you'll have to switch off the power and restart. If the
problem occurs again, abandon that disk and try a different copy of the
software.
Generally, when the bomb appears, any work you've done since the last
time you saved a document will be lost. (Saving documents every 15
minutes or so diminishes the risk of losing important work.)
The dialog box may also contain an error code (for example, ID = 33).
These codes are technical and, unless you're an expert, won't mean much
(although it's a good idea to make a note of the code in case you want to
report it to a dealer).
• An application in a folder won't open. Some applications cannot

operate unless they are on the same level of the hierarchical ftle system as
the System Folder. Drag the application out of the folder it's in and put it
in the directory window for your startup disk. (Or move it onto the
desktop.) Then try again to open the application. If it still won't open, try
using a backup copy. (If that works, make a new backup copy for
safekeeping.)

• You can't save anything on a disk. There are several conditions that
might cause this problem:
o The disk has not been formatted. You'll get a message telling you that
the disk is unreadable and asking whether you want to initialize it. (For
instructions, see "Preparing 3.5-Inch Disks for Use" in Chapter 7.)
o The disk is locked. Eject the disk and see whether the colored plastic
tab is in the locked position (leaving a small "hole" in the corner of the
disk case). Unlock it and reinsert the disk. (For instructions on locking
and unlocking disks, see "Protecting the Contents of 3.5-Inch Disks" in
Chapter 7.)

General problems with the Macintosh
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o The disk is full. There are two ways to find out how much space there
is on the disk:
I. On the Finder desktop, open the disk icon. Make sure the directory
window is in a By Icon or By Small Icon view. Look at the right side
of the window, just below the menu bar. You'll see a number,
followed by the label available (for example, "404K available"). That
figure is the amount of space left on the disk.
2. Select the disk icon and choose Get Info from the File menu. In the
information window that appears, you'll see how much space has
been used on the disk. Subtract the amount used from the total
capacity of the disk-800K, for example.

You can remove items from the disk to free up more space, use the
Erase Disk command to clear it completely, or try using another disk.
o The disk drive is not working. If you've tried the remedies suggested
above and still have trouble saving anything, take the computer to
your authorized Apple dealer for help.

• You can't eject a disk. For some reason your computer can't get the
information it needs to eject the disk in the usual ways. Choose Shut
Down from the Special menu. Then hold down the mouse button while
you restart the computer. This should eject the disk. If this doesn't work,
find the small hole to the right of the disk drive. Insert a straightened
paperclip (or similar small object) and push gently. This ejects the disk if all
else fails.
• The hard disk icon doesn't appear on the Finder desktop. There are
several possible causes and remedies:
o Your hard disk may not have been initialized. See Chapter 8, "Hard
Disks," for instructions on using Apple HD SC Setup to initialize it.
o If it's an external hard disk, you should switch it on and let it warm up
before you switch on the computer. (Check the manufacturer's
recommendation for how long to run the hard disk before switching
on the computer.) Also, if you've had to restart the computer after a
dialog box with a bomb appeared on your screen, the disk drive may
have been left in an odd state. Try switching it off, then on again.
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o If you have more than one SCSI hard disk, they may both have the
same SCSI ID (detennining device priority). Open the Apple HD SC
Setup utility (in the Setup Folder on the Macintosh System Tools disk).
When you see the Apple HD SC Setup dialog box, click the Drive
button. You'll see the device priority number for each Apple SCSI drive
found. If two SCSI drives have the same device priority number, you
must change one of them. See the manual that came with the disk
drive for instructions.
o The hard disk resource might be damaged. If you have an Apple SCSI
hard disk, you can try to repair the damage. Choose Shut Down from
the Special menu, insert the Macintosh System Tools disk, and restart
your computer. Open the Apple HD SC Setup utility (in the Setup
Folder on the Macintosh System Tools disk), and when you see the
Apple HD SC Setup dialog box, click the Update button. When the
process is complete, click Quit
If the resource was the problem, the hard disk icon should appear on
the desktop. Choose Restart from the Special menu to make the hard
disk your startup disk.
If your hard disk is not an Apple SCSI hard disk, refer to the owner's
guide for instructions on what to do when the hard disk resource is
damaged.

o If the hard disk you're having trouble with is a startup disk, the
problem might be a damaged System file. Use the Installer on the
Macintosh System Tools disk to reinstall your system software.
Instructions for doing this are in Chapter 9, "Startup Disks."
If the problem is so severe that the Installer won't work, try using
Font/DA Mover to copy your fonts and desk accessories to a new
System file (so you won't lose them). Drag the replacement System
file to the System Folder on the hard disk.

o There might have been a power failure while the hard disk was in use.
If so, try using the Disk First Aid utility to recover. See the Macintosh
Utilities User's Guide for instructions.
If none of these suggestions helps, contact your authorized Apple dealer.
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• Using Apple HD SC Setup, you see the message "Drive selection
failed." If you click the Drive button in the Apple HD SC Setup dialog
box and see this message, there are several possible problems.
o If the disk is not a SCSI disk, you cannot use Apple HD SC Setup, and
you'll see the message. See the manual that came with your disk drive
for instructions on initializing the disk.
o If the disk is an external Apple SCSI disk, it may not have been
connected properly or switched on. See your Macintosh owner's guide
for important information about connecting SCSI devices. Make sure
that terminators and cables are seated properly.
o Occasionally this message will appear with a non-Apple SCSI disk drive.
Check all connections and make sure the disk drive is switched on.
Also, refer to the manufacturer's instructions.

• On a Macintosh II, the fan seems noisier than usual. If the
computer is heating up the fan will work harder. Check the clearance
around the air vents and remove anything blocking the flow of air to the
ventilation system. Also check the ambient temperature and do what you
can to cool the room you're working in. If it is not possible to lower the
temperature, turn off the computer. (In an emergency, pull the plug on
the power cord.)
Another suggestion is to avoid using the expansion slot closest to the
power supply in the main unit. The fan inside the power supply is
temperature controlled, and an expansion card in the slot next to it will
create some heat. If you have fewer than six expansion cards, you won't
need to use this slot.

• The computer shuts down without warning. This could be caused by a
general power failure (in which case your other electrical appliances will
not work either). If you have a Macintosh Plus or Macintosh SE, press the
power switch on the back to turn the power off. If you have a
Macintosh II, it will have been switched off by the power failure.
On a Macintosh II, it is also possible that the air vents may have been
blocked or covered in some way, causing the system to overheat; or the
room temperature may have been too high. Thermal protection circuitry
may have shut down the computer to prevent damage to the hardware.
Check the clearance around the air vents and remove anything blocking
the flow of air to the ventilation system. Also check the ambient
temperature. Give the computer time to cool down (at least half an hour),
and try starting it again.
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• Miscellaneous software problems. You can avoid many software
problems by always keeping each of your startup disks current with the
latest system software. See "Using the Installer" in Chapter 9. If you have
the same problem with all disks, the computer most likely needs service.
Take it to your authorized Apple dealer.
Some applications might require their own customized system files to
work properly. In this case, you want to restart the computer from a
different startup disk (probably the application disk).
Some applications use data files (such as help files) that must be kept
together in one folder. If you drag that folder from a 400K disk to a hard
disk or to an SOOK disk that's initialized with SOOK format, the application
may not be able to find the data files. Try moving the data files to the
same directory window as the application.

• Unspecified symptoms and cures. If none of the symptoms or cures
described so far seems to fit, consider the three general ways in which
your computer could be ailing:
o The application you're using could have gone wrong just this once
after it was copied from the disk into memory. Try it again.
o The disk you're using has bad information on it. Try Disk First Aid
(explained in the Macintosh Utilities User's Guide).
o The computer is on the blink. Take it to your authorized Apple dealer.
If you've checked the specific symptoms in this chapter and you still
can't get any response from your computer, try turning it off briefly and
then on again. If this works and you're able to complete what you tried
before, it was just a glitch. (That's a technical term.) If you find yourself
in the same dilemma after restarting the computer, the problem is with
the disk (possibly your hard disk if it's the current startup disk). Try
another disk (one without any valuable documents on it, so you don't
risk losing them).
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Problems with MultiFinder
These are the factors most likely to cause problems:
• You haven't installed everything you need. (Check again to make sure
you've followed the instructions for installing the system software and
Background LaserWriter.)
• You haven't turned on the features you want to use.
• You need more memory (RAM) for what you want to do.
• You don't have enough disk storage for Background Printing.
The suggestions here may help you resolve some problems. If all else fails,
you can always operate your Macintosh with MultiFinder turned off
(opening one application at a time in the single-Finder environment). Or you
might want to consider adding memory and a hard disk to your system.
(Your authorized Apple dealer can help.)
• You can't open an application. If free memory is fragmented, you
may not be able to open an application-even though it has worked with
MultiFinder in the past. To clear up fragmentation, quit all open
applications and restart them. (For more details on memory and
fragmentation, see "Some Technical Points About Memory" in
Chapter 10.)
In certain cases when the largest available block of memory is close to the
amount you want, you'll get a message offering the option of opening
the application with Jess memory than the preferred amount. If you
want to try this, click OK in the message box; otherwise, click Cancel.
While you are running the application in this situation, it's a good idea to
save what you're working on frequently. If you notice that the
application is not behaving normally, quit it.
• The icon is missing from the menu bar. Afew applications have so

many menu titles that there won't be room for the active application's
icon at the right edge of the menu bar. If that happens, everything's still
OK; you've merely run out of menu bar real estate.

• Desk accessories won't work. Some desk accessories won't work with
MultiFinder turned on. For example, some spelling checkers may not work
because they cannot connect with the document you want to check.
When you want to use a desk accessory that doesn't work with
MultiFinder on, turn MultiFinder off. (See "Turning MultiFinder Off' in
Chapter 10.) Use the desk accessory to do what you want, then tum
MultiFinder on again.
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Another circumstance that can prevent you from opening a desk
accessory is a shortage of free memory. If this is the case, your Macintosh
will make an alert sound. To open the desk accessory, you'll need to close
one of the open applications.
• You can't open a disk or folder icon. If your system has a hard disk,
you can accumulate a lot of applications, folders, and documents. In other
words, you have more items for the Finder to manage (keeping track of
names, dates, copies, and locations). If the Finder gives you a message
that it is out of memory, you should increase the application memory size
for the Finder.
Changing the memory size for the Finder is the same as changing it for
any application-except that you can make the change while the Finder is
active (not possible with any other application). Open the System Folder
and select the Finder icon. Then choose the Get Info command from the
File menu. Use the pointer to select the box labeled Application Memory
Size, and type a new number. Finally, for the change to take effect, you
must restart the computer.

• Background Printing won't work. There are several possible causes for
this problem.
o Are Background Printing and MultiFinder turned on? Background
Printing must be turned on. Choose the Chooser desk accessory from
the Apple menu. the label Background Printing and make sure the On
button is selected. (For more detailed instructions, see "Making Sure
Background Printing Is On" in Chapter 10.)
It is also possible that MultiFinder hasn't been turned on. If so, the
Background Printing On and Off buttons will appear dimmed. Use the
Set Startup dialog box to tum MultiFinder on. (See "Turning
MultiFinder On" in Chapter 10.)
o Are the necessary printing resources installed? If you open the Chooser

and can't find the Background Printing label and the On and Off
buttons, you have not installed all the printing resources you need. See
"To Install Macintosh Printing Too&' in Chapter 9.
o Is AppleTalk active? Open the Chooser and make sure that AppleTalk is

active. If it's not, click the Active button.
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o Is your startup disk too full? Because Background Printing must be
able to create a spooled file and store it temporarily on your startup
disk, a shortage of space on the disk can cause a problem. If your
startup disk is a hard disk, there should be plenty of space. However, if
you are working on a system that has two 3.5-inch drives and no hard
disk, PrintMonitor may not be able to fmd enough storage space for
large spooled documents.
When this problem occurs, you will get a message telling you that the
document could not be printed because there's not enough free space
(and identifying the disk involved). Before you can print the
document, you'll have to tum Background Printing off. (Use the
Chooser desk accessory.) Then choose the Print command again. You
will be printing in the foreground, and you won't be able to use the
computer for another task until printing is finished.
o Do you have a LaserWriter printer? Background Printing is available
only for the LaserWriter family of printers.
o Have you reset the Alarm Clock? When you have elected to set a
specific time and date for a document to print, PrintMonitor depends
on the internal clock to tell it when to start. If you have reset the
Alarm Clock or the Time or Date on the Control Panel, that can affect
the schedule for a printing job.
If you have reset the clock and a job has not printed as expected, open
PrintMonitor and select the document in the Waiting list. Then use Set
Print Time (from the PrintMonitor window) to reschedule printing
according to the new clock setting.
o Is there a compatibility problem? Occasionally an application will be
incompatible with Background Printing. Documents won't print or
your system may hang up, and none of the suggested remedies works
to fix the problem. When that happens, tum off Background Printing
and print in the foreground.
Sometimes an update to application software can make the application
incompatible even though it has worked with Background Printing in
the past. When this happens, you can print in the foreground (by
turning Background Printing off), and you may want to contact the
application manufacturer to report the problem.
• General misbehavior with MultiFinder. Most applications are
compatible with MultiFinder, but now and then you may fmd an
application that is not. If you notice erratic behavior in an application, it is
best not to use it in the MultiFinder environment. (See "Turning
MultiFinder Off' and "Temporarily Starting Without MultiFinder" in
Chapter 10.) Contact the manl,lfacturer and ask whether an updated
version of the application is available.
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Index

A

About the Finder 114-115, 221, 239-240
accented characters 165
active window 18-20, 61
MultiFinder and 229
adding images to Scrapbook 152-153
Alarm Clock 125-126. See also Date;
Time
Apple Extended Keyboard 156-157,
162-163
Apple HD SC Setup 196-201
Apple Keyboard 156-157, 160-161
Apple menu 114-115. See also desk
accessories
About the Finder 114-115, 221,
239-240
MultiFinder and 226-227
AppleTalk
Active/Inactive 131-132
choosing devices on 133
connecting/disconnecting 132
devices and 130-131
zones and 133
application icons, dimmed, MultiFinder
and 229
applications 26-36, 94-104
changing memory size of, in
MultiFinder 241-243
copying 84-86
creating documents in 94, 95
duplicating 83
locking 88
moving 84, 93
moving through hierarchical file
system within 43-46
New command and 95
opening 26--27, 94
opening documents within 46,
98-100

printing documents within 109
quitting 224
removing 112
starting 26-27, 94
starting with MultiFinder 226
unlocking 89
arrow keys
Apple Extended Keyboard 162
Apple Keyboard 160
Macintosh Plus keyboard 158
B

Background Printing, MultiFinder and
231-238
turning on/off 232-233
background processing 231. See also
MultiFinder
Backspace key, Macintosh Plus
keyboard 159
brightness (of colors) 140
by Color command (View menu) 120
by Date command (View menu) 120
by Icon command (View menu) 119
by Kind command (View menu) 120
by Name command (View menu) 119
by Size command (View menu) 120
by Small Icon command (View menu)
119

c
Calculator 127
calendar. See Alarm Clock; Date; Time
capacities of3.5-inch disks 172-173
Caps Lock key
Apple Extended Keyboard 162
Apple Keyboard 160
Macintosh Plus keyboard 158

characters, optional 164-165
Chooser 105, 127-133
using with devices on AppleTalk
130-133
using with directly connected printer
128-129
choosing a printer. See Chooser
choosing commands from menus
11-13
Clean Up command (Special menu)
120-121
Clear command (Edit menu) 119
Clear key
Apple Extended Keyboard 163
Apple Keyboard 161
Macintosh Plus keyboard 159
clicking 52,53
selecting icons by 8
Clipboard 34. See also Edit menu
clock 125-126. See also Date; Time
close box 14, 17, 23, 65
Close command (File menu) 116
CloseView 145
closing windows 22-23, 65
color and Desktop Pattern 135-137
Color Control Panel 139-141
Color menu 122
color monitor, selecting number of
colors 143, 145
color of highlight, changing 139-141
color wheel dialog box 140
Command key
Apple Extended Keyboard 162
Apple Keyboard 160
Macintosh Plus keyboard 158
shortcuts with 169-170
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command(s)
by Color 120
by Date 120
by Icon 119
by Kind 120
by Name 119
by Size 120
by Small Icon 119
choosing from menus 11-13
Clean Up 120-121
Clear 119
Close 116
Copy 118
Cut 118
Duplicate 83, 117
Eject 118, 180-182
Empty Trash 121
Erase Disk 121
Get Info 86-87, 117
New 95
New Folder 115
Open 116
Page Setup 106-107, 117
Paste 119
Print 116
Print Directory 118
PutAway 117
Restart 121
Save 101
Save As 101-103
Select All 119
Set Startup 121, 243-244
Show Clipboard 119
Shut Down 2, 121
Undo 118
connecting/disconnecting AppleTalk
132
Control key
Apple Extended Keyboard 163
Apple Keyboard 160
Control Panel 133-150
Color Control Panel 139-141
General Control Panel 134-139
Keyboard Control Panel 142
Monitors Control Panel 143-147
Mouse Control Panel 148-149
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Sound Control Panel 149
Startup Device Control Panel 150
Convergence Test 144, 145, 146
Copy command (Edit menu) 73, 118
copying. See also duplicating
applications 84-86
disks 185-190
documents 84-86
folders 84-86
icons 83-86
3.5-inch disks 185-190
copying and pasting text 73
creating startup disks 208-214
customizing startup disks 216
Cut command (Edit menu) 118
cutting and pasting text 72-73
D

Date, setting 137. See also Alarm Clock
Delay Until Repeat, setting 142
Delete key
Apple Extended Keyboard 163
Apple Keyboard 161
deleting. See removing
desk accessories 115, 123-154. See also
Apple menu
Alarm Clock 125-126
Calculator 127
Chooser 105, 127-133
Control Panel 133-150
Find File 124, 125
Key Caps 150-152
MultiFinder and 230-231
Note Pad 124
Puzzle 124
Scrapbook 152-154
startup disks and 216
desktop 4, 78-80. See also Finder
Desktop Pattern, setting 135-137
destination disk 84
diacritical marks 165
dialog boxes, directory 29, 35-36, 97-98
dimmed application icons, MultiFinder
and 229
directories 90-91
printing 109--110

directory dialog box 29, 35-36, 97-98
directory views 90-91
directory window 14, 90-91
Setup Folder 21
System Folder 20-21
disks, hard 193-202
initializing SCSI 195-198
reinitializing SCSI 199-201
startup 203-218
disks, 3.5-inch 3, 171-191
copying 185-190
dragging to Trash 182-183
drives and 173
ejecting 180-184
initializing 173-179
locking 190
protecting the contents of 190
reinitializing 178-179
startup 203-218
document icon 30-31
documents 6, 94-104. See also
applications
changing name of 47-49
copying 84-86
creating 28, 94
creating with New command in
applications 95
duplicating 83
locking 88
moving 84, 93
moving images from Scrapbook to
153-154
naming 29-31
opening from Finder 96
opening within applications 46, 98-10(
organizing 37-49
printing from applications 109
printing from Finder 108-109
removing 49, 112
renaming 80-82
saving 29-31, 35-36
saving in hierarchical file system
47-49
saving with different name 101-103
saving with same name 101
unlocking 89

double-clicking 20-21, 52, 54
Double-Click Speed, setting 149
dragging 9-10, 52, 57
selecting grouped icons by 58-59
3.5-inch disks to Trash 182-183
windows 17
driver resource, SCSI hard disk 194, 199
drives, 3.5-inch disks and 173
Duplicate command (File menu) 83,
117
duplicating. See also copying
applications 83
documents 83
folders 83
Scrapbook files 154
E

Easy Access 166-169
editing text 32-34, 70-74
Edit menu 118-119
Clear command 119
Copy command 118
Cut command 118
Paste command 119
Select All command 119
Show Clipboard command 119
Undo command 118
SOOK disks
initializing 174-176
reclaiming space on startup 217-218
startup 207
Eject command (File menu) 118,
180-182
ejecting 3.5-inch disks 180-184
Empty Trash command (Special menu)
121
Enter key
Apple Extended Keyboard 163
Apple Keyboard 161
Macintosh Plus keyboard 159
Erase Disk command (Special menu)
121
Esc key
Apple Extended Keyboard 163
Apple Keyboard 161

F

H

File menu 115- 118
Close command 116
Duplicate command 83, 117
Eject command 118, 180-182
Get Info command 86-87, 117
New Folder command 115
Open command 116
Page Setup command 106-107, 117
Print command 116
Print Directory command 118
Put Away command 117
files, spooled 231
Finder 77-112. See also MultiFinder;
specific command; specific menu
desktop and 78-80
opening documents from 96
printing documents from 108-109
Finder memory graph, MultiFinder and
239-240
Find File 124, 125
folders 37-40, 89-93
contents of 91
copying 81H36
creating 92
duplicating 83
moving 84, 93
nesting 40-42
removing 49, 112
Font/DA Mover, MultiFinder and 245
fonts and startup disks 173--178
formats of 3.5-inch disks 172-173
formatting disks. See initializing disks
400K disks, initializing 176-178
fragmented memory, MultiFinder and
240-241
function keys, Apple Extended
Keyboard 163

hard disks 193--202
initializing SCSI 195-198
reinitializing SCSI 199-201
startup 203--218
HD Backup, MultiFinder and 245
hierarchical file system (HFS) 42-46,
89-93,97-103
moving through, within applications
43-46
saving documents in 47-49, 101-104
highlight color, changing 139-141
highlighted icon 8
history of system software 247-257
horizontal scroll bar. See scroll bars
hue (of colors) 140

G

General Control Panel 134-138
general problems, troubleshooting
259-265
Get Info command (File menu) 86-87,
117, 248-249
MultiFinder and 242-243
gray scales 143, 145

I, J
I-beam pointer 28. See also insertion
point
icons 4, 30-31, 80-89. See also
applications; disks; documents;
folders
dragging 9-10
opening 18-19, 20-21
.renaming 80-82
selecting by clicking 8-9
selecting grouped, by dragging 58-59
inactive windows 18-20, 60-61
MultiFinder and 229
information window 86-87
initializing disks 173--179
SOOK disks 174-176
400K disks l74-176
SCSI hard disks 194-201
inserting
text 70
3.5-inch disks 3
insertion point 28, 70
moving 33, 34
Installer 209-214
installing
Macintosh Printing Tools 212-214
Macintosh System Tools 210-212
printing resources 212-214
international language characters 165
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K

keyboard 155-170
shortcuts 169-170
Keyboard Control Panel 142
Key Caps 150--152
Key Repeat Rate, setting 142
L

LaserWriter Options dialog box 107
LaserWriter Page Setup dialog box 106
locking
applications 88
documents 88
3.5-inch disks 190--191
M

Macintosh 512K, history of system
software 250--251
Macintosh 512K enhanced, history of
system software 251-252
Macintosh Plus
history of system software 253-254
on/off switch 2
Macintosh Plus keyboard 156-157,
158--159
Macintosh Printing Tools, installing
212-214
Macintosh SE
history of system software 255-257
on/off switch 2
Macintosh System Tools, installing
210--212
Macintosh II
history of system software 255-257
power off switch 2
memory, MultiFinder and 221-222,
238--243
menu bar 11
Menu Blinking, setting 137
menus 11. See also specific menu
choosing commands from 11-13
pulling down 12
shortcuts 169-170
menu title 12
modifier keys (Easy Access) 166-167
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Monitors Control Panel 143-147
monitor status
setting for multiple monitors 144-147
setting for single monitor 143- 144
monochrome monitor, selecting
number of grays 143, 145
mouse 52-59
basics of 6-10
Mouse Control Panel 148--149
mouse keys (Easy Access) 168--169
Mouse Tracking, setting 148
moving
applications 84, 93
documents 84, 93
folders 84, 93
images from Scrapbook 153-154
insertion point 33, 34
pointer 7
text 72-73
through hierarchical file system
within applications 43-46
windows 17, 61
MultiFinder 219-245. See also Finder
active window and 229
Apple menu and 226-227
Background Printing and 231-238
desk accessories and 230--231
dimmed application icons and 229
Finder and 226
Finder memory graph and 239-240
Font/DA Mover and 245
fragmented memory and 240--241
HD Backup and 245
inactive windows and 229
memory and 221-222, 238--243
quitting applications and 224
RAM cache and 245
sample session 225-231
small icon in menu bar and 229-230
starting applications with 226
switching startup disks and 245
system requirements 221
tips 245
troubleshooting 266-268
turning on/off 223-224
unfragmented memory and 241
windows and 227-229

N

naming documents 29-31
nesting 91
folders 40-42
New command 95
New Folder command (File menu) 115
Note Pad 124
numeric keypad, using mouse keys with
(Easy Access) 168--169
numeric keys
Apple Extended Keyboard 162
Apple Keyboard 160
Macintosh Plus keyboard 158
0

on/off switch (Macintosh Plus and
Macintosh SE) 2
Open command (File menu) 116
opening
applications 26-27, 94
documents from Finder 96
documents within applications 46,
98--100
icons 18--19, 20--21
optional characters 164-165
Option key 164-165
Apple Extended Keyboard 162
Apple Keyboard 160
Macintosh Plus keyboard 158
shortcuts with 170
organizing documents 37-49
overlapping windows 18--19
p

Page Setup command (File menu)
106-107, 117
partitions 200
Paste command (Edit menu) 119
pasting text 34, 72-73
pattern (desktop). See Desktop Pattern
pointer, moving 7
ports, printer 129
power off switch, Macintosh II 2

Power On key
Apple Extended Keyboard 163
Apple Keyboard 161
Preferences dialog box 236-237
preparing disks. See initializing disks
pressing 52, 56
Print command (File menu) 116
Print Directory command (File menu)
109-110, 118
printer ports 129
printers, choosing. See Chooser
printing 105-110
background 231-238
directories 109-110
documents from Finder 108
documents within applications 109
groups of documents from Finder
108-109
printing resources, installing 212-214
PrintMonitor 233-238
problems, troubleshooting 258-268
protecting the contents of 3.5-inch disks
190
pulling down menus 12, 56
Put Away command (File menu) 117
Puzzle 124
Q
quitting applications, MultiFinder and
224
R
RAM cache
MultiFinder and 245
setting 138
Rate of Insertion Point Blinking, setting
137
Read Me documents 74-75
recovering items from Trash 112
reinitializing
SCSI hard disks 199-201
3.5-inch disks 178-179

removing
applications 112
documents 49, 112
folders 49, 112
images from Scrapbook 153
text 74
renaming icons 80-82
replacing text 74
resizing windows 62
resource files 127
Restart command (Special menu) 121
Return key
Apple Extended Keyboard 163
Apple Keyboard 161
Macintosh Plus keyboard 159

s
sample session (MultiFinder) 225- 231
saturation (of colors) 140
Save As command (File menu) 101-103
Save As dialog box 35
Save command (File menu) 101
saving documents 29-31, 35-36, 47-49
with different name 101-103
with same name 101
scanning order for startup disks 215
Scrapbook 152-154
adding images to 152-153
file, duplicating 154
moving images to document from
153-154
removing images from 153
scroll arrows 24, 67
scroll bars 14, 24-25, 66, 69
scroll box 25, 68, 69
scrolling windows 66-69
by the windowful 68
line by line 67
SCSI hard disk 193-201,
initializing 195-198
reinitializing 199-201
Select All command (Edit menu) 119

selecting 52
grouped icons by dragging 58-59
icons by clicking 8-9, 52-53
text 33, 71
Set Startup command (Special menu) 121
MultiFinder and 223-224, 243-244
Set Startup dialog box 223-224, 244
setting
Date 137
Delay Until Repeat 142
Desktop Pattern 135-137
Double-Click Speed 149
Key Repeat Rate 142
Menu Blinking 137
monitor status 143-147
Mouse Tracking 148
RAM cache 138
Rate of Insertion Point Blinking 137
Speaker Volume 139
startup applications 121, 243-244
Time 137
setting up a SCSI hard disk 194-201
Setup Folder, directory window 21
Shift-clicking 52, 55
Shift key
Apple Extended Keyboard 162
Apple Keyboard 160
Macintosh Plus keyboard 158
shortcuts 169-170
Show Clipboard command (Edit
menu) 119
Shut Down command (Special menu)
2, 121
size box 14, 15, 62
small icon in menu bar, MultiFinder
and 229-230
small System files 207, 218
software. See applications; system
software
Sound Control Panel 149
source disk 84
Speaker Volume, setting 139, 149
special keys, Apple Extended Keyboard
163
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Special menu 120-121
Clean Up command 120-121
Empty Trash command 121
Erase Disk command 121
Restart command 121
Set Startup command 121, 243-244
Shut Down command 2, 121
spooled files 231
starting
applications 26-27, 94
applications with MultiFinder 226
Macintosh 203-218
tutorial 3-4
Startup Device Control Panel 150
startup disks 203-218
creating 208-214
customizing 216
desk accessories and 216
fonts and 216
hard vs. SOOK 207
Installer and 209-212
making nonstartup disk 217
MultiFinder and 245
reclaiming space on 217-218
scanning order for 215
small System files and 207, 218
switching 215-216, 245
updating 208-214
sticky keys (Easy Access) 166-167
switching startup disks 215-216
MultiFinder and 245
System files, small 207, 218
System Folder 205-206
directory window 21
multiple copies of 206
system requirements (MultiFinder) 221
system software, history of 247-257

T

u

Tab key
Apple Extended Keyboard 163
Apple Keyboard 161
Macintosh Plus keyboard 159
TeachText 27, 74-75
text
copying and pasting 73
cutting and pasting 72-73
editing 32-34, 70-74
inserting 70
moving 72-73
pasting 34
removing 74
replacing 74
selecting 33, 71
text box 29
3.5-inch disks 171-191
capacities of 172-173
copying 185-190
dragging to Trash 182-183
ejecting 180-184
formats of 172-173
initializing 173-178
inserting 3
locking 190
protecting the contents of 190
Time, setting 137. See also Alarm Clock
title bar 14, 17
Total Memory, MultiFinder and
221-222
Trash 111-112
dragging 3.5-inch disks to 182-183
recovering items from 112
troubleshooting 258-268
tutorial 1-50
starting 3-4

Undo command (Edit menu) 118
unfragmented memory, MultiFinder
and 241
unlocking
applications 89
documents 89
3.5-inch disks 191
updating startup disks 208-214
utility programs 21

v
version number, identifying 248-249
vertical scroll bar. See scroll bars
View menu 119-120
by Color command 120
by Date command 120
by Icon command 119
by Kind command 120
by Name command 119
by Size command 120
by Small Icon command 119
volume (speaker) 139, 149

w,x, y
windows 13, 14-25, 60-69
active 18-20,61,229
changing size of 15
closing 22-23, 65
directory 90-91
inactive 18-20,60-61,229
moving 17, 61
MultiFinder and 227-229
overlapping 18-19
resizing 62
scrolling 66-69
zooming 16, 63-64
word wrap 28
wristwatch pointer 28

z
zones (network) 127, 133
zoom box 14, 16, 63-64
zooming windows 16, 63-64
274
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Macintosh System Software and Utilities

S®Tell Apple about your ........ ... .................. .................... .... ... . .
• Please contact your authori7£d Apple dealer when you have questions about your Apple products. Dealers are trained by Apple
Computer and are given the resources to handle service and support for all Apple products. If you need the name of an
authori7.ed Apple dealer in your area, call toll-free: 800-538-9696.
• Would you like to tell Apple what you think about this product? After you have had an opportunity to use this product, we
would like to hear from you. You can help us to improve our products by responding to the questionnaire below and marking
the appropriate boxes on the card at the right with a #2 lead pencil. If you have more than one response to a question,
mark all the boxes that apply. Please detach the card and mail it to Apple. Include additional pages of comments if you wish.
1. How would you rate your Macintosh system software and utilities overall? (1 =poor ... 6 =excellent)

2. How much experience have you had with computers? (1 =none ... 6=extensive)
3. Which Apple computer are you using? (l=Macintosh 512K enhanced, 2 =Macintosh Plus, 3=Macintosh SE, 4=Macintosh II)
4. How did you acquire your Macintosh system software and utilities? (1 =packaged with computer, 2 =purchased separately)
5. If this system software is an update, which version does it replace? (l=version 3.2, 2=version 4.0, 3=version 5.0,
4=don't know)
6. If you set up your own system software, how easy did you find the process? (l=difficult. .. 6=very easy)
7. How would you rate the Macintosh System Software User's Guide overall? (l =poor .. .6=excellent)
8. How much of the Macintosh System Software User's Guide have you read? (1 =entire manual, 2 =specific chapters,
3 =for reference only, 4 =none of it)
9. How easy was the Macintosh System Software User's Guide to read and understand? (1 =difficult. . . 6 =very easy)
l 0. How would you rate the organi7.ation of the Macintosh System Software User's Guide? (1 =poor ... 6 =excellent)
l I. How would you rate the Macintosh Utilities User's Guide overall? (1 =poor... 6 =excellent)

12 . How much of the Macintosh Utilities User's Guide have you read? (l=entire manual, 2=specific chapters,
3 =for reference only, 4 =none of it)

13. How easy was the Macintosh Utilities User's Guide to read and understand? (l=difficult. .. 6= very easy)

14. How would you rate the organization of the Macintosh Utilities User's Guide? (l =poor. . .6=excellent)

15. How easy was it to find the information you needed? (l =difficult. .. 6=very easy)

16. Please describe any errors or inconsistencies you may have encountered with the Macintosh Utilities User's Guide.
(Page numbers would be helpful.)

17. Please describe any errors or inconsistencies you may have encountered with the Macintosh System Software User's Guide.
(Page numbers would be helpful.)

.8. What suggestions do you have for improving the Macintosh system software and utilities?
Thanks for your time and effort.

030-3282-A

Tuck end flap inside back
cover when using manual.
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